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Using this Book

[)isks and File
Storage

Introduction
AutoCAD is a very popular, flexible software system that allows the user to create
both 2-dimensional and 3-dimensional models and drawings. This book offers a series
ofexercises to help you learn the 2D drawing techniques ofAutoCAD. Most ofthe 2D
commands in Releases 2006, 2007 and 2008 have not changed since Release 2000i.
These exercises can be used on all releases from 2000i through 2008.

For those who are familiar with computers, learning AutoCAD will be easy, simply
because you are aware ofthe typical response structure and the format ofyour system.

System Prompts and User Responses

All commands listed within the text of this book are in the command font. CIRCLE,
LINE, ZOOM, MIRROR, etc. When shown as in this font are commands.

In this book, the system command information will be shown in this style:

Command:
Specify first point:

Specify second point or [Undo]:

The user responses (what you should type in) will be shown in bold:

COffi."l1and: LINE
Specify first point:O,O
Specify second point or [Undo] :5,3

The Enter or Return Key

At the end ofeach command or entry on the command line, use the Enter key (symbol­
ized by .J) to signal the end of:

a command entry:
Command:LlNE.J

• a coordinate entry:
Specify first point:2,4.J

• a value:
New fillet radius.OOOO:3.J

• text:
Text:All Holes 2.00R Unless Note~

Please note that the .J will not be shown at the end ofevery entry after Chapter 1; it will
only be used when the user should press .J rather than entering any other response.

Most ofthe drawings in this book are small, so a floppy disk may be used for file storage
if your computer still has a floppy drive. Zip drives, Jazz drives, mass storage units
and CD writers are better suited to storing larger files. Always make three copies of
your files. Save your file every halfhour on the permanent computer drive, either C: or
D:. Ifyou have been working for more than three hours, also save onto an external file
system like a flash drive. Before you sign offfrom the system, e-mail a copy ofthe file
to yourself as welL

INTRODUCTION ix
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Starting
AutoCAD

AutoC6.D Classic

Keyboard and
Mouse Functions

x INTRODUCTION

Your Windows environment should have been set up so that a double-click on the
AutoCAD application icon will bring up AutoCAD.You will automatically be placed
in the Drawing Editor.

When you first start up, there may be palettes overlaying your screen. Click on the "X"
to remove them. On releases 2007 and 2008 a dashboard may come up instead ofto01­
bars. Pick AutoCAD Classic from the Workspaces toolbar.

Unfortunately, there is no way ofguaranteeing how the last user has left the screen, so
you may not have the necessary toolbars showing. If your screen is not the same as
shown below, you can either open toolbars in the View pull-down menu (very cumber­
some and difficult) or right~c1ickany toolbar on screen and pick from the list a toolbar
that you want.

The Windows Drawing Editor

The initial Windows screen contains the menu bar, the status bar, the drawing window
or graphics area, and several toolbars. Toolbars contain icons that represent com­
mands.

The menu bar (along the top) contains the pull-down menus. The status bar (along the
bottom) displays the cursor coordinates and the status modes such as GRID and SNAP.
Mode names are always visible in the status bar as selectable buttons. Click the buttons
to toggle the modes. The command line in Windows is "floating," that is, it may be
dragged to any location on the screen. The command line is where your commands
will be written out. Keep reading this to see where you are.

There are many different kinds ofpointing devices or mice on the market. Some have
two or three buttons, others have as many as 20. Two buttons are adequate for most
operations. A central roller on the top ofthe mouse will help with display cOlnmands.

In releases after 2004, the roller ball on the mouse will both ZOOM and PAN your file.

The Pick Button

On all mice there is a point or command indicator or pick button; on a two-button
mouse, it is usually on the left side of the device.

The pick button is used to indicate the command you want to access either from the
on-screen menu or from the digitizer tablet. It is also used to indicate point positions.

The Enter Button

The button on the right ofthe mouse will often have the function ofthe .J key (Enter or
Return) on the keyboard. This signals the end ofa command. There is also a right-click
facility that accesses the functions associated with each command. This can be turned
offunder the Tools pull-down menu by selecting Options and then UserPreferences.
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Function Buttons Many people who have used AutoCAD for a few years still make use of the function
keys on the top of the keyboard ( F6, F7, F8, etc). Move the mouse around the screen
noting the movement of the crosshairs.

F6

F7

F8

F9

toggles the Co-ordinate readout from
absolute, to incremental to off and back

toggles GRID on and off

toggles ORTHO on and off

toggles the SNAP on and off

Entering
Commands and

Coordinates

You can enter information either through the keyboard or through your mouse or
pointing device. There are also toolbars and icons that help to access the information.
You can enter a command by typing it in at the command prompt or you can use the
pointing device to pick up commands from:

the pUll-down menus in the menu bar

the icons on the toolbars.

Windows
Toolbors

Toolbars are groups of icons or tools compiled according to ap­
plication. Toolbars can be on-screen or not, and can be on the top
or side of your screen or floating.

Accessing Too/bars

In Releases 2000 to 2005, Toolbars can be accessed through the
View pull-down menu. Pick View, then Toolbars, then the tool­
bar that you need. In Releases 2006, 2007 and 2008, simply
right-click the two parallel lines on the end of the toolbar, and a
list of possible toolbars will appear. Pick the one you want.

To remove a toolbar from your screen, click on the X icon on the
top right of the toolbar.

Using Windows Too/hars

Toolbars contain tools that represent commands. When you
move the pointing device over a tool, Tooltips display the name
of the tool below the cursor. Pick that tool to invoke the com­
mand.

Placing Toolhars

The Standard toolbar is visible by default. It carries frequently
used tools such as Zoom, Redraw, and Undo. A docked too/bar
attaches to any edge of the graphics window. Afloating too/bar
can lie anywhere on the application screen, and it can be resized
and does not overlap with the drawing window.

3D Orbit

CAD Standards

Dimension

." Draw

Draw Order

Inquiry

Insert

..; Layers

Layouts

v Modify
Modify II

Object Snap

." Properties

Refedit

Reference

Render

Shade

Solids

Solids Editing

." Standard

Styles

Surfaces

Text

UCS

ucsn
View

Viewports

Web

Workspaces

Zoom

Lock Location ~

Customize.. ,

Ifnone ofyour toolbars appear on screen, exit AutoCAD and open the software again.
Your start-up file may not have been properly loaded.

INTRODUCTION xi
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Scroll Bars

Opening or
Accessing
Drawings

xii INTRODUCTION

To Dock a Toolbar

1. Position the cursor on the toolbar, and press the pick button on the pointing device.

2. Drag the toolbar to a dock location at the top, bottom, or either side of the drawing
window.

3. When the outline ofthe toolbar appears in the docking area, release the pick button.

To place the toolbar in a docking region without docking it, hold down the Ctr1 key as
you drag.

Placing theFirst Toolbar

If your screen comes up with no toolbars, type in the word 'toolbar' preceeded by a
dash as shown below. Then type in 'Standard' and your Standard toolbar will appear.
Dock it, as explained above, then right-click the two parallel lines on the end and place
the other toolbars as required. If this doesn't work, exit AutoCAD and reload it.

Command:-toolbar

Enter toolbar name or [All] :Standard

The Windows Command Window

Like the toolbars, the Windows command line or response area can be moved and
docked. By default the command window is docked at the bottom of your screen.

You can resize the command window vertically and horizontally, both with the point­
ing device and with the splitter bar located at the top edge ofthe window when docked
on the bottom and on the bottom edge when docked at the top. Resizing and docking
the command window can help you to create more space for your drawings on-screen.
Itcan also help you see your commands to find out where you may have gone wrong.

In most Windows applications there are scroll bars that advance the file you are
viewing. Each scroll bar has arrows that indicate a move up or down. To access an area
not displayed, click on the up or down arrow until the information is displayed or pick
the box within the scroll bar and move it quickly up and down the screen.

Scroll bars can be either vertical or horizontal. In Windows, the scroll bars on the top
and bottom move the file across the screen in the same way that PAN does.

Once you have accessed the Drawing Editor, you can start drawing and later save your
work under a specified name in a specified directory. Ifyou have a drawing staTted in

AutoCAD Release 2000i, 2004 or some earlier version, you can use OPEN to find it
and then work on it.

Opening Existing Drawing.5

The command line equivalent is OPEN.

In Windows, under File Name double-click the file name in the list of files. Use the
scroll bars to access other files. To access other directories, pick the down arrow be­
side the words' Look in:'. You can also type in the drawing name by picking the long
white box beside File Name:, then typing in the name ofthe file. Ifyou prefer to type in
both the directory and the name, type that into the File Name box.

Once your file is open, any changes can be saved to the same directory with the SAVE
command.
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Starting a New File

If you would like to start a new file, access the same File menu and choose New.

Before the new file is created, you can choose a default drawing file environment
and/or enter the name of the file that you wish to create.

Command: new
Enter template file name or L. (For none)] <acad.dwt>:

Enter template file name or [. (For none)] <acadiso.dwt>:

The _dwt extension stands for drawing template. acad.dwt is imperial, acadiso.dwt is
metric.

The default file environment can be either the acad.dwt standard file or a prototype file
that contains all the settings for a specific application. Once you are familiar with
AutoCAD, you can save drawing templates that contain plotter information, layer in­
formation, groups, blocks, linetypes, and other standard information so that you don't
need to set up your file from scratch each time.

Recovering Files

Jfyou have a problem with retrieving a file using OPEN, you may need to RECOVER
the file. Usually these problems are caused by either bad diskettes or removing the
floppy disk from the drive before AutoCAD has completely exited from the file. Ifyou
need to restore a file, simply type in RECOVER at the command prompt. Theoretically,
the OPEN cOlnmand should automatically repair any damaged files, but ifthis doesn't
work, try RECOVER.

Saving Files

Computers have a tendency to lose information at the worst possible times. It is sug­
gested that when you are using AutoCAD you save your files at least every hour.

The first time you save a drawing, you will be prompted for the name ofthe file before
it is saved. Ifyou have already entered the name ofthe current file under the New op­
tion under File, then AutoCAD simply saves the file under the given name and direc­
tory and you will not be prompted for a name.

To save a named file, use SAVE. Use the icon or

1. Type in the word SAVE at the command prompt

To save the file under a new name or on a different
directory, choose Save As frOln the File pull-down
Inenu.

Choose SAVE every subsequent time you would
like to save the drawing, and the drawing will auto­
matically be saved under this specified file name.

If you specified a directory and file when you
signed on, use SAVE to save the file under this
name.

Save B.s ...

. IQ ;iave

.,~~i.~'.'N.~i:~.. ".:.~~::~.w ..~~
!QI r:!ew ...

Ne~Sheet Set...

Qpen...

Op~n Sheet Set...

Load Marlsup Set .•.

~Iose

From the File menu, choose SAVE. In the Save

Drawing As dialog box, enter the new drawing
name. Then choose OK.

2.

To save a file to be read on an
earlier release of AutoCAD,
choose Save As, then under
the Files of Type box, pick
Rel130se 2000.

To change the directory, double-click on the directory listing that you want. The line
reading 'Look In:' must reflect the directory chosen.

You can save a file as a different release ofAutoCAD by specifying the file type. Spec­
ify the release you need under the Files of Type box in the Save As dialog box.

INTRODUCTION xiii
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Exiting AutoCAD

Options Dialog
Box

Changing the Drawing Name or Directory

Ifyou want to change the drawing name or directory, use Save As. Ifyou have been ad­
dressing C: while creating your drawing, you can save the file onto a disk before exit­
ing the file by using Save As, then pick A: or B: for the directory or drive.

Once you have saved the file, you can exit AutoCAD either by clicking on
the X at the top right or by picking Exit from the File menu.

The command line equivalent is QUIT.

The large red X will exit you from AutoCAD. The smaller black x will exit you from
the current drawing.

Do not remove your floppy disk from the drive before you have completely exited
fronl AutoCAD.

In previous releases and in many other Windows programs the
Options dialog box is called Preferences. The Options setup your
screen display, the drawing environment, and the systelTI. If you
fmd the color ofthe screen difficult to work with, change it under
Tools, Options, Display, Color. You can also set right-click
preferences here.

Window Elements

D Display sCioli bars in drawing window

o Display screen menu

(EJ U~e I<ltge buttom for loolbafS

oShow ToolTips

o Show shortcut kejls in ToolT ips
r----___

Colors... 1 I FonlL

Layout elements

oDisplay Layout and Model tabs

o Display Plintable aleC!

21 Display paper background

[!j Displey paper shadow

o Show Page SelupManagel tor new layouts

~ Creale viewport in new layouts

Closshair SIW

i5

DisplC!jI resolution

.:.! 11OO~.J Arc and circle smoothness

~~. ;8 I Segments in a polyline curve

~l ~! Rendered object smoolhness

:?! ;4 ! Contour lines per surtace

Display perlormance

o Pan and zoom with lasler &OLE

~ High~ght rasler image frMle only

:l 0 App~ solid liD

~ 0 Show lexl boundary flame only

~ 0 Draw tliue silhouettes 101 roIids and~fa=

Reference Edillading intensity

[50-------;
L__i

xiv INTRODUCTION

Context: Interface e1eFlle!'¢;
@t..Ugp--Tnx ,I!_ ••••I1I~~·
I~out I 1Crosshairs .l=~------""';;;;';;.q
i3D paralIel projection 1Autotrack vector II Red
i3D perspective projection 1;Autosnap marker 0 YeBow

I
Block editor : 1Drafti[1Q tool tip EJ Green

I Command line IiDrafting tool tip background mCyan
·ti Plot preview i ILight glyphs • Blue
,~~._._~_~.~~~_"", ..} ILight hotspot

;Light falloff II Magenta
1Light start limit 0 White
!Ughtendlimlt •••••••••
!~amera9lyp.hs c:~I?r CI Select Color, ..
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Introductory Geometry and
Setting Up

.

i chapter you should be able to:

UhAl SNAP, and GRID

methods and on-screen picking

ZOOM and PAN

This book is about how to use AutoCAD to make drawings. The information is rele­
vant to all AutoCAD releases from 2000 to 2008. Commands not available before a
particular release are noted.

Figure 1.1

/UC5ICor.J

/ ...----C(llT1J'11i:jnd ~Ine. Co'ordlna+..e Readout

/

Move your cursor across
the screen to the right ofthe
drawing area. If the nUll
-hers in the coordinate
readout are under 100, you
have opened an ilnperial
file. If they are over 500,
you have opened in metric.

Once you have entered the Drawing Editor,
AutoCAD establishes a default working

environment. There may also be some 'floating

palettes' on the screen (Sheet Sets, Tool Palettes).
Click on the X at the top
right corner of each palette
to clear these off your
screen so it looks like
Figure 1.1. Make sure your
workspace is AutoCAD
Classic (Releases 2007 and
2008).

Starting a
Drawing in

Metric or
Imperial

Changing Imperial and Metric

It is best to start off immediately with the units that
you want to use. If you have started in the wrong
units, open a new file with acad.dwt (imperial) or
acadiso.dwt (metric).

The command STARTUP can also be used. This will
prompt for either imperial or metric without the other
options.

'·~PTWT;;P'I;;·~'·····_·-'"·~~·.'~~'.~.~.
~Sheet5et$

tijatad -Named Plot Styles..dwt
g;acad.dwt
liIacadISO ..NamedPlot Styles,dwt
lliacadiso.dwt
tilANSI A (portraitl-Color Depe.,.

Command: STARTUP
Enter new value for startup <0>:1

Com..rnand :NEW

Introductory Geometry and Setting Up 1
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Pick either imperial or metric from the dialog box. Ifyou don't start in the right units,
your dimensioning, area, and volume calculations will be difficult.

Figure 1.2

The UNITS
Command

If you pick a point on the graphics
screen, you start to draw a rectangle,
Pick another point and it will

disappear.

In AutoCAD it is suggested that you draw everything at full scale or 1: 1 scale, and plot
the drawing at the required scale factor later.

Once you have chosen your deired units
from the startup menu, you then use the

UNITS command to set your readout
only.The type of units chosen detennines
how AutoCAD interprets coordinate and
angle command entries. The 'Insertion
scale' area indicates again your base units.
AutoCAD offers various types ofunits of
measure for use on your drawings. Before
setting up the parameters of the drawing,
first set up the units so that the readout dis­
plays the required units. Decimal mode
may be used for Inetric units as well as for
imperial units. Be sure you have set up
your file correctly for the units that you re­
qUIre.

+x

-y

+y

-x

Figure 1.40

Starting to Draw

AutoCAD uses Cartesian coordinates for
point entry. The points are set around a de­
termined origin atXO, YO, ZOo In this caseX
is 21"10". Y is 5'0", and Z is 0.0000. All
points to the right of 0,0 have a positive X
value; all points to the left have a negative
X All points above 0,0 have a positive Y
value; all points below have negative Y.

Moving the cursor around the screen you
will notice that the 0,0 position defaults to
the bottom left corner of your screen. See
Figures 1.4a and Figure lAb.

The decimal unit type will display one
millimeter for one unit. Specify the number of
decimal places for your readout using preci­
sion, as in Figure 1.2.

The engineering and architectural modes as­
sume that one drawing unit equals one inch.
Again set your precision, as shown in Figure
1.3. Fractional and scientific settings will
give a readout in those specific units. Again,
the UNITS cOlnmand only sets the readout. If
you are setting your UNITS in inches, but your
'Insertion scale' is luillimeters, then you will
have problems later.

The UNITS command can be accessed either Figure 1.3

through the command line or through the
UNITS dialog box from the Fonnat pull-down
menu at the top of your screen.

i
Ilf you press the space bar before
entering any other command just as
you open the file, the system might
offer you the 'HELP' files. To get the

'HELP' files off screen, click on the Xat

the top right.

Figure 1.4b

2 CHAPTER ONE
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(:hoosing the
Origin

The origin or 0,0 should be the most easily accessible point on the design. If a large
percentage ofthe dimensions on a drawing stem from one point, it should be made the
origin. The coordinate readout on the bottom of the screen is there to help you fmd
your position. The placement of the origin is important to establish a base for your
readouts. It will be more important later when merging files.

To move 0,0 from the bottom of the screen use the PAN command, as in Figure 1.5.

y

Figure 1.5

Often you can press down on the roller ball ofyour mouse to get PAN. The command
line equivalent is PAN or just P.

Command: PAN
(drag the icon across the screen to where you want it)

In architectural drawings the origin is often at the bottom left comer, as in Figure 1.6.

upper right 35',30'

0,0*===::::::=a_-=!.I
-2',-2' lower left

Figure 1.6

0,0

-5',-5' lower left

upper right 50',45'

1
42'

1
In mechanical applications it is often in the center, as in Figure 1.7_

upper right 2,2 upper right 10,20

-2,-2 lower left

Figure 1.7

1.2

-10,-20 lower left
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Using PAN to
get Started

I
iIn the command examples, the bold
type is the user entry or response.

The easiest way to start a file is by using 0,0 as the starting point. Use PAN to move the
origin or 0,0 to the center of the screen. Then draw your first object using 0,0 as the
fIrst point.

The PAN command is as follows:

The command line equivalent is PAN or P.

Once centered, draw a circle, then use ZOOM All to fit it to your screen, as in Figure
1.8. The same can be done using LINE. The CIRCLE command is explained further on
page 11, but the commands below will show how it works.

PAN

Figure 1.8

y

~x

CIRCLE ZOOM ALL

The LIMITS
Command

4 CHAPTER ONE

Command:PAN (move your 0,0 to the center of the screen as in

Figure 1.5)

Command:CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan

radius)] :0,0
Specify radius of circle or [Diameter]<1'-O">:5

Command: ZOOM

Specify corner of window, enter a scale factor (nX or nXP),

or [All/Center/Dynamic/Extents/Previous/Scale

/Window/ObjectJ<real time>:ALL

LIMITS sets a flexible general size for your drawing. LIMITS sets the size ofyour screen
and the area covered by the screen grid. Unlike drawing on paper, you can change the
LIMITS size at any time. It simply gives you a place to start and helps provide a visual
size that you can identify with.

The command line equivalent is LIMITS.

Setting LIMITS does not limit your model; it merely lets you determine how big the fin­
ished product might be. You can reset the LIMITS at any time simply by picking new
points on the screen. ZOOM All allows you to view the size you have chosen.

More free ebooks  :  http://fast-file.blogspot.com



Open acad.dwt. Change your

UNITS to Architectural and draw
in a line .. ZOOM All to see it on

the screE"n.

Use LIMiTS; GRID and SNAP to

set up a drawing environment.

Draw a line or circle the size of

your part, then use ZOOM All.

Set up your LIMITS, GRID and
SNAP if they might be useful.

Draw a line or circle the size of
your part, then ZOOM All.

A Sample Set Up

A house that is 40' x 36'.

The following commands will center the frrst line on your screen without LIMITS.

Command: LINE

LINE Specify first point:O,O

Specify next point or [Undo] :40' ,0
Specify next point or [Undo]:~

Command: ZOOM

Specify corner of window, enter a scale factor (nX or nXP),

or [All/Center/Dynamic/Extents/Previous/Scale

/Window/Object]<real time>:ALL

You can also draw this using LIMITS.

Command: LIMITS

Reset Model space limits

Specify lower left corner or [ON / OFF]
<0'-0",0'-0">:-5' ,-5'

Specify upper right corner <12.0000,9.0000>:45' ,40'
Command: ZOOM

Specify corner of window, enter .... /ObjectJ<real time>:ALL

Cornmand:LINE

LINE Specify first point:O,O

Specify next point or [Undo] :40' ,0
Specify next point or [Undo]:~

Setting LIMITS, SNAP and GRID

LIMITS sets an overall size for your design. SNAP sets an increment that the cursor will
move by. GRID sets a visual aid to help you place objects, and is often set to twice the
SNAP value. The grid will extend over the area given by the LIMITS command.

To find GRID and SNAP:

The command line equivalent is SNAP or GRI D.

Command: LIMITS
Reset Model space limits

Specify lower left corner or [ON/OFF]<0.OOOO,O.OOOO>:-S,-40
Specify upper right corner<12.0000,9.0000>:240,180

Command: ZOOM

Specify corner ..... Extents/Left/Previous/Scale/Window]<real

time>:ALL

Command: SNAP

Specify snap spacing (X) or

[ON/OFF/Aspect/Rotate/Style/Type]<1.0000>:5

Corn...'Tland: GRID

Specify grid spacing or [ON/OFF/Snap/Aspect]<O>:10

Introductory Geometry and Setting Up 5
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Entry of Points

Coordinate Entry
using Absolute,

Relative, and
Polar Values

The DYNamic function is very useful
but confusing at first. Turn it off for
coordinate entry by clicking the icon.

DYNamic off

DYNamic on

6 CHAPTER ONE

All parts of geometry are entered by means of points. Lines have two points each.
circles have a centerpoint and a point determining the radius. Arcs have a center point,

a radius point, a start point, and an end point.

There are three ways of entering points:

by coordinates: absolute values, relative values, or polar values

picking them on the screen, with or without SNAP or DYNamic

relative to existing geometry

In this chapter we will look only at the first two methods ofpoint entry. The LINE com­
mand will be used to illustrate coordinate entries.

The LINE Command

Find LINE as follows:

The command line equivalent is LINE or the command alias L.

Co~~and:LlNE or L

To create a LINE, you will need to know where it starts and where it ends. Pick two or
more points on the screen or enter the coordinates. Tenninate the command by press­
ing the Enter key (.J) .

The coordinates of an item, the X and Yvalues, can be entered either relative to the
origin (the absolute value of the line) or relative to the last point entered (the

incremental value).

Absolute Value Entries

In this method, the origin of the model or drawing does not change: the objects are
placed relative to the origin. To enter the absolute value ofan item, type in the X value,
then the Y value, separated by a comma. You will need to enter two sets of values to
draw a line. Press the enter key -I to signal the end of the coordinate entry and you
should get the line shown in Figure 1.9.

Command:LlNE

Specify first point:O,O

Specify next point or [Undo] :4,0

Figure 1.9

This will draw a line from the absolute position of 0,0 to the absolute position of
4,0.
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Relative Value Entries

To enter an incremental or relative value, type the @ symbol (Shift-2) before the
number. @ means 'from the last point.'

Command:LINE

Specify first point:2,3

Specify next point or [Undo] :@4,0

This will draw a line from the absolute position of2,3 to a position 4 units in positiveX
from this point.

Try these two examples:

Absolute
Comrnand:LINE

Specify first point:O,O

Specify next point or[Undo] :4,0

Specify next point or[Undo] :4,4

Specify next point or [Undo] :0,4

Specify next point or [Undo] :0,0

Specify next point or [Undo]:~

D

Figure 1.10

Relative
Comrnand:LINE

Specify first point:5,5

Specify next [Undo] :@4,O

Specify next [Undo] :@O,4

Specify next [Undo] :@-4,O

Specify next [Undo] :@0,-4

Specify next [Undo] :~

The example on the left in Figure 1.10 is a four-unit square starting at 0,0. The example
on the right is a four-unit square starting at 5,5. Both squares are created relative to the
origin, 0,0.

To draw a line from point 5,6 to point 8.3,6 use either of the following:

Absolute
Command: LINE

Specify first point:5,6

Specify next point or[Undo] :8.3,6

Relative
Command: LINE

Specify first point:5,6

Specify next[Undo] :@3.3,0

In choosing between the absolute and the incremental method, the deciding factor is
what you know. Ifyou know that the final point is going to be 8.3,6, use the absolute
value. Ifyou know that the line is going to be 3.3 units inpositiveXfrom the last point,
then enter the incremental coordinates. AutoCAD will do the calculations.

Introductory Geometry and Setting Up 7
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Polar Value Entries

Polar coordinates allow you to enter an item, relative to the last item, at a specified
length and angle. Angles are normally calculated counterclockwise from the positive
X direction, as shown in Figure 1.11.

Command: LINE
Specify first point:3,4
Specify next point or [Undo] :@4<45

~@4<45

3,4 </,,---4-------J45
0

Figure 1.11

90

180 --+-+-----'-~-

270

o

Where: @
4

<
45

relative to the last point
the length of the line
angle
the angle that the line will be drawn at; all angles are calculated

counterclockwise

@1<210

Try this example:

Command: LINE
Specify first point:6,O
Next point:@2<O

Next point:@3<90
Next point:@2<O

Next point:@1<270

Next point:@2<O

Next point:@2<90

Next point:@6<150

Next point:@1<210

Next point:C (for close)

Close

6,0 @2<0

@6<150

@2<90
@2<0 @1<270

@
@2<O

3<90

Coordinate Entry
using SNAP,

ORTHO,POLAR,
and DYNAMIC

8 CHAPTER ONE

As noted above, angles are calculated counter- Figure 1.12

clockwise from the furthest point in positive X

Functions that can help you enter your drawing information are found at the bottom of
your screen. The lefthand button on the mouse will enter a point every time you press it
while in a draw command. Yau can make your digitizing or picking of points much

easier and more accurate by using functions such as SNAP, POLAR and ORTHO. The
function bar is shown in Figure 1.13.

Figure 1.13
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SNAP on

SNAP off

SNAP
With SNAP you can draw lines, arcs or circles at preset integers. SNAP can also be set at

an angle or on an isometric. GRID follows the SNAP settings. More advanced SNAP
functions are found in Chapter 2. Ifyou set the SNAP to .25, all entries will be rounded
to the nearest .25 interval as shown in Figure 1.14.

6.25,6.75

9.50,4.75
3.75,4

Figure 1.14

The toggle turns SNAP off and on, you need the command to change the size.

Command: SNAP

Specify snap spacing (X) or

[ON/OFF/Aspect/Rotate/Style!Type]<1.0000>:.25

Try repeating the examples on pages 7 and 8 using the mouse and setting the SNAP
value to 1. If the coordinate readout does not move, press F6. Remember that it is a
three-way toggle; off, absolute, and incremental. If you set SNAP to 1, all the points
you digitize or pick from the screen will be accurate to one-unit integers. You cannot
be accurate without using SNAP and/or POLAR.

ORTHO

With the ORTHO option (F8 or the ORTHO button ), lines can only be drawn vertically
or horizontally. Draw a LINE across your screen. Keep adding segments to the line and
tum ORTHO on. You will notice that the cursor only goes vertically and horizontally.
By turning ORTHO off, you will be able to draw diagonal lines again.

The GRID (F7 or the GRID button) gives you a visual display of distance.

POLAR is very useful for placing
lines and determining distances.
Use it with SNAP for accuracy.

POLAR

Now tum ORTHO offand POLAR on. AsshowninFigure 1.15, POLAR allows lines to
be drawn vertically or horizontally at a given distance and it gives the incremental dis­
tance from the last entered point. The button is on when it looks pushed in.

IPOLAR
+_.-

Figure 1.15

Command: LINE

Specify first point: (pick a point) (with POLAR on move your

cursor to the right)

Specify next point or [Undo] :60

Specify next point or [Undo] :50 (move your cursor up)

The line will be drawn 60 units in positive X and 50 units in positive Y. POLAR will al­
low length entry for lines going 0,90, 180 or 270 degrees. Leave these lines on screen.

Introductory Geometry and Setting Up 9
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DYNamic
The DYNamic function displays the command line beside the cursor. DYNamic also
gives you a dynamic angle readout. You can draw lines at anglesin a similar way to
drawing using the POLAR option. Beware, however, because these angle readouts are
not given in decimal places; lines drawn in using DYNamic are not always accurate.
Change your angle precision in UNITS for more accuracy. Place one line beside the
otheras i n Figure 1.16. Zoom in to see how accurate they are.

••• 11I: •

...:..••.:~I/........k::x ;
dynamic

Figure 1.16

\/
I

coordinate entry

T

Command: LINE
Specify first point:O,O

Specify next point:l00

Command: LINE
Specify first point:O,O

Specify next point:@100<33

The second line in Figure 1.16 is accurate, the first is not. The line put in using the DY­
Namic angle is approximately 33 degrees, but is actually placed whereever your cur­
sor is between 33 and 34 degrees.

The DYNamic readout is useful for those who like to read their cOlmnands on the dis­
play screen rather than on the command line. In Figure 1.17, the ERASE command is
being used and the user is selecting the obj ects to be erased.

· .

Command: ERASE
Select objects: (pick 1)

Select objects: ~

Turn DYNamic off for coordinate

entries.
With geometry commands, you are prompted
for each point entry or value.

Figure 1.17

10 CHAPTER ON E

The value box will turn from
blue to white as you enter the
value, as shown in the radius
option of Figure 1.18.

Comrnand:Circle

Specify center point

for circle or

[3P/2P/Ttr (tan

tan radius) J :0,0

Figure 1.18
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Geometry
Commands

Without SNAP or coordinate entry
using POLAR or not your lines will

not be accurate.

All geometry commands are similar in the way they are entered. The user picks the
command LINE, CIRCLE, ARC, etc., and then AutoCAD will prompt for the points or
distances needed to create that geometry.

The LINE Command

The LINE command is as simple as the above examples indicate. With either a pick on
the screen or a coordinate position you can tell AutoCAD where each point should be.
Any combination ofpoints is accepted. Use the enter key.J to exit the command.

~~ ~ti~ /
.~ ~

~~; ",,1

The command line equivalent is LINE or L.

Cornmand:LINE

Specify first point: (pick a point)
Specify next point or (Undo) :@3<250

Specify next point or (Undo): (pick another point)

Specify next point or (Undo):~ (Enter)

When drawing lines, you are creating objects that are described by two points; a begin­
ning and an end. Any number ofpoints can be entered in the LINE command with each
point joined to the last by a separate line. Ifyou have entered five or six points in a sin­
gle command, any of the lines can be erased.

LINE Options

C will close the string of lines with a line from the last point to the first point.

U can be entered within the command line to undo the last entered point.

The CIRCLE Command

When drawing a CIRCLE you are also describing an obj ect that has two points; a center
and a radius. An ARC has four points: a center, a radius, a start, and an end.

The CIRCLE command will prompt you for the information needed to cOlnplete the
circle.

The command line equivalent is CIRCLE or C.

Figure 1.19 shows a circle with a radius of 4.

Command: CIRCLE

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)]: (pick a

point or type 0,0)
Specify radius of circle or

[Diameter}<l'-O!l>: (pick another point

or type in a radius value, for

example 4)

Figure 1.19

4,0
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Turn OSNAP off if your cursor
keeps going to another obiect on

..the screen.

Where: 3P = a circle fitted through three points
2P a circle fitted through two points
Ttr = a circle that is tangent on its diameter to two selected objects

indicated with a specified radius

Options appear when you type in C or CIRCLE. The default is to have a circle defined
by the radius. Type in D then space ifyou prefer to enter a diameter.When picking C IR­
CLE from either the screen menu or the pull-down menu, you will be prompted for one
of the options listed above.

The ARC Command

Arcs are also created by using options to control how the ARC is entered. The default is
to define the first, then the second, then the third or final point of an arc.

The command line equivalent is ARC or A.

The default arc is created through three contiguous
points. Pick three points on the screen after initiating
the ARC command as shown in Figure 1.20. The points
can be entered with SNAP on, by coordinate entry, or by
using existing objects with OSNAP, as shown in Chap­
ter 2. Figure 1.20

Command:ARC

ARC Specify start point of arc or [Center]: (pick point - 1)

Specify second point of arc or [Center/End]: (pick point - 2)
Specify end point of arc: (pick a third point - 3)

There are many variations on the ARC command.

You can access all ARC options through the Draw pull-down menu under Arc. Should
you want to enter the options at the command line, simply type in the option that you
want. Only the first letter ofthe option is required: e for end, r for radius, etc. Put in the
arc using the Start End Radius fonnula, as shown in Figure 1.21.

12 CHAPTER ONE

Command:ARC

ARC Specify start point of arc or

[Center] : (pick 1)

Specify second point of arc
or [Center/End]:E
Specify end point of arc: (pick 2)

Specify center point of arc or

[Angle/Direction/Radius] :R

Specify radius of arc <0.00>: (pick

3)

ARCs will be calculated counterclockwise.

Figure 1.21
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View Commands

The FILLET Command

The FILLET command provides an easy way to place an arc between two existing ob­
jects, usually lines. FILLET can also be used with radius 0 to clean up comers and con­
nect lines to an apex.

::,--

r
n

~f,f::~~~ ...""" ...".."..

The command line equivalent is FILLET or F.

- -':*- - --

1

~
2:

j

Figure 1.22

Command: FILLET

Current settings: Mode = Trim,Radius = <5.0000>

Select first object or

[Undo/Polyline/Radius/Trim/Multiple] : (pick 1)
Select second object: (pick 2)

In Figure 1.22 the default radius of5 was used. To change the radius choose the option
R. Always press the enter key -l after letter options. In the example below the option R
to change the radius, has been used to create a FILLET with the new radius value of 12.
Note that Rmust be followed by a space. R indicates that you would like to enter a new
radius value, the actual number is entered on the next line.

Cornmand:FILLET

Current settings: Mode = Trim,Radius = <5.0000>

Select first object or

[Undo/Polyline/Radius/Trirn/MultipleJ :~

Specify fillet radius:12
Select first object or

[Undo/Polyline/Radius/Trim/MultipleJ : (pick 1)
Select second object: (pick 2)

The View menu and toolbar offer commands which will change the display of the
model or drawing relative to the screen. Commands from the View menu will not
change the coordinates or position of the model or the database. They only change the
way you look at it. The following commands appear in the View menu:

ZOOM
PAN

REDRAW
REGEN

magnifies a section of the screen
moves the model across the screen without changing the
magnification factor (zoom)
updates the view and erase marks
recomputes the file

Ifyour scroll bars are not displayed, go to the Tools pull-down menu and choose Op­
tions, and then the Display tab.

Introductory Geometry and Setting Up 13
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The ZOOM Command

ZOOM is accessed by typing it on the command line, using the slider bars on the top
and bottom of the screen, or using the pull-down menus or the standard toolbar. For
the ZOOM options on the toolbar, hold the Zoom Out button down and the options will
be shown.

ZOOM is a transparent command which means it can be used with the icons below
within a command string.

The command line equivalent is ZOOM or just Z.

Command:ZOOM (or Z)

Specify corner of window, enter a scale factor (nX or nXP) , or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object]<re

al time>:

The options for the Zoom command are:

All (A)

Center (C)

Dynamic (D) =

Extents (E)

Previous (P)
Realtime

Window(W)

Scale nX
Scale nXP

expands or shrinks the lllodel or drawing to fit onto the
screen relative to your limits
centers the model on the screen; you mustenter a

magnification factor or "height"
creates a dynamic display of the item for zooming

expands or shrinks the model or drawing to fit all of the
objects on screen
returns you to the Previous zoom factor
zooms interactively to a logical extent. Activate with either
the button or a right-click
describes by two diagonal points a rectangle around the

area you want to view
specifies a percentage of the existing size
specifies a size relative to paper space

Many mice have a roller ball that acts as a ZOOM function. Roll the roller ball to
change the Zoom factor, or press down on it and move it across the screen to PAN. In
Release 2008 the ZOOM function on the roller ball sometimes malfunctions. Use
ZOOM All or ZOOM Extents to center your drawing on the screen.

Zoomed in

Figure 1.23

Original Zoomed out

14 CHAPTER ONE

In Figure 1.23 the object is centered on the screen using ZOOM ALL. Ifyour object gets
lost use ZOOM ALL to get it back on screen.
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ZOOM Window

\
!
I
i
I

I
I

I

Figure 1.24

Comrnand:ZOOM (or Z)
Specify corner of window, enter a scale factor (nX or nXP),

or [All/Center/Dynamic/Extents/Previous/Scale

/Window]<real time>:W

Specify first corner: (pick 1)
Specify opposite corner: (pick 2)

ZOOM Extents

Figure 1.25

Command:Z

Specify corner of window, enter a scale factor (nX or nXP),

or [All/Center/Dynamic/Extents/Previous/Scale

/WindowJ<real time>:E

ZOOM with scale

Figure 1.26

Scale works like this: .8x will display an image at 80% of its current size; .5x will dis­
play an image at half the current size; and 2x will display an image twice the size ofthe
current size.

Comrnand:Z
Specify corner of window, enter a scale factor (nX or nXP),

or [All/Center/Dynamic/Extents/Previous/Scale
/Window]<real time>: .5x
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ZOOM All is yourfriend. If you lose
all your objects, just ZOOMAII and
they will magically reappear.

Zooming In and Out

Zooming in doubles the size of the image, zooming out reduces the image by half.

Zoom Limits shows the screen limits. Ifyou have a center rolling wheel on your mouse
you can zoom in and out quickly, but ZOOM Window is usually more efficient.

ZOOMAJI

To display the entire drawing, use ZOOM All or ZOOM Extents.

Cornmand:ZOOM
Specify corner of window, enter a scale factor (nX or nXP),

or [All/Center!Dynamic/Extents/Previous/Scale!Window]<real

time>:A

The PAN Command

To move the view across the screen without changing the display size, use PAN as
shown in Figure 1.27.

X 1

Figure 1.27

X 2
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Command:PAN (or P)

Press ESC or ENTER to exit, if you have a roller on your

mouse, just press down and move it to PAN.

PAN and ZOOM

The PAN command moves the model across the screen, while ZOOM magnifies the
model within the screen. The database, i.e. the 0,0,0 point and associated coordinate
points, remain the same.

The roller ball can be very useful in placing the image on the screen, but be sure to ex­
periment with ZOOM All and ZOOM with a window (pick two points around what you
want to look at) and you may find these useful as well.

Windows Scroll Bars

Windows scrollbars can be used instead of the PAN command. To move the drawing
up, pick the down arrow on the vertical scroll bar. To move the drawing to the left, pick
the right arrow on the scroll bar. Ifyou have a smaller screen, you may want to have the
scroll bars not displayed. To remove them from the screen, choose the Tools menu,
then Options, then Display. Remove the check mark from the box beside Display
Scroll Bars.

REGEN

While your data are always available, to save memory, they are not always completely

generated. The REGEN command (RE) is used to update arc and circle displays to make
the objects look more rounded. If your arcs are choppy or squared, use REGEN to
update the screen to the current magnification factor and display a superior image.
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Figure 1.28

Alternate Units

Remember that UNITS only
changes the readout. To be

-accurate, use SNAP or coordinates
-to place points.

It is important to have the correct nomenclature when entering geometry.

Architectural
Command: LINE

Specify first point:2,3 (X 2 inches, Y 3 inches)
Specify next point or (Undo :@4',0 (4 feet in X, none in Y)

Specify next point or (Undo) :@O,2'3 (none in X, 2 feet 3

inches in Y)

Specify next point or (Undo) :@3'4-1/2",O (3 feet 4 1/2

inches in X, none in Y)

~"'ractional

With fractional units the information is entered as a fraction with a slash (I). For mixed
numbers a hyphen (-) must be added with the slash (I).

Command:LINE

Specify first point:1-1/2,2-3/4

Specify next point or (Undo) :@3/4,O

Surveying

The surveyor's compass rose is much the same as a ship's compass. It is divided into
four parts with the top being north, the left being west, etc. Angles are expressed in 90
degree quadrants.

The quadrant between north and east, for example, starts at 0 degrees due east and pro­
gresses 90 degrees to due north. To express 25 decimal degrees using AutoCAD's de­
fault origin for angles, enter N25dO/Q"E. You may omit null minutes and/or seconds
and enter N25dE.

When entering this measurement, do not use spaces.

Command:L

Specify first point:O,O

Specify next point or (Undo) :@38<S44d14'9"W

Measuring Angles

AutoCAD's default setting for angles is zero de­
grees at due east. You may change this zero­
degree reference point to due north, due west, or
due south. These are the only four positions of­
fered by the UNITS command. To orient the zero
reference at an angle other than those specified,
you can change the user coordinate system
(UeS) as explained later.

Untranslated Angles: lfthe UNITS command is
set to a nondecimal angular mode (e.g. radians),
an angle can be preceded by a 'less than'symbol
< to enter a measurement counterclockwise
from 3 o'clock.

If an angle measurement direction or origin has
been changed, enter < before an angle measurement to have the angle measured coun­
terclockwise from 3 o'clock.

Change the precision ofyour angle readouts to show up on the POLAR and DYNamic
readouts, as shown in Figure 1.28.
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Step]

Open AutoCAD. IfAutoCAD is already running, pick File from
the pull-down Inenu (top left), then New to start a new file in met­
ric by using acadiso.dwt.

Use the Tools pull-down menu and Drafting Settings or the

following typed commands to set your LIMITS and SNAP. Then

pick ZOOM All from the View pull-down menu, use the icon
shown, or type it in.

The bold type in the following c01TIlnands is the user response or

what you type in. Use the Enter Key .J to enter each command or
value.

Command:LIMITS.J

Tools Dra'H Dimen

layer...

LSl.yer tools

!:.olor ...

Liuetype...

Line~ejght..•

5cal!t,List ...

/;? Text ~tyle".

~ QimensKln style...

~. T~Style ...

eoint Style...

MuJtmne Style, ..

~njts ...

dl' Thickness

.4t".!IM~
Rename. "

Step 2

/

Step 3

Reset model space limits

Specify lower left corner or [ON/OFFJ<O.OOOO,O.OOOO>:-S,-5.J

Specify upper right corner<12.0000,9.0000>:100,60.J

Command: (from the View pull-down menu, pick ZOOM All)

Command: SNAP
Specify snap spacing (X) or

[ON/OFF/Aspect/Rotate/Style/Type]<1.0000>:5

Start by drawing a series of lines using absolute coordinates. Turn DYNamic off.

Command:L.J

Specify start point:O,O~

Specify next point or [undo] :75,0....1

Specify next point or [undo] :75,50.J

Specify next point or [undo] :0,50....1

Specify next point or [undo] :c.J

Command: ZOOM

Specify corner of Scale/Window] <real time>:Extents

Command: ZOOM
Specify corner of Scale/Window]<real time>:.8x

Make sure that ORTHO, and OTRACK are off, but that POLAR and SNAP are on.

+

When entering coordinates, make

sure your DYN button is turned
off! Its on the bottom line of your

screen

Then draw in the next lines using POLAR to
complete an inside rectangle. Move your
cursor directly up, down, right or left from the
last entered point.

I
I

/
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Command:L.J

Specify start point:5,5.J

Specify next point or

[undo]: (move your cursor to the right)65.J

Specify next point or [undo]: (move your cursor up)40.J

Specify next point or [undo]: {move your cursor left)65.J

Specify next point or [undo] :c.J
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Step 4

Use the enter key .J at the end of

each typed entry to send the
information to the computer or to

exit you from the LINE command.

Enter a line at an angle from 10,10.

COffi...rnand:L
Specify start point:10,10
Specify next point or [undo] :@20<30
Specify next point or [undo]:~

Then another from the opposite direction.

Command:L

Specify start point:50,10
Specify next point or [undo] :@20<150
Specify Dext point or [undo]:~

StepS Notice that the ends of the diagonal lines are not

near the snap points. ZOOM into the end ofthe line
on the left to start adding circles. Use either the

icon or type the letter Z.

Command:Z

Specify corner of window, enter a

scale factor (nX or nXP), or

[All/Center/Dynamic!Extents/Previo

us/Scale/Window]<real time>: (pick 1, pick 2)

Make sure SNAP is on too. Use the CIRCLE command with DYNamic.

Command:CIRCLE

Specify center point for circle

or [3P/2P/Ttr (tan tan

radius)]: (pick the snap point

to the right of the end of the

diagonal line)
Specify radius of circle or

[Diameter]<1.OOOO>:2.7

The radius of the circle will snap
to the closest snap point. Yourra­
dius entry at the command line
will override this. When asked B
for the radius, use .J to accept
the default.

Command: CIRCLE

Specify center point for circle or [3P!2P!Ttr (tan tan
radius)]: (pick the snap point shown)

Specify radius of circle or [Diameter]<2.7000>:~
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Step 6

Step 7

Now use ZOOM All to place your total image within your screen again.

Then use CIRCLE with the Ttr option to add a circle in the center.

Command:CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan

radius)] :Ttr

Specify point on object for first tangent of circle: (pick

the first circle)

Specify point on object for first tangent of circle: (pick
the other circle)

Specify radius of circle <2.7000>:10

Finally add some FILLETs to the inside rectangle.

r----~--------------------
: 2

tl
I
I
I
i
I
I
I
I
I
I

20 CHAPTER ONE

~ Command: FILLET

Current settings: Mode = Trim,Radius = <5.0000>

Select first object or

[Undo/Polyline/Radius/Trim/MultipleJ :r

Specify fillet radius:l0

Select first object or [Undo/ Multiple]: (pick 1)

Select first object or [Undo/ Multiple]: (pick 2)

Continue to fillet the edge until your drawing looks like the one on the right above.
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In this tutorial we will create a drawing in imperial measurements without using LIMITS
or SNAP. Make sure your status bar looks like this: only MODEL and POLAR on:

Step] LIMITS, GRID and SNAP are very useful for placing items that are rectilinear with regu­
lar integers. For many applications, they are simply not needed. Here is how to get
started without them.

First open a new file and make sure that the units are imperiaL Pick either File, then
New, or pick the icon from the Standard toolbarwhich should be on the top left ofyour
screen.

Command:NEW

Then choose acad.dwt from the list of template
options.

Another way to get started is to use STARTUP.

"eipTW"e~e$ ... ---~.~~-~­
faI~etsets
lIacad·~NamedPlotStYle$.dwt

lIaC~i£9'At
lIIacgolS0 ..NamedPiat 5t~S.dwt
IIJqc&iiso·d~

IIIANSIA (oortrait:J·"€oIor DeOe...

Step 2

Step 3

Command: STARTUP

Enter new value for

startup <0>:1

Command:NEW

(Choose imperial)

Now set your UNITS to architec­
tural.

Command:UNITS

Set your units to architectural.

Choose the 11'" under Precision.
There is no need to change the
Angle readout.

Choose OK.

Now draw a CIRCLE, then use
ZOOM to place it on the page.

Command:CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan

radius)] :0,0

Specify Radius of circle or [Diameter] :4'

Don't forget the foot symool. AutoCAD defaults to inches, so if you only enter 4 as
your value it will be accepted as four inches not four feet.
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Step 4 You will not be able to see the object on screen, so
use ZOOM to place it.

Use the roller on your mouse, the icons, or simply Z
from your keyboard to start the ZOOM command.

Command:Z

Specify corner of window, enter a

scale factor (nX or nXP),or

[All/Center/Dynarnic/Extents/Previous

/Scale/Window] <realtirne>:A

Comrnand:Z
Specify corner a f window, enter a

scale factor (nX or nXP), or

[All ..... ow]<real time>: .5X

This centers your circle on the screen. Let's assume
this circle is a patio table, now let's make chairs.

-i;
!

StepS

Step 6

Use the LI NE command to create a small rectangular chair. Use POLAR to make the
chair 24" x 18". Just move the cursor directly right, then up, and type in the value.

Conunand:LlNE

Specify first point: (pick a point to start)

Specify next point or [Undo] :24 (move the cursor right)

Specify next point or [Undo] : 18 (move the cursor up)

Specify next point or [Undo] :24 (move the cursor left)

Specify next point or (Undo) : c

Now use CIRCLE and ARC to create another type of chair.

a

Comrnand:CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan

radius) ] : (pick 1)
Specify radius of circle or [Diameter] <1'-0">: (pick 2)

Command:ARC

ARC Specify start point of arc or

[Center] : (pick 3)
Specify second point of arc or

[Center/End] : (pick 4)
Specify end point of arc: (p~ck 5)

Command: (from the View pull-down

menu, pick ZOOM All)

22 CHAPTER ONE

Step 7 The only way to make progress is to practice. Use ZOOM to zoom in and out, creating
more chairs.
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Exercise 1 Units Practice 1
Open a NEW file and set the UNITS accordingly.
PAN the origin (0,0) onto your screen and draw in the first line starting at 0,0.
Use ZOOM All or your roller boll to adjust the size of your image.

1--:---- ----~--~9~~~_11_i================-2-~-=1---J

-l
4 3 11

4 4

I

3
4

3
4

--- - ----- - ------

Rl

FRACTIONAL

8'

2,50

~2'OI0---1~
~O,80 ~~

r---I---f--+ 2,83

-~~1,20 ~

90"

~L 1,00 135' 2,12

I I~
~L50

3,00---j

DECIMAL

"-
In

I

(\J
]

90"

~ ARCHITECTURAL

-- -~----- ,.------.

ENGINEERING

1250E+001

12,60l+00 f
3.04E +00

--....--117"'(j
I---l.20E+00~

SCIENTIFIC

1
l' -6,0 11

~

01'-6.0 11

1'-3,0", I

f.---~- 5'-0.1' ------~

I

3 ,_ 3,0/' --.--f---f---11'-60'
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Exercise 1 Units Practice 2
Open a file in imperial units - acad.dwt - and set your UNITS.
Use PAN to move the object onto your screen and start drawing from 0,0.

'"(\J
I
~

20/-4 If

4'-6/
1 -I

3 1

ARCHITECTURAL
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SURVEYORS
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Exercise 1 Practice
LIMITS may be used to get started, or put in the first line and ZOOM ALL.
GRID and SNAP make these much easier. Don1t forget POLAR.
These objects are drawn individually as practice. They are not scaled to the page.

L50

U
~ ~,25

1---5,75----l

IblQ

3.50 I
~5D 2'10

-'---'--._;:======-""'11--_---'~
3,00-1 I

1----5.50---1

r-- 2.50T 2.00-1c-
5.501~

t
.5,

le
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Exercise 1 Architectural
Open an imperial file - acad.dwt - and draw the objects as shown.
Do not attempt to dimension the drawing.

I Command:ONITS, Architectural, Precision 0'-0"
Command: LIMITS
Reset model space limits
Specify lower left corner or [ON/OFF]<O,O>: -2' ,-2'
Specify upper right corner<12,9>:25' ,20'
Command: SNAP
Specify snap spacing (X) or [ON/OFF/Aspect/Rotate/Style/Type]<l>: 3
Command: GRID
Specify grid spacing or [ON/OFF!Snap/Aspect] <1>: 6

15'

~

I~
tT

Rl~

~
,I
..q-

'"

I

2' fl ~

[
I,Q
I

8

)Y (ryl ~
I

80
In

~ ~.
t ] f[10' 8' 10'

08
3' 2'-6'" 2'-6"

,
2'-6 6 ) 2' 2'-6'

I T I I r

e
e
o
[

-=L11. 1'-6' "I g]
II 2' ·1

~~
1'-8"

I

1
~ 4'"

I--..-:-

~

8

Kitchen Layout
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Exercise 1 Mechanical
Open a NEW file in metric, acadiso.dwt, and draw the object below.
The GRID and SNAP will help you get started.
Some people find LIMITS handy.
Draw the LINEs first, then add the CIRCLEs, ARCs, and FILLETs.

Command: UNITS, Decimal, Precision 0
Command: LIMITS
Reset model space limits
Specify lower left corner or [ON/OFFJ<O,O>:-lO,-40
Specify upper right corner<12,9>:220,110
Command: SNAP
Specify snap spacing (X) or [ON/OFF/Aspect/Rotate!Style!Type]<lO>:5
Command: GRID
Specify grid spacing or [ON/OFF!Snap!Aspect]<10>:lO
Command: (from the View Pull Down menu, pick ZOOM ~l)

R25
¢30

R35

210

70 30 70R15 R15

10

I fl 75

100 20

R20

R6

Template
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Exercise 1 Woodwork
Start a NEW file in metric - acadiso.dwt - and set it up as shown.
Either use LIMITS as shown below, or put in a line from 0,0 to 580,0 and ZOOM ALL.

Command: UNITS, Decimal, Precision 0
Command: LIMITS
Reset model space limits
Specify lower left corner or [ON/OFF]<O,O>:-lO,-lO
Specify upper right corner<550,340>:1000,800
Command: SNAP
Specify snap spacing (X) or [ON/OFF/Aspect/Rotate/Style/Type] <10>: 5
Command: GRID
Specify grid spacing or [ON/OFF/Snap/Aspect] <10>: 10
Command: (from the View Pull Down menu, pick ZOOM All)

I

270_---1 r--

305

35

580

l J t 0
f'...

l J
0
f'...

l J a
f"'--.

l J a
f'...

l
0
CD

l+
-.;;t a
0J 0J

R12 i
.--i

96 f In
Ln
.--i

T
-- I-- 20 Ln

(Y)

Paper Cabinet
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Help Files, OSNAP, OTRACK,
BREAK, TRIM, and ERASE

Once you have learnedhow to sign on to the system and have located all the menus, you
can learn the system from on-screen documentation.The Help files have two main
functions.

The first function serves as an index ofcommands. When looking for a command that
will change the magnification of the data on the screen, you may be able to spot it by
using the following (Note: There is no ~Ask Me' in Release 2007 or 2008).

displaying
spacing

setting
"Is. snap grid spacing

grid View window in dbConnectt elements
grid [dr':~Wlrlg

Ifyou have just opened a new file in AutoCAD, you can get to the Help files simply by
pressing the space bar before entering a command.

Use the X at the top right of the dialog box to remove the box from your screen.

The Help index gives you a listing ofthe various commands which are available on the
system. Once you have found the correct command, you can retrieve information
about how it works.

AutoCAD responds to any command with a series ofprompts. The Help files explain
those prompts.

On any version of AutoCAD, the Help files explain the syntax or command line se­
quence, and the prompts and options of each command.
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Understanding
Command

Strings

Creates a circle

~ [k<l;W menu: Circle

I!!Command line: circle

Command strings are generally very similar in construction. Once you understand
how they work, your AutoCAD skills should improve very quickly.

Option and Default Brackets

The AutoCAD commands are set up so that you can understand what the options are
and accept the defaults within the commands. Once you understand how the com­
mands are set up, it should be easier to figure out how to use theln. Remember you are
in control.

Defaults

The information offered in angle brackets, < >, is the default. This is what the com­
mand will do if you do not specify something else.

Specify center point for circle or [3P Hhree PQlnts)i 2P (Two Points)1 rtr (tan tan
radiusl]: Specify a point Of enter an option

In the case ofthe CIRCLE command, the previous radius is used by default ifno other is
specified. The square brackets offer you construction and diameter options.

Ifyou have asked AutoCAD to construct a circle for you, you will then be prompted
for the information needed to construct that circle.

Command:CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan Lan

radius) ]: (pick a point)

Specify radius of circle or [Diameter] <5.00>:

The first line says that by default you start the circle by indicating the center point.

2

Center/Radius

Figure 2.1

2
2 Point

1

o
2

3 Point

Then you can specify the radius or, with the use of' D' to indicate diameter, you can in­
dicate a diameter.

If you would like to specify another means by which you would like the circle con­
structed, choose one of the three options within the square brackets.

Figure 2.1 illustrates three different ways that AutoCAD can construct a circle without
reference to any other objects. The first circle on the left is the default. 2 Point and 3
Point are the other two circle types.

The AutoCAD prompts change according to the options you choose. Most options re­
quire a numeric value. For example, to change the diameter, type in d for diameter,
then type in the diameter that you need, 1.5,2.75, etc. You can also choose the value on
screen by picking a point.
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Option Brackets

The square brackets offer the various options available with each command. In the
CIRCLE command, many ofthe options are shown in the first line; the Diameter option
is shown in the second line.

Command:CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan

radius) ] : (pick a point)
Specify radius of circle or [Diameter] <5.00>:

With the ARC command, some options are shown in the first prompt, but others show
up with each option chosen. There are many ways of calculating arcs, and these are
found in the Draw pull-down menu and illustrated in the Help files, but you generally
only use one or two.

In Figure 2.2, three different arcs are generated. The first is calculated through three
points. The second is calculated through the start, end and radius. To enter this, type in
C to place the center of the arc or E to place the end instead of the default.

2

3

X3

2

Xl

J
2

Figure 2.2

Three Point Start End Radius Center Start Angle

( 3 e.oints

r: ;2.tart, Center! End

tN. Start, CenterJAngle

t? Stgrt, Center) Length

r;; Start) End) Angle

r Start, End) Q,irection

f1 Start) End! 8,.adius

r: ~.enter, Start, End

tN. C§.nter, Start, Angle

J7. Center, Start, b.ength

r; CQntinue

Command:ARC

ARC Specify start point of arc or [Center]: (pick 1)

Specify second point of arc or Center/End]: (pick 2)

Specify end point of arc: (pick 3)

The third is calculated through the center point, then the start point, which will give the
radius, and then the angle through which it is drawn, in this case 135 degrees.

Command:ARC

arc Specify start point of arc or [Center]: c

Specify center point of arc: (pick 1)

Specify start point of arc: (pick 2)

Specify end point of arc or [Angle/chord Length] :_a

Specify included angle:135

Picking the arc from the Draw pull-down menu will bring up the list ofarcs shown on
the left. Ifyou pick an arc from this Inenu, you will be prompted for each component of
the arc in tum.

In some cases you are prompted to pick a point through which the arc can be generated,
such as the start, end or center of the arc.

In other cases you are prompted for a value. In the example above, 135, the angle ofthe
arc, is a value. When specifying an option such as a diameter or angle, you first choose
the option and use .J to have AutoCAD accept this option. You will then be prompted
for the required value. Values can be entered on screen with a 'pick' as well as by en­
tering the numeric value at the command line.
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Obiect SNAPs There are three ways to enter points:

PICKING Pick on screen, using SNAP to be accurate. (Chapter 1)

COORDINATE ENTRY You can enter absolute, relative, or polar coordinates in any
order.

ENTITY SELECTION, OBJECT SNAP, OR OSNAP This allows you to use existing ob­
j ects to create your file. Accessing points on existing objects is called using OSNAPs.

,
~

[~Dpoitlt

WIDpoint

I~T....S4PC tion

Figure 2.3

, ,, ,, ,.... ,.... ,, ,, ,

, off

SettifltJS...
OSNAP: Object SNAP

Object Snaps allow you to specify precise points on objects in order to create or edit
objects. AutoCAD has 16 Object Snap modes that allow you to specify precise points
on objects. The capitalized letters are those needed when typing in the option.
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APPint

CENter

ENDpoint

EXTention

FROM

INSertion

INTersection

MIDpoint

NEARest

NODE

NONE

PARallel

PERpendicular

QUADrant

Quick

TANgent

snaps to a real or imaginary intersection of two ohj ects
(apparent ntersection)

snaps to the center of an arc or circle

snaps to the closest end of any object

snaps to a point along the extension of a line or arc

establishes a temporary reference point from the parameters of
an existing objects

snaps to the insertion point of a block

snaps to the intersection of two items

snaps to the midpoint of a selected item

snaps to a point on an object nearest to the digitized point

snaps to a point created by POINT, DIVIDE, or MEASURE

turns the Object Snap mode off

draws a line parallel to an existing line

snaps to a 90 degree angle to an existing line

snaps to the 0, 90, 180, or 270 degree point on an arc, circh:, or
ellipse

snaps to the first snap point found

snaps to the tangent of an arc or circle
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Accessing OSNAPs

OSNAPs can be accessed in one of four ways:

1. There may be a designated button on your mouse. Often ifyou hold the Shift button on

your keyboard down and use the right-click button on your mouse, an OSNAP menu
will appear where your cursor is.

2. Type in the first few letters of the OSNAP mode.

3. Choose Object Snap from the Drafting Settings under the Tools menu.

4. Use the OSNAP buttons.

The hyphen (-) in the architec­
tural point entry is not the same
as in the architectural readout
on the status line.

Using OSNAPs

Figure 2.4 illustrates the use of some OSNAPs within
the command line. When entering the OSNAP, type in
the first three or four letters, or Shift right-click and ac­
cess the asNAP list.

First, draw three circles as shown in Figure 2.5. The
size doesn't matter.

Command: CIRCLE

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)] :0,0

Specify radius of circle or

[Diameter] :3

Cornrnand:C

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)) :9,4

Specify radius of circle or

[Diameter] :6

Cornmand:C

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)) :18,0

Specify Radius of Circle or

[Diameter] :3

Figure 2.4

000
Figure 2.5

Now create lines tangent to the arcs. The TANgent object snap creates a tangent to the
identified object from the last object to a circle or arc. For TANgent type in TAN,

Command:LINE

Specify first point:TANgent to (pick 1)

Specify next point or [Undo]:

TANgent to (pick 2)
Specify next point or [Undo]:~

Comrnand:LlNE

Specify first point:TANgent to (pick 3)
Specify next point or [Undo]:

TANgent to (pick 4)
Specify next point or [Undo]:~

Figure 2.6

AutoCAD will calculate the tangent for you; just pick which side ofthe object the tan­
gent should be on, as shown in Figure 2.6. You need to secure a tangent connection for
both sides ofthe line. To set the OSNAP to TANgent, right-click the OSNAP button, set
tangent, and make sure the OSNAP button is on.
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Now use the QUADrant option to attach the other two lines as shown in Figure 2.7.
QUADrant takes the top, the bottom, or the far right or left ofa specified circle or arc.
Type in QUAD for QUADrant.

Command:LINE
Specify first point:TANgent to (pick 1)

Specify next point or [Undo]:
QUADrant of (pick 2)

Specify next point or [Undo]:~

Command: LINE
Specify first point:

QUADrant of (pick 3)
Specify next point or [Undo):

TANgent to (pick 4)

Specify next point or [Undo]:~

Now use CENter to place a circle concentric with the
first as shown in Figure 2.8, CENter takes the center
ofan arc or circle. Only items with a defined radius can
have a center point.

Command:CIRCLE

Specify center point for circle or
[3P/2P/Ttr (tan tan radius)] :CENter

of (pick 5)

Specify Radius of Circle or

[Diameter] :3

Now use the TRIM command (see page 72) to trim off
the extra portions ofthe circle, as shown in Figure 2.9.
The TRIM command will erase a portion of an object
between two edges identified by intersections with
other objects.

Command: TRIM

Current settings: Projection=UCS

Figure 2.7

Figure 2.8

Figure 2.9

Figure 2.10
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Edge=None

Select cutting edges ...

Select objects: (pick 1)

Select objects: (pick 2)

Select objects: (pick 3)

Select objects: (pick 4)
Select objects:~ (enter - no more cutting edges are needed)

<Select object to trim> or
shift-select to extend [Fence/

Project/Edge/eRase/Undo] : (pick 5,6)

Your final image should look like Figure 2.10.

The TRIM command will not work unless the TANgent
option has been properly used. If the lines don't inter-
sect the circles, they will not be trilnmed.

This example has shown how to use OSNAPs within a
command string. You can type in the first few letters
ofthe OSNAP option, use Shift right-click to get a list on screen or get the OSNAP op­
tions from a pull-down menu or floating toolbar.You can also set up your OSNAP so
that the options automatically appear.
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OTRACK

Running OSNAPs

You can set up OSNAP so that the options are automatically turned on.

ti) To llack hom an Omap point pau$/< O\Ief tho! POInI \'\/h,e in ~

"Vif cOl!lLl\l'lF'Jd A trocl<ing "actO! "PpedlS wher1 you move I"" CVIro<
To:lop lr!lCkin;l, p!lll'$il <We[!he point_.

In this example, ENDpoint, MIDpoint and CENter are turned on. These are the usual
choices. We have seen how CENter works. ENDpoint takes the closest end point. All
lines are made up of two end points. MIDpoint takes the middle point of an object.
These options are illustrated in the Tutorials at the end of this chapter.

The OTRACK cOlnmand is useful for lining objects up relative to other objects.

Figure 2.11

OTRACK is a toggle switch found on the function bar at the bottom ofyour screen, as
shown in Figure 2.11.

Using OTRACK

With OSNAP on, OTRACK will track the ENDpoint, MIDpoint or CENter ofan object
and line up a new point exactly across from or beneath it. OTRACK works vertically or
horizontally. First draw in the lines as shown in Figure 2.12 (A).

_r· ..·T
A

Figure 2,12

Command: LINE

Specify first point: (pick 1)

Specify next point or [Undo]: (pick 2)

Specify next point or [Undo]:~

Make a line from the top right comer, lining it up with point 1 as shown on Figure 2.12
(A). Then draw your cursor across the endpoint ofpoint 1 without picking it. Move it
up level to your beginning point. When you have found the position that lines up, pick
that point. AutoCAD will create a line using the X value ofpoint 1 and the Yvalue of
your start point in Figure 2.12 B. It's a lot easier to do than to explain.
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BREAK, TRIM,
and ERASE

The BREAK command removes a portion of a single object between two specified
points. The TRIM command trims a series ofobjects according to a cutting line or cut­
ting lines. The ERASE command removes an entire object from the file.

The BREAK Command

BREAK is found under the Modify menu in both the Toolbar and the pull-down menu.
The obj ect will be broken from the point chosen on the object or by another point
specified after entering F to indicate a different first break point. In Figure 2.13, the
line indicated in the first pick is cut from the center of the circle to the intersection of
the line and the circle.

ea2

Figure 2.13

Comrnand:BREAK

Select object: (pick 1)

Enter second point (or F for first point) :F

Enter first point:CENter of (pick 2)

Enter second point:INTersection of (pick 3)

The TRIM Command

TRIM is found under the Modify menu in both the Toolbar and the pull-down menu.
Pick either one or a series of cutting lines, and then choose the objects to trim.

In Figure 2.14, the lines are all trimmed to the circle; the circle was indicated first.

Figure 2.14

Command:TRIM (or TR)

Current settings: Projection=UCS Edge=None

Select cutting edges ...

Select objects: (pick 1)

Select objects:~ (no more cutting edges are needed)

<Select object to trim> or shift-select to extend [Fence/

Project/Edge/eRase/Undo] : (pick 2,3,4,5,6)

The ERASE Command

Figure 2.15

@@@Command:ERASE (or E)

Select objects: (pick 1)

Select objects: ~

ERASE is found under the Modify menu in both the Toolbar and the pull-down menu.
You can also simply type in E. In Fig-
ure 2.15 the non-concentric circle is
erased.
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GRIPS GRIPS are used to identify a selection set or group of objects prior to a Modify com­
mand such as ERASE or MOVE (see Chapter 3). If you select a group of objects, blue
grips will appear. This means you have selected the objects for editing. Now you can
use ERASE to erase them.

Command: (pick 1) other corner

(pick 2)
Command:ERASE Erase 5 found

In Figure 2.16, five objects were selected by a crossing
window, going from right to left. The objects were then
erased. To undo an erase, use Undo or U.

Command:U Undo Erase

Figure 2.16

Use the Escape key on the top left ofyour keyboard to clear the grips ifyou have cho­
sen them incorrectly.

ERASE can also be used with the Crossing and the Window options to erase a group of
objects as seen in Figure 2.17.

ERASE with
Window and

Crossing

o
Figure 2.17

Window
Col1l.t'Tland: ERASE
Select objects: (pick 1, 2)

Select objects: ~

Crossing
Command:ERASE
Select objects: (pick 3, 4)

Select objects: ~

UNDO and
REDO

The Window selection set, as shown in picks 1 and 2, provides a blue-colored window.
Any objects contained in this window will be erased. Since the diagonal line and the
top line do not lie completely within the window, they will not be erased.

The Crossing selection set, as shown in picks 3 and 4, provides a green-coloured rec­
tangle. Any object that touches or is within this rectangle will be affected by the com­
mand. In this example, every object except the vertical line on the left will be erased.

The UNDO command will undo the previous command, regardless ofwhat it is. Ifyou
erase something by mistake, trim something by mistake or enter some geometry that is
not correct, use UNDO to return to correct it. You can UNDO as many commands as
you have entered since the file was last opened.

Command:UNDO (or U)
Command:REDO

REDO will bring back a command that you have taken out with UNDO.
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Step} Start a new file in imperial units. You are
making a tricycle. No limits are needed, but
you need to make sure you are in imperial.
Choose acad.dwt. (You make the entries
shown in BOLD).

Command: NEW

(Choose acad.dwt)

Or

Command:STARTUP

Enter new value for startup

<0>:1
Command: NEW(Choose Imperial)

Command: UNITS

Set units to architectural.

[~~~:~~~=:~:~:~~~~~~~~;:~:::=:::::.:.~., .•-
Id;~"'"'' ~iQPTWTemplates

\ OSheetSets
!~acad -Named Plot Styles,dlNt 33 I<

!.~.dwt 331<
i~ac~dISO ·Named Plot styles.dwt 25 K

: 5acadi5o,dwt 25K

!SANSI A(portrait)-Color Depe... 281<'

: [SjAN5I A (portrait) -Named Plot .. , 28 K
i BANSI A -Color Dependent Plot... 29 K

i SANSI A-Named Plot Styles.dwt 29 K
I!5AN5I B -Color Dependent Plot.., 28 K

.1 [EiAN5I 6 -Named Plot Styles.dwt 29 K

; [!SANSI C -Color Dependent Plot... 29 K

I~AN51 C -Named Plot styles,dwt 291:

Li}:diliE1;c\' ~"'.~.,.~_ ...c •• ·._ •• : •. ~~~i

Step 2
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Often with architectural designs the layout is set at regular inter­
vals so LlMITS/ GRID and SNAP are an advantage. With this tricy­
cle elevation these are not needed. Simply start with a couple of
circles, then ZOOM Extents.

Command:CIRCLE

Specify center point for circle or [3P/2P/Ttr

(tan tan radius)] :0,0

Specify radius of circle or [Diameter] :10

Cornrnand:CIRCLE
Specify center point for circle or [3P/2P/Ttr

(tan tan radius)] :0,0

Specify radius of circle or [Diameter] :12

Command: (from the View pull-down menu, pick ZOOM Extents)

Command:Z

Specify corner of window, enter a scale factor (nX or

nXP),or[All/Center/Dynamic!

Extents!Previous/Scale/WindowJ<realtime>:E

Command:Z

Specify corner of window, ..... Scale/Window] <real time>:.7X

You can also use your roller ball to ZOOM the objects into the middle ofyour screen.
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Step 3 Make sure OSNAP is on, and draw an arc from the CENter ofthese two circles just up
and to the right. When your cursor approaches the circle, a smaller circle should appear
at the center indicating an OSNAP. If this doesn't show up, use Shift right-click for the
menu, and pick kenter as shown on the left, or simply type in CEN.

Command:ARC

ARC Specify start point of arc or [Center] :CEN of (pick 1)
Specify second point of arc or [Center/End]: (pick 2)

Specify end point of arc: (pick 3)

3

3

Command: ARC

ARC Specify start point of arc or

[Center] :CEN of (pick 1)

Specify second point of arc or

[Center/End] : (pick 2)

Specify end point of arc: (pick 3)

Next you want to place an arc starting from the saine
center point, just a
little to the right of
the first arc. OSNAP

After you have picked the first point, turn OSNAP off
or you will have difficulty placing the next points. If
the cursor 'picks up' another line, an OSNAP is as-
sumed, and the second arc will be generated along the
endpoints of the existing arc.

no Qsnap Settings...

e ~ent8t

o Quadrant

() Tangent

......0 Temporary trac~point

£' Erom
Mid Be~ween 2 Points

Poin~ Filter'S

/ t;.ndpoint

;:/ Midpoint

X Intersection

X ~parent Intersect

_ ... E)$.tension

...!.- !:erpendicular

; ParaUel

o Noqe

60 In~ert

.It Near.est

A;, tlone

You should now have two arcs and two circles.

Step 4 Place a circle with a radius of l' at the same center point.
Use Zoom Window to zoom in and see it. You can either
use your roller ball on your mouse, the icon as shown, or
type in Z then pick two points.

Command:Z

Specify corner of window, enter a

scale ... ow]<realtime>: (pick 1)

Specify opposite

corner: (pick 2)

Now put the two circles in using the END of the two arcs.
Turn your OSNAP on.

Command:CIRCLE

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)] :END of
(pick 1)

Specify Radius of Circle or

[Diameter] :3

Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan

radius) ] :END of (pick 1)

Specify Radius of Circle or [Diameter]:2
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StepS Use TRIM to remove the ends,
ofthe arcs as shown.The circle
is your cutting edge.

With OSNAP on, you will snap to
whatever setti ngs are current.
Squares and triangles will show up
on your objects as you move your
cursor when OSNAP is on. Toggle
them off on the status line.

Comrnand:TRIM

Current settings:

Select cutting edges ...

Select objects: (pick 1)

Select objects:.J
<Select object to trim> or shift-select to extend [Fence/

Project/Edge/eRase/Undo] : (pick 2(3)

<Select object to trim> or shift-select to extend [Fence/

Project/Edge/eRase/Undo] :.J

Since you have now been using the file for at least a few minutes, you should
save at this point.

Step 6 Use the line com­
mand with OSNAP,
OTRACK and PO­
LAR to place the
rectangle at the top
of the two arcs.

Comrnand:LINE

Specify first point:END of (pick 1)
Specify next point or [Undo] :END of (pick 2)

Specify next point or [Undo] :4 (move your cursor up)

Specify next point or [Undo]: (move your cursor over pick 1,
then back up to a horizontal, then pick the point shown)

Specify next point or [Undo]:c

/

Step 7

/

1

Now we need to draw the back wheels. Draw in a
line from the bottom QUADrant of the first wheel,
36 inches to the back. Make sure POLAR is on..

Command:LINE

Specify first point:QUAD of (pick

1)
Specify next point or [Undo] :36

(move your cursor to the right)

Specify next point or [Undo]:.J

2

2
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Command: CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan

radius) ] :2P

Specify first end point on circle's diameter:END of (pick 1)

Enter second end point of circle's diameter:12{move your

cursor straight up)

Once the CIRCLE has been drawn in, ERASE the line.
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NEAR

Command: CIRCLE
Specify ... radius)] :CEN of {the

right circle}

Specify radius of circle or [Diameter]:D

Specify diameter:10

Command:ARC

ARC Specify start point of arc or [Center]:NEAR the line

Specify second point of arc or [Center/End]: (pick 2)

Specify end point of arc:NEAR the circle

Using a similar proceedure as for the front wheel, put
in three more circles and two arcs. For the arcs, make
the first from the center ofthe small circle to the MID­
point of the vertical line, and the second to a point
slightly higher using NEARest. TRIM all unwanted
lines.

Step 8

Step 9 For the handle, use ARC and LINE. The ARC command
will continue from the last entered point if you use .J
when prompted for the first point.

Comrnand:ARC

ARC Specify [Center]: (pick 1)

Specify second End] : (pick 2)

Specify end point of arc: (pick 3)

Command:~ (brings back ARC)

ARC Specify . of arc or [Center]:~

(continues from last point)

Specify second point of arc or [Center/End]: (pick 2)

Specify end point of arc: (pick 3)

Step 10 For the pedals, set up a GRID and SNAP, and draw them
in without OSNAP. Use two points to pick the size of
your limits.

Comrnand:LIMITS

Specify bottom left: (pick 1)

Specify upper right: (pick 2)

Command: SNAP
Specify snap spacing<>:.5

Command: GRID

Specify grid spacing<>:l

Finally use LINE and ARC to draw in a seat.

Help Files, OSNAP, OTRACK, BREAK, TRIM, and ERASE 41
More free ebooks  :  http://fast-file.blogspot.com



In this Tutorial we will practice using OSNAP and OTRACK to draw the mechanical
piece shown below. Make sure ORTHO, OTRACK and POLAR are all on.

o 0

Step]

,....... ....,••, ...., '""--.-..No..........'...... .. ..... ~ . .....,.""'"-.... ~

~10ij~Ji·r~PQ'LAB.]·ci·$.~~p'·.'liQiB~~~··.••••..·,~i

For many applications, particularly mechanical, LIM­
ITS, GRID and SNAP are not needed. Another way to
set up your screen is simply to choose your units, lnet­
ric or imperial, then draw in the first object. Use
ZOOM to place it on the page.

Cornmand:CIRCLE

o

o
o

Step 2

Specify center point for circle or [3P/2P/Ttr (tan tan

radius) J :0,0

Specify Radius of circle

or [Diameter] :100

Now ZOOM the object on screen.

Cornmand:Z

Specify corner of window, enter a scale factor (nX ornXP),or

[All!Center!Dynamic/Extents!Previous!Scale/Window]

<realtime>: A

Comrnand:Z

Specify corner of window, enter a scale factor (nX or nXP), or

[All!Center/Dynamic/Extents!Previous/Scale/Window]

<real time>:. 3X

You can also use your mouse roller ball to center the circle on the screen.

Use the POLAR option to place the lines around the outside of the circle. Move your
cursor along the direction indicated by the arrows, then type in the value.

Point entry by typing coordinates will
not work if DYNamic mode is on.
Turn it off.

i

I
I

G Ii
-~Q9~:~QQ J

i-- -------------1

i G !

i 300,->0°1

/ Command: LINE

Specify first point:-300,-300

Specify next point or [Undo] : 600 right
Specify next point or [Undo] : 600 up
Specify next point or [Undo] : 600 left
Specify next point or (Undo) :c
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Step 3 Fillet the comers with a radius of 100.

Command: FILLET (or F)

Current settings: Mode = Trim,

Radius = <5.0000>

Select first object or[Undo/Polyline/

Radius/Trim/Multiple] :R

Specify fillet radius:l00

Select first object or

[Undo/Polyline/Radius/Trim/MultipleJ:

(pick 1)
Select second object: (pick 2)

Corrunand:FILLET

Current settings: Mode = Trim,

Radius = <5.0000>

Select first object or[Undo/Polyline/

Radius/Trim/Multiple] : (pick 3)
Select second object: (pick 4)

Continue until all four comers are done. By pressing the
spacebar at the Command: prompt, the last entered com­
mand will be retreived. This could make your data entry a
lot quicker.

o

o
o 0

• ----------- 2Step 4_n

If the CENter OSNAP does not
come on, right-click the OSNAP
button, choose settings.

Place CIRCLEs in the four comers. As shown in the illustra­
tion, once the circle is identified, you can pick either the pe-
rimeter or the center of the circle to place the smaller ones.

For pick 1place the cursor over the circle, then move the cursor to the center ofthe cir­
cle. The object snap picked up will be the CENter because the center mark is high­
lighted. The OSNAP button must be on.

Command:CIRCLE

Specify center point for circle or

[3P/2P/Ttr (tan tan radius)] : CENter of (pick 1)

Specify Radius of Circle or [Diameter] :25

Command: CIRCLE

Specify center point for circle or
[3P/2P/Ttr (tan tan radius)] :CENter of (pick 2)

Specify Radius of Circle or [Diameter] :25

Step 5

If you type in CEN this will override the ENDpoint
OSNAP I which is the system default.

Now draw in the lines as shown in the illustration. To
place these, use both OSNAP MIDpoint and the OTRACK
ofthe center ofthe circles for placelnent as described be~

low.

o 0

o
o 0

Make sure that CENter, MIDpoint and ENDpoint OSNAP is set and that the OSNAP
button is turned on.
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For the first point,
pick the MID of the
left vertical line. (

Cornmand:LINE
Specify first point:MID of (pick the vertical line)

For the next point, drag your cur­
sor over the circle as shown. Do
not pick the circle, simply drag the
cursor across it. Then drag it down
to line up with the horizontal. This
will give you a line with the X
value ofthe center ofthe circle and
the Yvalue of the MIDpoint of the
vertical line, producing a straight
line.

Draw in all four lines.In this exam­
ple, the MIDpoint is taken from
the top line and the end of the line
is lined up with the center of the
circle on the right.

Once you have done this for all
four lines, you should be familiar
with the way it works.

o 2
~

o
Step 6 Finally, access the ENDpoints of the small lines to

finish the drawing.

o
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Command: LINE

Specify first point:END of (pick 1)

Specify next point or

[Undo] :END of (pick 2)
Specify next point or [Undo] :END of (pick 3)
Specify next point or [Undo] :END of (pick 4)
Specify next point or [Undo] :c

o 0

When completed, your object should look like this. 0
o 0
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Exercises 2 Practice
DRAW all of these, just for practice.
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Exercise 2 Architectural
For the Lot Plan you will need to change your UNITS to Surveyors.
The Floor Plan is drawn with Architectural Units.
To get the area of the lot, set your OSNAP to ENDpoint, then use the AREA command.
You will be prompted for the corners of the lot. Press Enter for the area.

POOL
USE CIRCLE TTR

?
?
o

~
Z

in
o

72 1 \0.75"

349 1 4.25"
N84D54 11G'E

LOT PLANS SHOW THE PROPOSED STRUCTURE AND THE LOT
UPON WHICH IT IS TO BE BUILT. THE LOT IS SHOWN IN

SURVEYORS I UNITS. AND OFTEN INCLUDES EXISTING WATER,

GASS AND ELECTRICAL SERVICES. THE NORTH ARROW SHOWS

THE ORIENTATION OF THE BUILDING. THE EASEMENTS AND

GRADING OF THE LOT WOULD BE NEEDED TO COMPLY WITH
LOCAL BUILDING CODES IN ORDER TO GET A BUILDING
PERMIT.

IN THE NORTHERN HEMISPHERE, THE MAJORITY OF THE

WINDOWS SHOULD BE ON THE SOUTH SIDE OF THE BUILDING
TO TAKE ADVANTAGE OF PASSIVE SOLAR HEATING IN THE
WINTER. DECIDUOUS TREES SHOULD BE PLACED OUTSIDE
THESE WINDOWS TO SHADE THEM IN SUMMER.

LOT PLAN
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r- 39 1 -4"

LOT (SURVEYORS' UNITS)
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Exercise 2 Mechanical
TANgent OSNAP will be important for both of these.
Start with a circle at 0,0. ZOOM, then place your next circle relative to it.
These objects are not drawn to scale within the page.

R1.l2

1~2,50

¢1.00
3 HOLES

Rl,SO

R 0

--+----1----+ .75
1.50

3,00 f-
Escutcheon Detail

r---600-~

Escutcheon

Edges chamfered at 45°

Cir-cle Ttr

f---- 100 -----I

9'J28,Q
Circle 2P

Plate

R82.0

R64,O

i
i

-~--t

,_--+-------+--.......-...1-
I

i

R19,Q

f~ 12.0 --.T-----<-J

4 Fillets

R26,Q

R38.0
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Exercise 2 Challenger
Start with the origin at the center of the left circle.
Place the circles according to the coordinates.
Fillets and lines at angles are demonstrated in Chapter 1.
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Selecting Obiects
Within the

Modify
Commands

Object Selection and
Modify Commands

objects

Once objects are drawn on the screen, editing commands under the Modify menu or
toolbar are used to cut down on drawing time. When editing, OSNAP is particularly
important to get the exact position ofobjects when they are moved, copied, or rotated.

In virtually every editing command, you will be prompted to 'Select objects'. This
makes sense because the editing command will change the position or the parameters
of objects, and thus the system needs to know which objects you want to change. As
you select items, they are highlighted (dotted lines).

Objects can be selected in a variety ofways. Ifyou are selecting the object after you
have invoked the command you can select the objects by:

• digitizing the desired item with the cursor pick box

• indicating a group of items with the Crossing option - type C or pick right to
left

• indicating a group of items with the Window option-type W or pick left to
right

• indicating a series of items with Fence - type F

• indicating a group of items with CPolygon- type CP

• indicating a group of items with WPolygon - type WP

• indicating the last entered item using the Last option - type L

• indicating the previous selection set with Previous - type P

• indicating all objects by typing in ALL

Once you have identified your selection set or chosen the objects that are to be edited,
AutoCAD will keep prompting you to select objects to be added or removed from the
selection set. To continue with the Modify command after selecting objects, press.J to
signal the end of object selection.
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Figure 3.1

The object selection default is to select the items one by one, as shown in Figure 3.1.
Only the two objects selected will be affected by the editing corrunand.

Select objects: (pick 1, 2)

Selection Windows
You can also select objects by drawing a rectangular window or crossing area in re­
sponse to the Select objects: prompts as shown in Figure 3.2.

a
Figure 3.2

4

b

Window is Blue
Command: ERASE

Select objects: (pick 1)

Specify opposite corner: (pick 2)

Crossing is Green
Command: ERASE

Select objects: (pick 3)

Other corner: (pick 4)

Picking from the left to the right,as in Figure 3.2 a will create a Window (blue after Re­
lease 2007) that will highlight for modification all objects contained within it. Picking
from right to left, as in Figure 3.2b will identify for modification all objects that touch
the crossing line (green after Release 2007).

Figure 3.3
a b

SO CHAPTER THREE

Selection Polygons

To select objects in an irregularly shaped area, use Window Polygon or Crossing Poly­
gon. The Wpolygon (Figure 3.3a) and Cpolygon (Figure 3.3b), work like Window and
Crossing windows. Type in WP or CP after the Select objects: prompt.
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Modify
Commands

Since COpy assumes multiple
copies, .J must be used to exit
from the command.

Selection Lines or Fence

With the Fence option, the objects touching the fence line will be picked up, as in Fig­
ure 3.4. Fence is useful for non-adjacent objects.

((@~';
•<V>

------ --_._~---

Figure 3.4

Select objects:F (Fence) (pick points)

You can use any of the above methods for object selection in any of the editing
commands. The following examples show how to choose first the command, and then
the selection set. Choosing the selection set first with GRIPS is covered on page 56.

The COpy Command

The COPY command takes an item or group ofitems and places a copy at another loca­
tion or at multiple locations. The COPY command assumes the creation of multiple
copies.

The command line equivalent is COPY.

~--9'3"·--'1 J
'-------

Figure 3.5

Cornmand:COPY

Select objects: (pick 1, 2)

Select objects:.J

Specify base point or displacement [Multiple] :END of (pick 3)

Specify second point of displacement or <use first point as

displacernent>:END of (pick 4)

Specify second point of displacement or <>:.J

In Figure 3.5 the vector along which the objects will be copied is identified by point
picks. You can also use an incremental value, as seen below.

Second point of displacernent:@9'3",O (uses the incremental
value rather than picking points)

Object Selection and Modify Commands Sl
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Autodesk has unaccountably tripled
the words in the prompts. In COpy
and MOVE, the first point is 'from
where' the next is 'to where'.

Figure 3.6 illustrates the use of COpy with multiple entries.

1------- ---0.0.---

1_1;1
Figure 3.6

Command: COPY
Select objects: (pick 1, 2)

Select objects:.J
Specify base point or displacement [MultipleJ :END of (pick 3)
Specify second point of displacement or <use first point as

displacement>:END of (pick 4, 5, 6)

Specify second point of displacement or <>:.J

The MOVE Command

The MOVE command moves an object or series of objects from one point to another,
relative to a defined point on the obj ect or a base point.

The command line equivalent is MOVE or M.

.----_+-+-~......-¥2
X,
X4

I

)IE-.-~~~-~~
f

Figure 3.7

I
I
i
i

.------ --- f----
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Command:MOVE

Select objects: (pick 1)

Specify opposite corner: (pick 2)

Select objects:.J

Specify base point or displacement: (pick 3) (from where)

Specify second point of displacement or <use first point as

displacement>: (pick 4) (to where)

In Figure 3.7 the objects are moved according to point picks. As in the above example
for copy, an increment or polar could also have been used:

Specify second point of displacement or <>:@-2,O
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Moving Objects to 0,0

To move a selected group ofobjects from their current position to 0,0, fIrst identify the
selection set. Identify which point you would like to be at 0,0. Use 0,0 as the destina­
tion or displacement. In Figure 3.8, the two circles were created in the middle of the
screen. They were then moved to 0,0 and then zoomed into the screen again.

In Figure 3.8, pick 3 is where
the objects are coming from,
and 0,0 is where they are
going to. The destination
need not be ON the objects

Figure 3.8

Comrnand:MOVE

Select objects: (pick 1)

Specify opposite corner: (pick 2)
Select objects:.J

Specify base point or displacement:CENter of (pick 3)

Specify second point of displacement or <use first point as

displacement>:O,O (to 0,0)

The MIRROR Command

The MIRROR command creates a mirror image ofan item or group of items through a
specified mirroring plane selected by a real or imaginary line.

The command line equivalent is MIRROR.

r------¥2

'f3
i

:~

Figure 3.9

Command:MIRROR

Select objects: (pick 1)

Specify opposite corner: (pick 2)

Select objects:~

Specify first point of mirroring plane:END of (pick 3)

Specify second point of mirroring plane:END of (pick 4)
Delete source objects? [Yes/No]<N>:.J

In Figure 3.9 the objects are mirrored through a plane created by picks 3 and 4.
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The ROTATE Command

The ROTATE command rotates an object or series of objects around a specified base
point. Using the command sequence below, the objects are rotated 45 degrees around a
point in the middle ofthe object itselfas shown in Figure 3.10. To view the rotation of
the object dynamically, move the cursor in a circle around the base point.

The command line equivalent is ROTATE.

54 CHAPTER THREE

Figure 3 - 10

Command:ROTATE
Current positive angle in DCS: ANGDIR=clockwise ANGBASE=O

Select objects~ (pick 1)
Specify opposite corner: (pick 2)

Select objects:.J

Specify base point: (pick 3) (use SNAP for accuracy)

Specify rotation angle or [Copy/Reference] :45

COpy and ROTATE

A very good new feature in ROTATE found in Releases 2007 and 2008 is the ability to
copy the objects within the command string.

Figure 3.11

Cornrnand:ROTATE
Current positive angle in DCS: ANGDIR=clockwise ANGBASE=O

Select objects:all (this will take all your objects)

Select objects:.J

Specify base point: (pick the middle point)

Specify rotation angle or [Copy/ReferenceJ:c

Rotating a copy of the selected objects

Specify rotation angle or [Copy/Reference] :45

In Figure 3.11 the'c' option for copy was used to copy the objects as they were rotated.
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Rotating Using a Reference

Use the reference option to rotate something when you are not sure what the angle is,
but you know the desired final angle.

.... 'Xs

Figure 3.12

Q
.

. . .

' .
. ". ~. ... '... .. .

, .. .. .. ~ .. .. .. .

Command: ROTATE

Current positive angle in DCS: ANGDIR=clockwise ANGBASE=O

Select objects: (pick 1)

Specify opposite corner: (pick 2)

Select objects:.J

Specify base point: (END of pick 3)

Specify rotation angle or [Copy/Reference]:r

Specify the reference angle <0>: (END of pick 4)

Specify second point: (END of pick 5)

Specify the new angle: (END of pick 6)

In Figure 3.12 the' r' option for reference was used to reference the current angle to the
desired angle in picks 5 and 6.

The SCALE Command

The SCALE command is very similar to those described above. Figure 3.13 shows ob­
jects scaled at a value of .5. A scale factor more than 1: 1 will make the image bigger. A
scale factor less than 1: 1 will make it smaller.

The command line equivalent is SCALE,

Figure 3.13

Command: SCALE

Select objects: (pick 1,2)

Specify base point: (pick 3)

Specify scale factor or [Reference]:.5
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Editing with
Grips

Getting Good Results the First Time

Always use SNAP, OSNAP, or actual coordinates to pick base points. Ifa reference ob­
ject is needed to complete an editing command (for example, a line in the MIRROR
command), insert it, reference it with OSNAP, then erase it.

The commands demonstrated above were used before the objects were selected. With
the aid of grips you can select objects, then use the editing commands to edit them.

LINE

Figure 3.14

CIRCLE POLYLINE SPLINED POLYLINE

Figure 3.14 shows where the grips would be placed on a variety of objects.

Grip Modes

Once you select objects using grips, the commands STRETCH, MOVE, ROTATE,
SCALE, and MIRROR can be invoked. Once you have identified the selection set, you
identify a base point orhotgrip. This is solidinReleases 2005-2006, and red in Release
2007 and 2008.

When the hot grip is chosen, it turns a solid color. The grip modes will then be loaded
and you can edit using one of the five modes. Use the space bar or Enter key to toggle
through the modes, or type in the first two letters of the mode. For example, to reach
Scale mode from another mode, keep pressing.J until Scale appears, or enter se.
If the grip mode does not work on your system, type GRIPS and then enter 1.

Grips Example

First draw in a series of lines as shown in Figure 3.15. At the Command: prompt pick
up the two lines on the right. The grips will appear in blue on the set of objects.

,~i--I

11 B]3
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Figure 3.15

Command: (pick 1, 2)
Command: (pick 3)

Pick 3 loads the hot grip and the grip modes. Now you can modify the two objects cho­
sen.
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Figure 3.16 a

IhI ~l
i

b c

Clear grips by pressing
ESCape twice, or by accessing
a new command through
either buttons or menus.

Once the base grip is chosen, the grip modes appear. Figure 3.16a shows STRETCH.

Command:**STRETCH**

Specify stretch point or [Base point!Copy/Undo/eXit] :

(pick a point to stretch the objects to as shown.)

Figure 3.16b shows MOVE. Just use the space bar or Enter to advance to MOVE.

Command:**STRETCH**~

Command: * *MOVE* *
Specify move point or [Base point/Copy/Undo/ eXit]: (pick a

point to move the objects to as shown)

Figure 3.16c shows ROTATE. Just use the space bar or Enter to advance to ROTATE.

Command:**STRETCH**~

Command:**MOVE**~

Command: * *ROTATE* *

Specify rotation or [Basepoint/Copy/Undo!Reference!eXit] :-50

n
I IL' D-E'l

Figure 3.17 a

Figure 3.17a shows SCALE.

b

Command:**STRETCH**SC

Command:**SCALE**
Specify scale factor or [Base point/Copy/Undo!eXit] : .5

Figure 3.17b shows MIRROR.

Command:**STRETCH**MI

Command:**MIRROR**

Specify second point or [Base point/Copy/Undo/Exit] : (pick

above)

Exiting from Grips

Use the ESCape key on the top left ofyour keyboard to remove the grips. Ifyoll pick
up grips by mistake use ESCape to remove them.
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Setting
LINETYPEs

AutoCAD offers the standard different types oflines - center, hidden, and dashed - in
addition to many variations to make drawings more legible and more attractive. The
LlNETYPEs are not loaded with the default AutoCAD drawing, so for you to use them

they must be loaded into the file.

---ByLayer

---ByLayer
---B.vBlock
--- Continuous

If your Properties toolbar, or any
other tool bar, is not loaded,
right-click any toolbar on the
vertical lines and then choose the

Changing
LTSCALE

58 CHAPTER THREE

The command line equivalent is L1NETYPE.

To load new linetypes, choose Other. .. from the linetype menu. This will retrieve the
Linetype Manager dialog box. From this, choose Load. This will retrieve the Load or
Reload dialog box. Choose the linetype you would like to use, then click OK. Close the
Linetype Manager.

You will then return to the main menu. If you want to use the new linetype to draw
with, pick the down arrow, then the linetype you have just loaded. This will set the cur­
rent linetype for subsequently drawn objects.

To change objects already drawn into a specific linetype, pick the object, pick the
down arrow on the Linetype button, and pick the linetype you want for those obj ects.

Depending on the size ofyour object, linetypes that are not continuous may show up as
such. This is because the scale of the drawing is too large or too small.

To see your changes properly you need to change the scale of the screen display.

Command:LTSCALE
Enter new linetype scale factor <1.000>:13

The final drawing scale oflinetypes is discussed in Chapter 11. Don't waste too much
time trying to work out what linetype scale you need, just keep entering numbers in in­
crements of 10, .1,10,100,1000, -10, until it looks OK.
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Step 1

In this tutorial we will make a roller arm. Open a new file
in metric using acadiso.dwt. Keep the settings the same.

Start with two circles at 0,0. PAN them into view.

Command:C

Specify center point for circle or

[3P/2P/Ttr(tan tan rad)] :0,0

Specify Radius of circle or [Diameter] :50

Command:C

Specify center point for circle or

[3P/2P/Ttr(tan tan rad) ] :0,0

Specify Radius of circle or [Diameter] :75

o

1

©

Step 2

Step 3

IOlRACK

Command:Pan (the hand will show up and you can move the

image across the screen)

Now use COpy to place another set of circles at 300 units in X and 100 in Y.

Command:COPY

Select objects: (pick 1, 2)

Specify base point or

[Displacement] displacement:CEN

of (pick 2)

Specify second point of

displacement

or <use first point as displacement>:@300,100

Now use MIRROR to get the third set ofcircles in. Set POLAR and OTRACK on to make
your line entry easier.

Command:MIRROR

Select objects: (pick 1)

Specify opposite corner: (pick 2)
Select objects:.J

Specify first point of mirror line:CEN of (pick 3)

Specify second point: (pick 4)

Delete source objects?[Yes/No]<N>:.J
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Current settings: Mode =

TrimrRadius = <5.0000>

Select first object or[Undo/

Polyline/Radius/Trim/Multiple] :r

Specify fillet radius <1.000>:300
Select first object or [Undo/Polyline/Radius/Trim/Multiple]:

(pick 1)
Select second object or shift-select to apply corner:

Command: FILLET

Use FILLET to create the arcs between the parts.Step 4

(pick 2)

(pick 3 to 6) as shown

Your drawing should look like this. o

of (pick 3)

or [Copy/Reference]:c

selected objects

or [Copy/Reference] :240

StepS Now use ROTATE with the copy option to make two
rocker anns at a 240 degree angle.

Command: ROTATE
Current positive angle in DeS:

ANGDIR=clockwise ANGBASE=O

Select objects: (pick 1, pick 2)

Select objects:.J

Specify base point:CEN

Specify rotation angle

Rotating a copy of the
Specify rotation angle

2)i(i ~

Your object should now look like this.

Step 6 Change the linetype of the new rocker ann.

Load a hidden linetype with the Linetype button.

Pick the objects using a crossing window and
place them on this linetype.

Use LTSCALE if needed to make the new linetype
appear as a hidden line.
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In this example we will make a bay window using ROTATE, COPY, and MIRROR.
Open anew file in imperial units and change your units to architectural- use UNITS.

Command:LlNE

Specify start point:O,O

/' Specify next point or (Undo) : 8,0

Specify next point or (Undo) : 8, 60

Specify next point or (Undo) :0,60

Specify next point or (Undo) : c

Step 1 Use LINE to draw in the window itself, not the dimensions,
just the window.

Command: ZOOM
Command: ZOOM

All

.8X

Depending on how your

system is set UPt you may have
to use 5TARTUP to access
imperial units.

You can also use your mouse and roller ball to zoom the part onto the screen.

Command:LlNE

Specify start point:0,6

Specify next point or (Undo) :@8,0

Specify next point or (Undo):~

Comrnand:LINE

Specify start point:O,54

Specify next point or (Undo) :@8,0
Specify next point or (Undo):~

Command:LlNE

Specify start point:MID of (pick 1)
Specify next point or (Undo) : PER of (pick 2)
Specify next point or (Undo):~

Step 2 Use COpy to create the glass section. Use POLAR if
you like, if not type in the displacement value.

Command:COPY

Select objects: (pick line)
Select objects:~

Specify base point or

[Displacement] displacement: (pick anywhere)
Specify second point of displacement
or <use first point as displacement>:@l,O

Step 3 Make sure that the POLAR and OTRACK options are on to add the next 8 x 8 section.

Command:LlNE

Specify start point: (pick the

corner)

Specify next point or (Undo):8

Specify next point or (Undo):8
Specify next point or (Undo):8

Specify next point or (Undo):~

",--- --_.-
I

S·

1 _

l~~8'-J
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Step 4

Step 5

Use ROTATE to rotate the comer section at 60 degrees while copying it.

Command:ROTATE
Current positive angle in Des:

ANGDIR=clockwise ANGBASE=O

Select objects: (pick 1, pick 2)

Select objects:~

Specify base point:END of (pick 3)

Specify rotation angle or

[Copy/Reference] :c
Rotating a copy of the selected objects

Specify rotation angle or [Copy/Reference] :300

Fillet the right side to make a good comer, and erase the other two lines.

Step 6

~
.•......~..............•........
...~

Command: FILLET
Current settings: Mode Trim,Radius

Select first object

or [Undo/Polyline

/Radius/Trim/Multiple] :r

Specify fillet radius <1.000>:0

Select first object or

(Undo/Polyline/Radius/Trim/Multi

pie] : (pick 1)

Select second object or shift­

select to apply corner: (pick 2)

Command: ERASE

Select objects: (pick 3,4)

Now COpy the window down to the comer, and ro­
tate it using a reference point.

Command:COPY

Select obJects: (pick 1, pick 2)

Select objects: ~

Specify base point or

[Displacement) displacement:END

of (pick 3)

Specify second point of

displacement

or <use first point as

displacement:END of (pick 4)
Command: ROTATE

Current positive ANGBASE=O

Select objects: (pick 5, pick 6)

Select objects:.J

<5.0000>

2

3 ),(---~
I I

:"'-Tr- J,

: :: ~
I II j
I II j

: :::
: :: l:

, I I ~

I II l
• II I
I H I
I U I
I H I
I H I
I :if I
J Ii I
I H I
, ~ l I
I l:I I

~jLi

4

6
X

62 CHAPTE RTH REE

Use ZOOM Window to zoom into the object to see it. Within the command string pick
ZOOM from the Properties tool bar and zoom into the comer. See detail on next page.
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Step 7

Specify base point:END of (pick 7 )

Specify rotation angle or [Copy/Reference]:R
(Zoom into the area using the Zoom Window icon)

Specify the reference angle <O>:END of (pick 7)

Specify second point:END of (pick 8)
Specify the new angle:END of (pick 9)

Now MIRROR the lower window through the upper window.

Command:MIRROR

Select objects: (pick 1)

Specify opposite corner: (pick 2)

Select objects:.J

Specify first point of mirror line:

MID of (pick 3)

Specify second point: (pick 4)

Delete source objects? [Yes/No]<N>:.J

Use ZOOM Extents to view the whole window. Using
ZOOM Extents will show all parts of geometry on your
screen.

I I
I I
!---TI--j

I II I
I II I
I II I
I II I

4
X

Command:ZOOM (or just Z)

Specify corner of window, enter a scale factor (nX or

nXP), or[All/Center/Dynamic/Extents/

Previous/Scale/Window/ObjectJ <real time>:E

Your bay window should look like this.
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Exercise 3 Practice
Use COPY, ROTATE, MIRROR, and MOVE to complete these drawings.
Do not put in the dimensions.

I--- -- .-.....
- I-~

- 1--

- 1--

- 1-- (u

- I
I 1-,... ~

1-1- -,...- -
1-1- .....
'-'- '-
I--- 10-

81
_--'3o:.....:....'O'_-J~

5'

CQSeMen-t window
2'-11'

30.00

Lancet 'Window

60,00

I
2'-8'

I

m~m
IE!9IE]
It---1'-10'_1~6'-4#_I

4'

1

Double Hung window

~20

Guide

~
RIill
LJ=d

Bushing

Rocker ArM
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Exercise 3 Architectural
Use Architectural Units to draw this elevation.

~
I

I

Jo;:----;:-~~~~~~~~~~

Finish d Floor
St eps 7'J
each EJrade

~=t=----,-------+--------+----------,---,,-----,--

ELEVATION

THIS IS AN ELEVATION OF THE FRONT FACADE OF A HOUSE.

IT IS A SCALE DRAWING OF THE FRONT; ALL LINES ARE VIEWED AS IF FROM "STRAIGHT ON".

SOME NOTATIONS ARE PARTICULAR TO ELEVATIONS: NOTE THE ROOFLINE ON THE PORCH.

ROOFLINES IN IMPERIAL ARE NOTED WITH AN INCH VALUE RELATIVE TO 12" OR PER FOOT - 6/12 OR 45 DEGREES.

THE FOUNDATION IS NOT ALWAYS SHOWN. HERE IT IS 8' DEEP, SHOWN IN HIDDEN LINE, BROKEN.

THE HEIGHTS OF CEILINGS, DOORS, WINDOWS, ETC. ARE GENERALLY SHOWN IN THE SECTION DRAWINGS.

ANOTHER HIDDEN LINE SHOWS THE BOTTOM OF THE FINISHED CEILING.

THE OVERALL HEIGHT IS OFTEN NEEDED FOR A BUILDING PERMIT.

ELEVATIONS SHOULD BE LABELED WITH THE COMPASS DIRECTION, SOUTH, NORTH, EAST, ETC.

GOOD PLACEMENT OF WINDOWS AND SOLAR PANELS IS CRITICAL FOR SUSTAINABLE ARCHITECTURE.
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Exercise 3 Mechanical
Use COPY, MIRROR, MOVE and TRIM to complete these drawings.
See page 58 for hidden and center lines.
These drawings are not drawn to scale within the page. Draw at 1 = 1.
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Foot Reel Side
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Exercise 3 Challenger
Set Architectural Units, SNAP to 3, GRID to 6 and draw in these three desks.
Note that you can copy the desk and modify it, then copy again to make the office.
This is a plan of modular furniture.
Once these desks are completed, assemble them as in the plan on the next page.
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'

I
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Exercise 3 Challenger (continued>
Doors are 31 long, aisle distances should not be less than 24".
Don't forget OSNAP.

t~
5'-9' 7'

'I
5'-9'

11'

29'-7'

FLOOR PLAN
A FLOOR PLAN OR PLAN GIVES A LAYOUT
OF WALLS OR, IN THIS CASE t FURNITURE.
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STRETCH, TRIM, EXTEND,
OFFSET, and ARRAY

should be able to:

Set options

Removing and
Adding Obiects

Chapter 3 looked at identifying obj ects for a selection set using Window and Crossing,
Window Polygon, Crossing Polygon, Fence, Previous and Last. Now we will discuss
removing objects from the selection set.

REMOVE Option

To remove objects from your selection set you can hold the Shift button down while
picking them or use the REMOVE option. Use REMOVE when a group of objects has
been identified and just a few need to be removed from this selection set.

Once this option is chosen, the Select objects: prompt changes to a Remove objects:
prompt. Note that you can use Window and Crossing within the REMOVE option.

To copy just the lines and solids in the electrical symbol in Figure 4.1 you could pick
each object separately (four picks) or identify the whole set with Window, then re­
move the circle (three picks).

1

Figure 4.1

Command: COpy

Select objects: (pick 1)
Select opposite corner: (pick 2)
Select objects:R

Remove objects: (pick 3)
Remove objects:~

Specify base point or displacement, or [Multiple]: (pick 4)

Specify second point of displacement

or <use first point as displacement>: (pick 5)

This option can be used with any Select objects: prompt.
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Add Option

Ifobjects have been removed and should be added back into the selection set, use Add.
Use Add to change the prompt from Remove objects: to Select objects:, then continue
to add objects to the selection set. The command line equivalent is ADD or A.

4

3

More Modify
Commands
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2

Figure 4.2

Command:COPY

Select objects: (pick 1)
Specify opposite corner: (pick 2)

Select objects:R

Remove objects: (pick 3)

Other corner: (pick 4)

Remove objects:A

Select objects: (pick 5)

Select objects:..J
Specify base point or displacement, or [Multiple]: (pick 6)

Specify second point of displacement

or <use first point as displacement>: (continue with

command)

You may alternate between Remove and Add as shown in Figure 4.2 until you are
satisfied with the objects in the selection set. Again the hot key is Shift while you are
picking.

These Modify commands are similar to those discussed in Chapter 3, but have a more

intricate structure. Keep reading the prompts for maximum efficiency.

Like the commands offered in Chapter 3, REMOVE and ADD can be found under the
Modify pull-down menu and under the Modify toolbar, and by typing them in with
aliases.

The STRETCH Command

The STRETCH command is used to make lines, plines, and other linear objects either
shorter or longer. It repositions the selected side of an existing obj ect or group of ob­
jects relative to a new point or position.

Practice STRETCH to make sure you know how it works. It is very useful.

The command line equivalent is STRETCH.
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You must use a Crossing
Window with STRETCH.

1,1 4 )

Figure 4.3

1,1

x
4

1,1 7 )1

Command: STRETCH
~.. Select objects to stretch by crossing-window or polygon ...

Select objects: (pick 1)
Other corner: (pick 2) (crossing the right side)

Select objects:.J
Specify base point or displacement: (pick 3)
Speci fy second point of displacement: (pick 4) (3 units)

Note that the Crossing option is automatic. You must pick your Crossing Window
from right to left as shown in Figure 4.3. All objects in the Crossing are highlighted
when they are chosen.

Stretching Circles and Arcs

Circles are moved as full circles - stretching a circle does not create an ellipse. One
end ofan arc can be picked up and stretched into a different radius. Ifthe arc is fully en­
closed, there is no change in the radius.

X
4

Figure 4.4

~-­

I
i

r-l
'-----1r=J----1 f--I----1

1.~_

If you pick all the objects with
your Crossing selection, you will
MOVE the objects instead of
STRETCHing them. Choose only
the side of the object that you
would like to stretch.

Command: STRETCH
Select objects to stretch by crossing-window or polygon ...

Select objects: (pick 1)

Other corner: (pick 2)

Select objects:.J

Specify base point or displacement: (pick 3)
Specify second point of displacement: (pick 4)

In Figure 4.4 the objects within the Crossing Window are the line for the door and the
arc of the door, both of which will effectively be moved, and the two lines indicating
the walls around the door, which will be stretched to accommodate the new position of
the door.
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The TRIM Command

The TRIM command is used to cut offan object or a series ofobjects at their intersection
with a boundary or cutting edge. While you have already used TRIM on individual ob­
jects, you can also use it on multiple objects.

The command line equivalent is TRIM.

The cutting edge or boundary must already exist on the drawing before you can use
TRIM. You can use TRIM on lines, as in Figure 4.5, or arcs as in Figure 4.6.

Figure 4.5

x

-----....",--------,..-..--. ·"'''''''''3

---~·---x-

, x
" 2

Command: TRIM

Current settings Projection=UCS, Edge=None

Select cutting edges ...

Select objects or <select all>: (pick 1)

Select objects:~ (no more cutting edges are needed)

Select object to trim or shift select to extend or

[Fence/Crossing/Project/Edge/eRase/UndoJ : (pick 2, 3 )

Select object to trim or IUndo] : (pick 3)

Select object to trim or IUndo] :~

The Fence option, being sold as a
new feature, has been around since
Release 12.

2
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Figure 4.6

Command: TRIM
Current settings Projection=UCS, Edge=None
Select cutting edges ...
Select objects or <select all>: (pick 1)
Select objects:~ (no more cutting edges are needed)
Select object to trim or shift select to extend or

[Fence/Crossing/Project/Edge/eRase/Undo]: (pick 2, 3, 4, 5)

Select object to trim or ge/UndoJ: ~

The arcs in Figure 4.6 are trimmed to the edges of the circle.
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You can also choose multiple objects as the cutting edges. In Figure 4.7 all of the ob­
jects are considered to be cutting edges.

In both TRIM and EXTEND,
<seled all> means type in the
word All if you want everything
to be an edge.

Figure 4.7

Comrnand:TRIM

Current settings Projection=UCS, Edge=None
Select cutting edges ...

Select objects or <select all>: (pick 1)
Other corner: (pick 2)

Select objects:.J

Select object to trim or shift select to extend or

[Fence/Crossing/Project/Edge/eRase/Undo] : (pick 3 to 10)

Select object to trim or IUndo]:~

The EXTEND Command

The EXTEND command also uses a boundary (or boundaries), but uses it as the item to
extend objects to. In Figure 4.8, the boundary is clearly the diagonal line. Once picked,
it will be highlighted.

The command line equivalent is EXTEND.

In Figure 4.8 small lines within the circle are extended to the perimeter ofthe circle.

1
.' x. ~

::' x,---:x ....
5

4

~
. '.

, .

. .

.~.. .. .
. .

The Fence option, as well as all
the others, are also part of the
EXTEND command string. Still
very useful, not new.

Figure 4.8

Command: EXTEND

Current settings Projection=DCS, Edge=None

Select boundary edges ...

Select objects or <select all>: (pick 1)
Select objects:.J

Select object to trim or shift select to extend or

[Fence/Crossing/Project/Edge/eRase/Undo] : (pick 3 to 10)

Select object to trim or IUndo]:~
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TRIM and EXTEND with Implied Intersections

Implied intersections are the points where two objects would intersect if they were ei­
ther extended or trimmed. You can trim objects using their implied intersections as
cutting edges for the trim as shown in Figure 4.9, and extend objects using their im­
plied intersection as the boundary as shown in Figure 4.10.

Figure 4.9

Command: TRIM

Current settings Projection=UCS, Edge=None

Select cutting edges ...

Select objects or <select all>: (pick 1)

Select objects:~ (no more cutting edges are needed)

Select object to trim or shift select to extend or

[Fence/Crossing/Project/Edge/eRase/Undo:E

Enter an implied edge extension mode [Extend/No extend]:E
Select object to trim or [Project/Edge/Undo]: (pick 2, 3, 4)

Select object to trim or [Project/Edge/Undo]:~

If AutoCAD responds 'no cutting
edges selected' it means that the
objects would not intersect. Try Fillet

IRadius O.

Figure 4.10

3
X

2

4
X

1 c=--

."'7""( Command: EXTEND
Current settings Projection=UCS, Edge=None

Select boundary edges ...

Select objects <select all>: (pick 1)

Select objects:~

Select object to extend shift select to extend or

[Fence/Crossing/Project/Edge/eRase/Undo] :E

Enter an implied edge extension mode [Extend/No extend] :E

Select object to extend or /Undo]: (pick 2, 3, 4)
Select object to extend or Undo]:~

Figure 4.10 shows the last three objects extended to where the intersection with the
vertical line might be.

Explore the other options of TRIM and EXTEND in the Help files.
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The OFFSET Command

OFFSET is arguably the most often used editing command on the system. OFFSET cop­
ies an object parallel to an existing object at a given distance. Note that the OFFSET
command works only in theX-Yplane.

The command line equivalent is OFFSET,

Offset first requires the offset distance - the distance that all ofthe objects will be off­
set by. It doesn't matter how far away the direction pick point is from the offset object;
only the side is important, as shown in Figure 4.11. Earlier releases ofAutoCAD have
less words in the command strings, and are generally easier to understand, but the ac­
tual command sequence has not changed.

4
x

figure 4.11

~J

X

Command:OFFSET

Specify Current settings: Erase sQurce=NO Layer=Source
OFFSETGAPTYPE=O

Specify offset distance or [Through/Erase/Layer]<Through>:8
Select object to offset or [exit/Ondo]<exit>: (pick 1)
Specify point on side to offset: (pick 2)

Select object to offset or [exit/Undo] <exit>: (p~ck 3)
Specify point on side to offset: (pick 4)

Select object to offset or [exit/Undo]<exit> : (continue to
pick points and sides)

The prompts for the objects to offset and the side to offset will continue in a paired se­
quence until you press .J.

As can be seen in Figure 4.12, ARCs, CIRCLEs and PUNEs will maintain the same cen-

7

3

Figure 4.12

ter point and have an offset radius.

The Through option in OFFSET, once used to specify a point through which you would
like subsequent offsets calculated, now functions as the COpy command. Each object
picked up can be placed according to a separate distance, as shown in Figure 4.13.
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4

3
5

6

Figure 4.13

The Undo option lets you undo
the previous pick while still in the
command.

Command:OFFSET

Specify Current settings: Erase =NO .... , OFFSETGAPTYPE=O

Specify offset distance or [Through/Erase/Layer]<Through>:t

Select object to offset or [exit/Undo] <exit>: (pick 1)

Specify through point: (pick 2)

Select object to offset or [exit/Undo] <exit>: (pick 3)
Specify through point: (pick 4)
Select object to offset or [exit/Undo] <exit>: (pick 3)

Specify through point: (pick 4)

Select object to offset or [exit/Undo]<exit>:~

Use OFFSET with FILLET radius 0 to create objects with parallel lines at many distances,
as shown in Figure 4.14. Figure 4.14a is the final part. A vertical line is OFFSET at the
various distances in 4.14b. Then the horizontal lines are OFFSET in Figure 4. 14c.Finally
FILLET with radius 0 is used to 'clean up' the comers (Figure 4.l4d). Diagonal lines can
then be added.
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-~~
48

70

""a>

a b c d
Figure 4.14

The ARRAY Command (Polar)

The ARRAY command rnakes circular (Polar) or rectangular patterns of selected ob­
jects by copying them along or around an identified point.

If you find the dialog boxes slo
and cumbersome, type in - befor
the ARRAY command for th
command without the dialog box. The command line equivalent is -ARRAY,

Command: -ARRAY

Select objects: (pick 1)

Other corner: (pick 2)

Select objects:~ (indicates that no more are needed)

Enter the type of array [Rectangular/Polar]<R>:P

Specify center point of array:CENter of (pick 3)
Enter the number of items in the array:8
Specify the angle to fill {+=CCW,-=CW)<360>:~ (accepts 360)

Rotate arrayed objects [Yes/No]<Y>:~ (accepts default)
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In Figure 4.15 the object (a chair) is arrayed around the center ofthe larger circle (a ta­
ble) at equal distances through 360 degrees, rotating each object. To acheive this ar­
rangement in the ARRAY dialog box you must pick the objects, then pick the center
point, then specify the number of items and the rotation angle.

Figure 4.15

Since you are not prompted, make
sure that you have made a selection
from every area of the screen. If your
objects end up in places that you did
not expect, it is probably your center
point that is incorrect.

Command:U

To Undo a bad ARRAY.

,.~

~ + ~
"~/'

With a polar ARRAY, as seen in Figure 4.16, you can also specify the incremental angle
between each object rather than the total distance ifyou prefer. Just choose that option
in the dialog box.

2

Figure 4.16

It is always a good idea to use the
Preview button ifthere is one on a
dialog box. This will stop you
from making a mistake and hav­
ing to correct it later.

Again, ifyour objects are going in
unexpected places, it is probably
the center point that is incorrect.

Generally speaking, the objects
are rotated as they are arrayed
relative to the rotation angle. If
you do not want them rotated,
simply remove the check in the
'Rotate items as copied' box.
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The ARRAY Command (Rectangular)

The Rectangular option ofthe ARRAY command prompts for the number ofrows (cop­
ies in the Ydirection) and the number ofcolumns (copies in the X direction). Then you
are prompted for the distance between the copies in rows and columns. This is the
center-ta-center distance, useful for both building trades and mechanical engineering.

The command line equivalent is ARRAY.

In Figure 4.17, the objects are ARRAYed along X or in columns. Note that the distance

2

Figure 4.17

between the columns includes the half­
width of the item itself.

ARRAY can be used to go in either one di­
rection or two. In this case, the array is
creating a series ofobjects going in the X
direction at a distance of .5625 units.

Again, ifyou don't like dialog boxes, the
options can be typed in. Many people
find this faster.
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Command: -ARRAY

Select objects: (pick 1)

Other corner: (pick 2)
Select objects:.J

Enter the type of array [Rectangular/Polar]<R>:.J

Enter the number of rows(--)<l>:~ (accepts the default of 1)
Enter the number of columns ( )<1>:7

Enter the distance between the columns:.5625

When doing layouts that contain many objects in both the X and Ydirections, specify
both rows and columns. In specifying the number of rows and colmnns, the total
number is indicated; if you have 1, and want 6 more, the total is 7.

Be sure to use asNAP where possible to make sure that your entries are as accurate as
possible.

Once the objects are ARRAYed, they are accessible as individual itelTIS and can be
modified individually.
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ARRAY: Multiple Rows and Columns

Ifyou have a chair that is 24 inches wide and you want an aisle of 18 inches between it
and the next chair, the spacing would be the width of the chair plus the width of the
aisle (24 + 18 = 3'6").

T [Q] [Q] ~e [Q] [Q]

1[Q] [Q] [Q] [Q] [QJ
o.islE?

[Q][QJ[Q][Q][Q]
--1Af-

Figure 4.18

In Figure 4.18 the chairs are placed in both rows and columns.

Command: -ARRAY

Select objects: (pick 1)

Other corner: (pick 2)
Select objects:~

Enter the type of array [Rectangular/PolarJ<R>:~

Enter the number of rows{--)<1>:3

Enter the number of columns ( )<1>:5

Enter the distance between the rows:60 (distance B)

Enter the distance between the columns:42 (distance A)

A negative distance will place
the ARRAY in a negative direc­
tion: to the left if columns, and
down frOln the original if rows. d:ll::n::Il::l 0

c!:1l::ll:::ll:::1I::l
"--'---'-~i!!!I-

What can go wrong with ModifY commands?

When entering commands from the Modify menus make sure that you follow the
prompts and supply all the necessary infonnation. The typed-in commands are easier
to get right than the dialog boxes because the dialog boxes assume defaults.

If your command goes terribly wrong, simply use Undo to correct the situation.

Command:U
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Step]

This exatnple will illustrate how to use ARRAY, TRIM, EXTEND,
and OFFSET to create a backyard hot tub.

Don't use LIMITS, GRID or SNAP. Tum DYNamic off.

IIIII

--
f-

~O~f- I---- -- -- -- ~ / --
I IIIII

Step 2 Create a line from 0,0 to 0,28, and ARRAY it to make 16. Use POLAR for your LINE, or
type in the coordinates as shown.

Command:L
Specify start point:O,O

Specify next point or [Undo] :0,28

Specify next point or [Undo]:~

Command:Zoom All

Corrunand:ARRAY

Select obj eets on the up­
per right corner to pick
the line. When com­
pleted, use.J to return to
the dialog box, then OK
to accept the array.

Step 3
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Create a line from 0,0 to 30,0 and ARRAY it by 15 to nlake a rectangular grid (the patio
stones). Use the command line version.

Corrunand:L
Specify start point:O,O

Specify next point or [Undo] :30,0

Specify next point or [Undo]:~

Command: -ARRAY

Select objects:L

Select objects:~

Enter the type of array [Rectangular/Polar]<R>:~

Enter the number of rows (---)<1>:15

Enter the number of columns ( )<1>:~

Enter the distance between rows ( ) :2
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Step 4 Make a CIRCLE to create a hot tub shape and OFFSET
it to make a ridge.

Command:C

Specify center point for circle or

[3P/2P/Ttr(tan tan rad)]: (pick 1)

Specify Radius of circle or

[Diameter] :6

.... .....
I"

r-... I'\.
1/ 1\

I ,1 1\
~

\
l~ }
I"'\: 10- L..-

I){

I., I-

Command:OFFSET

Specify Current settings: Erase sQurce=NO Layer=Source

OFFSETGAPTYPE=O

Specify offset distance or [Through/Erase/Layer]<Through>:1

Select object to offset or [exit/Undo] <exit>: (pick 2)
Specify point on side to offset: (pick 3)

Select object to offset or [exit/Undo]<exit>:~

Use TRIM with individual object picks if there are some objects not
trimmed.

'-""'10- to
~,, r..... ."/ "1 \

3f\ I
\ I

......
Ik.

iJ.S
~ A

Command: TRIM

Current settings Projection=UCS,

Edge=None

Select cutting edges ...

Select objects or <select all>: (pick 1)
Select objects or <select all>:~

Select object to trim or _.... eRase/Undo:F

Specify first fence point or [Undo]: (pick 2)

Specify first fence point or [Undo]: (pick 3)

Specify first fence point or [Undo]: (pick 4)

Specify first fence point or [Undo]:~

Select object to trim or [Project/Edge/Undo]:~

Now trim out the lines inside the outer circle. Use Fence to
pick up the parts to be trimmed.

Step 5

Step 6 Use OFFSET to create a set oflarger patio stones on the outside ofthe original stones as
a border.

Command: OFFSET

Specify Current ... E=O

Specify offset distance or

[Through/Erase/Layer] <Through>:4

Select object to offset or

[exit/Undo] <exit>: (pick 1)

Specify point on side to offset: (pick 2)

Select object to offset or

[exit/Undo] <exit>: (pick 3,4,5,6,7(8)

Use the roller ball on your mouse or ZOOM with a scale factor to keep the objects on
the screen.
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Trim,Radius

Step 7 Use FILLET to make comers.

Cornmand:FILLET
Current settings: Mode

= <5.0000>

Select first object or
[Undo/polyline/Radius/Trirn/Multipl

e] :r
Specify fillet radius:O

Select first object or

[Undo/ ... Multiple]: (pick 1)

Specify second object: (pick 2)

FILLET all four comers.
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Command:EXTEND
Current settings ... edges ...

Select objects: (pick 1 to 4)
Select objects:.J

Select object to extend or [Project/

Edge/Undo] :F

Specify first fence point: (pick 5)

Specify next fence point or [Undo]:

(pick 6, 7, 8) .J

Specify next fence point or [Undo]: (9,

10, 11, 12).J
Specify next fence point or [Undo]:.J

Select object to extend or [Project/
Edge/Undo]: .J

Use EXTEND to create a set of larger patio stones on the
outside of the original stones as a border.

StepS

2
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Command: STRETCH

Select objects to stretch by

crossing-window or polygon ...

Select objects:C
First corner: (pick 1)
Other corner: (pick 2)

Select objects:.J

Specify base point or displacement: (pick
3)

Specify second point of displacement:@l,O

Now you have a completed exterior hot tub area with 2x2
stones, 2x3 stones and 2x5 stones.

Finally use STRETCH to· make the stones on the right
extend two units further.

Step 9
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Exercise 4a Practice
Use the Modify commands to complete these parts.
oraw at a sca Ie of 1= 1.
These parts are not drawn to scale within the page.
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Exercise 4b Practice
OFFSET and ARRAY will be useful for drawing these objects.
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Exercise.4 Architectural
Use OFFSET to place the LINEs for the walls. Use FILLET radius 0 to clean them up.
The indow measurements are on the first floor plan on page 137.
Section A-A is on page 11 7.

ateh added later
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WORKING FLOOR PLANS
PRESENTATION DRAWINGS ARE USED TO SELL THE IDEA TO THE CLIENT.
WORKING DRAWINGS ARE MADE FOR THE CONSTRUCTION CREW.
MEASUREMENTS ARE FROM THE OUTSIDE OF THE FRAME BECAUSE
THE CARPENTER IS THE FIRST ONE TO USE THEM.
EXTERIOR WALLS ARE 6" STUD WALLS, WITH A 4 TO 10" VENEER.

~K1:eriOr Wall
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Exercise 40 Mechanical
Use the commands on the facing page to create this gear.
Save your file so you can add the dimensions to it later.

¢34,5

¢36,00

9 50 +0.02
, -0,00

11,00

2 000+ 0,002
, -0,000

033,00

¢30,OO

¢29,OO

014,00

---=----=--- ---- 09,00

R3,53

TOOTH
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WORM AND PINION
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Exercise 4b Mechanical

3,125

a. b c d e

a. Draw the first line
b. OFFSET at the specified distance
c. Add the bottom line and top line
d. OFFSET to the top
e. Use FILLET radius a to clean up the ends
f. ARRAY

h9f

J k

n
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The PLINE
Command

Entity Commands with
Width

A PLiNE or polyline is a single-drawing entity that includes line and curve sections that
may vary in thickness, and may be edited using PEDIT (polyline edit) for the Spline and
Fit curve options to create contour lines or airfoils. The individual segments are
connected at vertices; the direction, tangency, and line width are stored at each vertex.

The PLiNE command can create rectangles as single entities as well as curved segments
of varying thickness.

The command line equivalent is PLlNE.

Command:PLlNE

Specify start point: (pick a point)
Current line width is 0.0000

Specify next point or

[Arc/Close/Halfwidth/Length!Ondo/Width] :

Where: Arc
Close

Halfwidth
Length
Undo
Width

a change from line entry to arc entry
a closed pline, in which the first point will be joined to
the last entered point in the pline to make a closed
object; more than two points are needed to have a
closed pline
a specified halfwidth on either side of the pline vector
the length of the pime
an undo of the last point entered
a specified width of the line or arc segments on either
side of the pline vector

The first PLiNE command prompt asks for a point at which the polyline will start.

Command:PLlNE

Specify start point: (pick a point)

Entity Commands with Width 89
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You must enter the first point, after which you can choose one of the options (Width,
Arc, etc.). Ifyou want to change the width, note that you must change the start and the
end width to create a wide line as in Figure 5.1.

~ -=:r'SO
I }(o ~

Figure 5.1

Command:PLlNE

Specify start point: (pick a point)

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width] :W

Specify starting width<O.OOOO>: .50

Specify ending width<O.500>:~

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width] :11,0

The command default is to enter the second point. Ifyou pick a second point, this as­
sumes a straight segment or a line. If you continue picking points, the object created
will look like a series of lines, but it will be a single object that can be edited using PE­
OIT or other editing commands.

PLiNE is often used to create borders around views or drawings, as in Figure 5.2.

Cornmand:PLlNE

Specify start point:O,O
Current line width is 0.0000 units

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/

Width] :W

Specify starting width<O.OOOO>:.25

Specify ending width<O.2500>:~

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/

Width] :11,0

0,8.5

-~

00

Figure 5.2

11,8.5

11,0
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You can continue drawing with this line at the current thickness or change it at any
time. POLAR, OTRACK, and ORTHO work the same on PLiNE as on LINE.

Specify next point or [Arc/Close/ /Undo/Width] :11,8.5

Specify next point or [Arc/Close/ /Undo/Widthj :0,8.5

Specify next point or [Arc/Close/ /Undo/Width]:C

To achieve a perfect comer on a box or rectangle, use the Close option. This will attach
the first point to the last entered point and create a clean, beveled comer.

When changing the width both start and end points must be entered.

Command:PLlNE

Specify start point: (pick 1)

Current line width is 4.00 units

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Width] :W
Specify starting width<4.00>:.25

Specify ending width<O.25>:~ (don't pick!)
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Do notpickfIfyou pick, you will create an object similar to that in Figure 5.3. This is a
cornnlon mistake. AutoCAD will measure the distance from your first pick to your
second and use that as the end width of your PUNE.

Pick 2 is generally inside
3 the triangle.

Figure 5.3

Pline with Varying Width

You can create objects such as arrows using one PUNE with a series ofdifferent seg­
ments with varying widths. You can change the width at every vertex, as in Figure 5.4.

Figure 5.4

Command;PLlNE

Specify start point: (pick 1)

Current line width is 4.00 units

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width] :W

Specify starting width<4.00>:0

Specify ending width<4.00>: .35

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/width] : (pick 2)
Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Width] :W

Specify starting width<0.35>: .10

Specify ending width<O.lO>: .10

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width] : (pick 3)

PLINE Corners

The end ofeach pline is calculated relative 2 1 2
to the points or vertices used to create it. If 1.-3 ..,
the pline has a width, the ends are perpen-
dicular to the pline itself. Pline comers
must be smooth, or a gap will result, as in 4 3
Figure 5.5.

When making plines, use a continuous se­
ries of points as in Figure 5.5b, don't pick
twice in the same spot as in Figure S.Sa.

a

Figure 5.5

b
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figure 5.6

Editing the polyline curve options with PE DIT
will override these line and arc segments.

Po/yares

The PLINE command can be used to create arcs within polyline seglnents or on their
own, as shown in Figure 5.6.

Simply type in the letterA to toggle to the arc
mode, then type in the letter Lto get back to
straight line segments. The resulting polyline
will be one entity with arc and line segments.

Command:PLlNE

Specify start point: (pick a point)

Current line width is 0.1000

Specify next point or [Arc/Close/

Halfwidth/Length/Undo/Width] :A
[Angle/CEnter/CLose/Direction/Halfwidth/

Line/Radius/Second point/Undo/Width] :

The command default is to create a two-point arc. Once the first arc segment is in, the
system assumes that you want to continue with a series of arcs until the Loption is en­
tered, which will return you to a line segment.

The PEDIT
Command

One ofthe great advantages ofPLlNE is that, once the pline is entered, it can be modified

using PEDIT,

In the introductory stages, this command sequence is used most often to change the
width of a pline. In Figure 5.7, the border is edited from .25 units to .10 units.

The PE DIT command changes the width of all the segments of the identified pline.

The command line equivalent is PEDIT.

Figure 5.7

Command:PEDIT

Select polyline: (pick the polyline)

Enter an option

[Close/Join/Width/Edit Vertex/Fitcurve/Spline/Decurve/Ltype

gen/Undo:W

Specify new width for all segrnents:.l0

Enter an option

[Close/Join/Width/Edit Vertex/Fitcurve/Spline/Decurve/Ltype

gen/Undo] :.J

92 CHAPTER FIVE
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3

Figure 5.8

Command:PEDIT

Select polyline: (pick 1)

Enter an option

[Close!Join/Width/Edit

Vertex/Fit

curve/Spline/Decurve!Ltype

gen/UndoJ :J

Select objects: (pick 2)

Select objects: (pick 3)

Select objects: (pick 4)

Select object:.J

Enter an option [Close/Join/Width/Edit

Vertex/Fit curve/Spline/DecurveLtype gen/Undo]:~

More segments can be added to the pline by using the Join option. This will add lines or
arcs to a pline which can then be edited for width.

In Figure 5.8, the arc and the two lines identified by
picks 2,3, and 4 are added to the pline selected with
the first pick before the command option Join. Only 4

segments with a common end point can be joined. 2

You can change polylines back to regular lines by using the command EXPLODE. This
will also remove the width given.

If you apply PEDIT to an object that is not a polyline, you will be given the option of
turning it into one. Then use Join.

PEDIT with Spline and Fit Curve

To create contour lines and other items used in
surveying, among other fields, a polyline can be
modified to become a spline or fit a curve
through a series of points or vertices.

The Spline curve option of PEDIT will edit the
pline according to the series of points used to
create it. Make sure you use the Close option
when entering the pline to get a continuous
spline as seen in Figure 5.9.

FIT CURVE

Figure 5.9

PUNE with PEDIT can also be used to show wood grain as in reverse sections for wood­
working or molding, as can be seen in Figure 5.10. First put in a PUNE. Then use PEDIT
with either the Fit Curve or Spline options.

Figure 5.10

Entity Commands with Width 93
More free ebooks  :  http://fast-file.blogspot.com



The POLYGON
Command

The POLYGON command is like PLINE in that you are creating an object that has many

vertices.

The command line equivalent is POLYGON.

Figure 5.11

Command: POLYGON

Enter number of sides<4>:5
Specify center of polygon or [Edge]: (pick a center point)

Enter an option [Inscribed in circle/ Circumscribed about

circle] <I>:I

Specify radius of circle:l.5

Figure 5.11 illustrates a five sided-polygon.

Hexagons

In mechanical drawing, hexagons (six-sided
regular polygons) are quite common.

Ifyou need to draw a hexagon that is measured
by the distance across the flats choose the op­
tion Circumscribed about circle. The diameter
across the circle will equal the distance across
the flats, as shown in Figure 5.12.

Figure 5.12
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Cornmand:POLYGON

Enter number of sides<4>:6

Specify center of polygon or [Edge]: (pick

Enter an option [Inscribed in circle/

Circumscribed about circle] <I>:C

Radius of circle: (pick 2)

You can also use the POLYGON command to draw
regular polygons by specifying the length ofan edg,e
as shown in Figure 5.13.

Command: POLYGON

Enter number of sides<4>:6

Specify center of polygon or [Edge]:E

Specify first endpoint of edge: (pick 1)

Specify second endpoint of edge:@4<O

center)

1>< ><2
Figure 5.13
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The SOLID
Command

SOLID and DONUT are commands that have a filled-in area or solid mass. This can also

be achieved with the BHATCH command with the solid fill hatch. These commands are
always available when you type them in, and can be found in some AutoCAD Releases
(not Releases 2007 or 2008) on the pull-down menus and toolbars.

The command line equivalent is SOLID.

1 2''''3.4
2 4 10 12 6

Figure 5.14

Figure 5.15

Corrunand:SOLID

Specify first point: (pick 1)

Specify second point: (pick 2)

Specify third point: (pick 3)

Specify fourth point: (pick 4)

Third point:.J

Figure 5.14 illustrates
the order in which points
are entered. If you con­
tinue to digitize after the
fourth entry, the system
will add in a paired se­
quence until you termi-
nate with ~. To create a
triangle, use .J after the
third point prompt.

The order in which points are entered is very important. Figure 5.15 provides some ex­
amples.

Do not confuse SOLID with the
SOLIDS option given under the
Draw menus.

The DONUT
Command

The DONUT command is used to create a thick or
solid circle. The inside diameter is used to
determine the hole of the doughnut. Use an inside
diameter of zero to create a solid circle; use a

larger diameter to create a ring. Once DONUT is
active, a donut will be drawn every time you

digitize until you press .J.

1.00

Figure 5.16 illustrates the inside and outside di­
ameters of a DONUT .

Figure 5.16

DONUT is useful for surveying and civil engineering applications for property and po­
sition markers. It is also useful within dimensioning ifthe options available aren't giv­
ing you what you think you want.

Corrunand: DONUT

Specify inside diameter of donut<.5>:O

Specify outside diameter<1.0>:2

Specify center of donut or <exit>: (pick 1)

Specify center of donut or <exit>: (pick 2)

Specify center of donut or <exit>:~

Like the SOLID command, DONUT has been replaced by CIRCLE and BHATCH. For
many applications, however, DONUT is a faster solution for a solid circle.
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The TEXT
Command

Chapter 8 deals with many aspects oftext, including text style, editing, fonts, paragraph
text, and a wide variety of text alignments. Here we introduce simple, one-line text
entry. The MTEXT command will make paragraphs and large text formats easier. The

TEXT command is useful for title blocks and view titles.
When entering TEXT, AutoCAD will prompt you to choose a height for each character,
a rotation angle for your string, and a point at which to place the text string on the
model or drawing.

The command line equivalent is TEXT.

Figure 5.17 illustrates the justification ofthe TEXT command. The default is left justifi­
cation at the baseline ofthe text string. The other options will center, right justify, or fit
to either top or bottom comers.

DEFAULT

Figure 5.17

CENT~RED

RIGH1<
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Comrnand:TEXT
Current text style: "Standard" Text height 0.200

Specify start point [Justify/Style]:J
Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR:

Once you have chosen a point at which to place your
text, the command will prompt you for the height ofthe SeALE:
letters, the rotation angle, and the text or string ofchar- IX

acters itself. Figure 5.18 illustrates the placement of 2 xl / 4 II -_II aII
single line text.

Command: TEXT Figure 5.18

Current style: "Standard" Text height

0.200
Specify start point [Justify/Style]: (pick 1)

Specify height <.2000>:.15
Specify rotation angle of text <O>:~ (to accept the default)

Enter text:Scale:

Enter text:~

Command:~

Current text style: "Standard" Text height 0.150

Specify start point [Justify/Style]: (pick 2)

Specify height<.2000>: .25
Specify rotation angle of text <O>:~

Enter text:1/4"=1'O"
Enter text:~

More free ebooks  :  http://fast-file.blogspot.com



Multilines The MLINE or multiline command is used to create multiple, parallel lines.

The command line equivalent is MLiNE.

MLiNE is particularly useful for drawing walls and other architectural features. From a speci­
fied point, AutoCAD draws a multiline segment using the current multiline style, and contin­
ues to prompt for other points. Like LINE, using Undo undoes the last vertex point on the
multiline. If you create a multiline with two or more segments, the Close option will be in­
cluded in the command string as seen in Figure 5.19.

3

2

1.00,

Figure 5.19

4

Command:MLlNE

Current settings; Justification = Top, Scale

Style = Standard

Specify start point or [Justification

/Scale/STyle] : (pick 1)
Specify next point: (pick 2)
Specify next point or

[Close/Undo] : (pick 3)

Specify next point or

[Close/Undo] : (pick 4)
Specify next point or

[Close/Undo] :C

Justification

This option determines how the multiline is drawn between the points you specify.

Enter Justification type Top, Zero, or Bottom, as shown in Figure 5.20.

Top Zero Bottom

Figure 5.20

Scale

This option detcnnines the distance be­
tween the two lines of the multiline.

The scale is based on the width established
in the multiline style, as shown in Figure
5.21. All lines in the MLiNE will be scaled
to the entered scale factor. Figure 5.21
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+By using PLI NEand SOLI Deffectively, we can create
a presentation view ofa small cabin with a staircase
and a fireplace. Like many architectural applica­
tions, this is more easily drawn with SNAP on be­
cause it is in regular intervals.

Step] First change the units to Architectural. At the command prOlupt type UNITS.

Command: UNITS

Architectural

Precision: O'-O~

Step 2 Make your LIMITS -1',-1' and 24',18'. Set SNAP to 4/t.

Command: LIMITS

Reset model space limits
Specify lower left corner or [ON/OFF] <0'-0",0'-0">:-1' ,-1'

Specify upper right corner <12.0000,9.0000>:24' ,18'

1J'J'
-I T

Note: PUNEs are gen-
erated through the center b
line. The Dimensions
include PLiNE width.

1-

iu

...J~~
The polyline width is 81t

, the size of a
regular exterior wall.

Add the PLiNEs as shown on the
illustration.

This is a presentation drawing not a
construction drawing, the dimensions
are from the middle ofthe plines on the
comers. Note how to start the PLlNE so
that your corner is correct in the com­
mand string below.

Set your SNAP and GRID to 4 to make it
eaSIer.

When entering co-ordinates,
DYNamic gets in the way. Usi ng
GRI D and SNAP is the fastest
way to do this.

Step 3

Command:PLlNE

Specify start point:4' ,0

Current line width is 0.00 units

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Width] :W
Specify starting width<O.OO>:8

Specify ending width<8.00>:~

Specify next point or

[Arc/Close/Halfwidth/Length/Undo!Width] :0,0

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Widthj :0,4'

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Width] :~

Repeat PLiNE for the exterior walls. Use the spacebar to bring back the PUNE com­
mand to make it faster.

98 CHAPTER FIVE
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Step 4 Now use ZOOM Window to get a closer look at the
northeast corner of the building. Add the lines as shown,

with the pline width at 2".

Once sufficiently zoomed, enter the staircase with PLiNE.

Command:PLlNE

Specify start point:NEAR to (pick 1)

Current line width is 8.00 units

Specify next point or [Arc/Close/
Halfwidth/Length/Undo/Width] :W

Specify starting width<8.00>:2

Specify ending width<2.00>:~

Specify next point or [Arc/Close/

Halfwidth/Length/Undo/Width] : (pick 2)

1/ r-..

-
-

Co -I

~

t
B'/
t/ 2 3,

Step 5 Now use PLiNE to place an arrow pointing up the stairs. The dimensions in the
command string below are simply a guide. You can use your co-ordinate readout to
place these rather than typing them in. Just make the arrow look like the one shown.

Command:PLlNE
Specify start point:18'2",4'6"
Current line width is 2.00 units

Specify next point or [Arc/Close/Halfwidth

/Length/Undo/Width] :18'2",7'

Specify next point or [Arc/Close/Halfwidth

/Length/Undo/Width] :W

Specify starting width <2.00>:7

Specify ending width<7.00>:O
Specify next point or [Arc/Close/Halfwidth

/Length/Undo/Width] :18'2",8'

Specify next point or [Arc/Close/Halfwidth

/Length/Undo/Width] :~

Step 6 Now use PUNE to create a break line on the staircase. A break line is used on floor plans
to indicate that the stairs extend up or down to another level.

I

Since PLiNEs are created along
a center line with width added to

'I· both sides, be sure to deduct
half the wall thickness to obtain

I the correct wall length.

Command:PLlNE

Specify start point: (pick 1)
Current line width is 0.00 units
Specify next point or [Arc/Close/
Halfwidth/Length/Undo/Width} : (pick 2,

3, 4, 5, 6, 7 in sequence)

A break line in a staircase is always necessary on a floor
plan. The plan view shows only one floor or level in the
building. The stairs extend up to another level. The break
line is the visual image that tells the viewer that the stairs
continue.

6

4
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Step 7 Now use PAN to move the drawing to the right, at the same scale factor, and then use
SOLID to create a fIreplace. You should have SNAP on and OSNAP off for this
command.

1 3 5 7 9 11

2 4

6 8

10 12

PUNEs are entered from their
MIDDLE paint, so calculotions
will need to be adjusted.

Step 8

Step 9
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Command: SOLID
Specify first point: (pick 1)
Specify second point: (pick 2)

Specify third point: (pick 3)
Specify fourth point or [Exit]: (pick 4)

Specify third point: (pick 5)
Specify fourth point or [Exit]: (pick 6)

Specify third point: (pick 7)

Specify fourth point or [Exit]: (pick 8)

Specify third point: (pick 9)

Specify fourth point or [Exit]: (pick 10)

Specify third point: (pick 11)

Specify fourth point or [Exit]: (pick 12)

Specify third point:~

Use PAN again to move the drawing over to the
left so that you can create a North arrow outside

the building. Draw in a vertical line at 3 " and a

horizontal line at ] .5' across the lower section as
shown. Then draw in two smaller lines to make

an x. Use the ends of these lines and OSNAP
ENDpoint to draw in a North arrow.

North arrows are used on floor plans to show the
direction that the house is facing. In the northern
hemisphere, the north side ofthe building will be
cooler than the south, so the fireplace is often
placed on that wall.

Then, with your SNAP still set to 2, draw in two
diagonal lines through the intersection. Now use

SOUD to fill in the sides of the North arrow.

Command: SOLID
Specify first point: (pick 1)

Specify second point: (pick 2)

Specify third point: (pick 3)
Specify fourth point or [Exit]:~

Specify third point:~

2
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Step 10

3

Continue adding solids until you have a North arrow.

1 2

Finally, add lines for windows and doors, and your simple floor plan is complete.

Once the first window is drawn in, use COPY, ROTATE, and STRETCH to make the oth­
ers. Note that you can adjust the size of the window openings with STRETCH to make
the window on the south side longer, taking advantage of the sun and solar energy.

+ +

PRESENTATION DRAWINGS

PRESENTATION DRAWINGS, GENERALLY DRAWN IN PUNEs, ARE USED TO SHOW A CLI­

ENT THE GENERAL LAYOUT OF A BUILDING. THE POSITIONS OF WINDOWS, DOORS,

STAIRCASES, AND FIREPLACES ARE SHOWN, BUT THERE ARE NO DEFINITE DIMENSIONS,

NO NOT ATIONS OF MATERIALS, AND NO STRUCTURAL INFORMATION. THESE WOULD BE

ON THE CONSTRUCTION DRAWINGS (SEE PAGE 85).
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Exercise 5 Architectural
To appreciate architecture you must have some knowledge of architectural styles.
Here are two examples. Use PLiNE for the acanthus leaves.
Set PDMODE to 34, then use DIVIDE to place the bricks along the arc.
MIRROR, COPY, and SCALE will also be useful.

TRIGLYPHS

EGG AND DART

ECHINUS

\--1-__ ACANTHUS LEAVES

~----TORUS'r-----------r'

BYZANTINE AND ROMANESQUE

CENTER ALWAYS
ON SPRING LINE

jointeb 1linrseshne

ARCHITECTURAL DETAILS

THE ARCHITECTURAL DETAILS

AROUND DOORS AND WINDOWS ARE
USED TO DETERMINE THE

BUILDING'S STYLE AND DATE. THIS
IS WHERE CRAFTSMANSHIP AND A
SENSE OF PROPORTION ARE
IMPORTANT.
WHERE STRUCTURAL DETAILS
SHOW THE STRUCTURE OF A
BUILDING, ARCHITECTURAL DETAILS
DETERMINE THE STYLE.
SEE

WWW.ONTARIOARCHITECTURE.COM
FOR MORE INFORMATION ABOUT

THESE STYLES.

NOTE POINTED HORSESHOE ARCHES ARE FOUND PRIMARILY IN VENETIAN GOTHIC ARCHITECTURE.

STONE JOINTS MAY BE HANDLED IN A VARiETY OF WAYS
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Exercise 5 Mechanical
The PUNE showing the break in the shaft will be the hardest part
to draw in this example.

1--------------16'--------------f

-i 1/2¢ r

t----+- +--~Dllte' Dr"", cchl

1--+-----f---+--lcoI'\P().~b.rrlnton Inc

UNSPECIFIED TOLERANCE ProJ T tle

10"
I

~r
1/4 3/4

L...-_+-- -+-_-.I 11; L

~~:~
SHAFT END
DETAIL

NTS

2 3/4

1 1/2 =-_1
1

o

\VELD

-------7----·

PEDIT

PLINE AND

Rl/2

6,0

6,0I
50,0

L'
~~

MiG X 1.0

THREAD
2 X 0 + 1/4 UP TO 6//

2 X 0 + 1/2 OVER 6/1

JC
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Exercise 5 Wood
These clock pieces have reverse sections to show how the clock is constructed.
The break lines show that the body of the clock is longer than is shown.
Draw the clock at a scale of 1= 1.
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Exercise 5 Challenger
Profiles of wood and stone molding are often shown with
section lines as in this 13th century church doorway in Italy.
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Profiles: Church of Madonna Scorsa in Aquila
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Entity Properties: Layers,
Colors, and Linetypes

chapter, you should be able to:

creote geometry on them
........

and use the COLOR command

or obiects

of objects

on/off fhe LAYER

About LAYERs The LAYER command allows you to control the drawing by
means of visible entities, much like transparencies, as
shown in Figure 6.1. Different colors and linetypes can be
associated with different layers. To help complete the
drawing, these layers can be either displayed or
undisplayed, active or inactive, accessible or inaccessible.
The number of layers you can use is unlimited. Figure 6.1

The command line equivalent is LAYER.

Il
' '-"-
Gil_All

i ?;:
,-.~ All Used Layers

I
-I BLOCK V ~ t\t • whilB CON_GUS - O.-m Color_I
~ BRiCKARCH V Q fb • white CON_OUS - O....m C;:4or_7
... CENTER V (Wl ." • red CENTER -O.-m CclOf_1
... DEFPOINTS '~ ~ ~ • white CON_OUS - O...m Coloc_
... DIM (;) a 'i • white CON_OUS - O.Jn (oh,,3... DIMEN 9 (j flt • red CON_OUS - O.-m ColOf_1... HATCH Q Ci!! ~ • red CON-OUS - O....m Cclcr_)
.. HIDDEN .;) @I ~ • red HIDDEN -O...m CCkcf_1
...-rilO lNORDING {~ GJ 0l'J • Mtite CON_OUS - O.-m 'C<:~k>f_7

Layers can only be set up and modified with the Layer Properties Manager, but the
layer can be can be set with the Layer toolbar.
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The Layer Properties Manager dialog box will help you to view the layers, change the
colors, tum layers off, freeze and thaw them, and lock or unlock them.

Current

Name

Off or On

Freeze

Lock

Color

Linetype

Lineweight

New

Delete

OK

Show Details

Cancel

Help

sets the highlighted layer to current - the one you are
working on

the name of the layer; no spaces or dots allowed

sets the selected layers off or on, which makes the layer
invisible or visible

freezes selected layers, making them invisible and not
regenerated, or thaws (unfreezes) them. Freeze is for model
space layers

locks selected layers, making them visible but not
accessible, or unlocks them

the color set to that layer. All of the choices along the top so
far have been toggle switches, on or off; this allows you to
choose a color

the linetype of the layer

the lineweight of the layer

allows you to enter a new layer starting with the layer name

allows you to delete a layer if there are no objects in it

exits from the layer dialog box while saving changes

offers more information on the status of the highlighted
layer

cancels the layer changes or additions you have made

provides help files on the layer functions

.~ ~..
.....

<V 0 'li' &1J...
I

Creating a New
Layer
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Pick the button for New on the top left side of
the layer dialog box, highlighted in Figure 6.2,
and you will see a new layer appear in the list
Type in the name for the layer to override
Layerl, the default name.

Once the name is entered the layer will be
added to the layer list. The next time you enter
the dialog box the layers will be listed alpha- Figure 6.2

betically.

When typing layer names, add no spaces, slashes or periods.

Activating Layers for Changes

In order to change the name, state, color, linetype, or lock value ofthe layer, it must be
identified or selected. Move the cursor to the layer name and pick it. The layer's line
should be highlighted.

When selecting more than one layer for changes, use the regular Windows method for
identifying multiple objects: use the Shift key to highlight all layers between the top
and bottom ones that you choose, and the CtrI key to highlight multiple layers indi­
vidually. The selected layers will be highlighted and modified.
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hidden

Color and Linetype options will affect all highlighted objects, as shown in Figure 6.3.

Figure 6.3

Changing a Layer 1Vame

Ifyou should type in the name incorrectly, double-click on the name. The area now ac­
tivated will turn blue. Move your cursor away from the line, and the name itselfshould
be highlighted. Type in a new name or revise the current name. The new name will re­
place the old.

Making a LAYER Current

In order to draw on a layer you must make it current. The easiest way to do this is
through the Layer Properties Manager shown in Figure 6.4. Highlight the layer that
you would like to have current, and pick the word Current.

Figure 6.4

The Layers toolbar shown on Figure 6.5 is possibly quicker, if that toolbar is dis­
played. Pick the down arrow and select the name ofthe layer that you would like to be
current. To place objects on a different layer, highlight them, then using the down ar­
row, place them in the desired layer.

.0
!Jl:il Ii.] center

B
J1~10 objects

Figure 6.5

The Layer toolbar will show which layer is current. If this toolbar is not displayed,
right-click the end of another toolbar, then pick layers from the menu.

Changing Layer Color

In the Layer Properties Manager se­
lect the the colored box under the let­
ter C that corresponds to the layer you
would like to change, as shown in
Figure 6.6.

This will invoke the Select Color dia­
log box. Pick the color that you would
like, then click OK. Figure 6.6
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• ByBlock
II Red
DYeUow
o Green

o C.Yan

.6.!11j:~'ed Layers

• B,YLayer

•

~_AII

I····~
l····~ Group Filter'
L... Group Filter2

Figure 6.8

Figure 6.7Setting Color Independent of
Layer

You can set a color using the COLOR
command. This will override your layer
color setting. To do this, type in the word
COLOR at the command prompt, or pick
the color button on the Object Properties
toolbar shown in Figure 6.8, which is
generally just to the right of the Layer
toolbar.

Problem Shooting

If your layers suddenly disappear, you
have chosen the New Group Filter by
mistake. In the Layer Properties Man­
ager choose All Used Layers as shown in
Figure 6.7 and your layers will reappear.

If your objects are being entered
in a color different than your
layer setting, you have set a
color in the COLOR command.
Set the COLOR setting back to
Bylayer.

Command:COLOR

All subsequent objects will be drawn in this color. This may cause some confusion if
your colors have been set to a particular layer because the color setting overrides the
layer color. Keep the COLOR command set to Bylayer and you should have no prob­
lem.

Loading LINETYPEs

In addition to colors, you can also have linetypes associated with each layer. Load line­
types within the Layer Property Manager dialog box in the same way that you would
load them in the Graphics area, see page 56.

Once you have set a color or a linetype outside the Layer dialog box, all future geome­
try added to this layer will use this color or linetype. Until you are sure ofwhat you
are doing, both the Color setting and the Linetype setting should be ByLayer.

Changing
LTSCALE

Depending on the size ofthe object, the hidden lines may not show up as hidden. Ifthis
is the case, either the objects that you thought were on that layer are not, or the scale of
the drawing is too large or too small for the linetype to show. You will need to change
the linetype scale relative to the current drawing.

Command:LTSCALE

Enter new linetype scale factor<1.OO>:12

Match Properties
and CHPROP

The Match Properties command will take the linetype, color, and linetype scale ofa
selected object and apply these properties to any other objects that you choose.

Command: '_matchprop

Select source object: (Pick an object)
Current active settings: Color Layer Ltype Ltscale

Lineweight Thickness

PlotStyle Dim Text Hatch Polyline Viewport Table Material

Shadow display
Select destination object(s) or [Settings]: (Pick other

objects)

The last objects will have the properties i.e. color, linetype, dimension style, etc. of
the first object chosen.
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Layer Filtering

The CHPROP connnand cycles through the properties. With the dialog box you are
prompted to pick the objects you would like modified; then you can choose Layer,
Color, Linetype, Thickness, etc. and type in the new value. If you use the command
line, here is the sequence:

Command:CHPROP

Select objects: (pick an object)
Select objects:~

Enter property to

change [Color/LAyer/LType!LtScale/Thickness] :c
Enter new color <bylayer>:Red

Enter property to change

[Color/LAyer/LType/LtScale/ThicknessJ :LT
Enter new linetype <hidden>:Center

Enter property to change

[Color/LAyer/LType/LtScale/ThicknessJ :~

Sometimes you Inay want only certain layers to be listed in the Layer Control dialog
box. The Filter option allows you to limit which layers are listed. You can filter on the
basis of:

• layer names, colors, and linetypes

• whether layers are on or off

• whether layers are frozen or thawed

• whether layers are locked or unlocked

• whether layers have plot or don't plot status

• whether layers contain objects or not

• whether or not layers are part of externally referenced (xref) drawings.

Layer filtering is used on very
large files, or files that belong to
someone else or where you don't
need to use many of the layers.

To Filter a Layer

In the Layer Properties Manager,
pick the New Property Filter
button. Create a new filter bJTOUP

as shown. In Figure 6.9, all layers
that are red have been filtered.

Figure 6.9

Layer Management

The default layer is O. Ifyou enter any dimensions, you will also create a layer called
Defpoints. Neither of these layers is renamable. The Defpoints layer does not plot.

While creating a model in AutoCAD, layers should be named in a logical, straightfor­
ward manner. Also, keep your LlNETYPE and COLOR commands set to ByLayer.

Many industries have developed layering standards so that there is no question about
where objects will be located. Ifyou are starting work with a company, make sure that
you know what the layering standards for the company are, and find out whether there
are any standards outside of the company that you should be aware of.

Freezing layers when you are not using them will save a great deal oftime with larger
models. Until they are regenerated, layers that have been frozen will not display when
they are thawed.
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In this example we will make an adjustable bearing
with hidden lines and center lines.

Jt
---- --

____ a.._ ....

.:_-=~--- -
- --

Step 1 First set up your layers.

Pick the New Layer button to add new layers. Add Centre, Hidden, and Object.

Step 2 Once the names are loaded, change the color of each layer by picking the layer name
and then picking the Set color button. An overlay menu will offer you a selection of
colors.

Choose a color for that layer. The nine base colors
are the best to choose.

• objects

• hidden

• center

White

Yellow

Red

Index cofor: 1 Red, Green,

Choose Load to load new
linetypes. Choose CENTER,
hold the Ctrl key down on your
keyboard and then pick
HIDDEN from the list of
linetypes to load them both.

Pick OK. Then choose CEN­
TER under the Select Linetype
menu shown to make your cen­
ter lines 'center' lines.

Now load and set the linetypes. Pick the word Continuous under the linetype column
across from the CENTER layer
to load the Linetype manager.

Step 3
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Step 4 Now that the linetypes have been loaded, return to the Layer Properties Manager and
load the hidden line type to the Hidden layer.

Activate the Hidden layer, choose the word Continuous under the Linetype column,
then choose the hidden linetype from the list. Press OK. Use OK to exit from the Set
Linetype dialog box, then OK again to exit from the Layer Control dialog box.

Step 5 Now that the layers are ready, use the same menu to make the Objects layer current.

Your screen should look like this:

~ • white Continuous - Default Cok
~ • red CENTER - I.Jefau1t Cok

o y...w HIDDEN - Default [Dk

•

R1.00

RO.SO

1-----6.00---....Mirror these through the center line, and
use LINE and TRIM to fmish the part.

Draw two more circles on at a centerof6,2.
The radii will be .5 and 1.

Draw a circle with a center ofO,O. ZOOM to

the Extents of your geometry, and then
zoom down.

Now with the Objects layer current, draw in the front view ofthe adjustable bearing as
shown. Do not draw in the dimensions.

Step 6

If you set 0 color or UN ETYPE
under the COLOR or LlNETYPE
commands, they will override
your layer setting.

Step 7 Now return to the pull-down menu and make the Centre layer current.

o
1f!J. 0
D12,.
Jl;JO Hidden
Jl2J. Objects

Draw in the lines as shown. They should
be a different color as well as a different
linetype.

Try changing the LTSCALE to see if there
is any noticeable difference in the center
lines.

Command:LTSCALE
New scale factor<1.OO>:1.5
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Step 8 Return to the pull-down menu and make the Objects layer current to draw in the side
view as shown by picking the word Objects.

Again, do not put in the dimensions, simply put in
the lines. Using OFFSET will probably prove the
easiest way of doing this.

/-'4 nuets .25R

~---r

2.00

~-+
2.00

~-+

~l.ooh25 ~ 1+
~3.50Y

Step 9
Now return to your pull-down menu and make the Hidden layer current to place the
hidden lines as shown.

En ~~ rr:lt. 0bjects

Hidden

Make sure POLAR, OSNAP and OTRACK modes
are on to line the hidden lines up with the front
view of the object.

-- i---
0.50,
--L

- ____ 1- __ 0.50
I T
I

--7--r---

--1---

Step 10 Now make the Center layer current and add the center lines as shown. Again, SNAP set
to .25 would be of use in this view.

-----1-----:---r--
+

Step 11

114 CHAPTER SIX

Return to the Layer pull-down menu and change the colors of the layers to see ifyou
can make it look nicer. Ifthe colors remain the same as you change the layer color, it is
because the current color of an object is overriding the layer color. Set color back to
ByLayer, then use CHPROP to change all of the objects to be colored by layer.
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Step 12

If you lose your Layer
toolbar, right-dick any

toolbar at the parol Ie! bars
and bring it back.

Step 13

We are now going to play with the Lock/Unlock facility to see how it works. It may be
time to save the file just in case.

Command: SAVE

(enter a name in the dialog box)

In the pull-down menu lock the Centre and Hidden layers. Once the layers are locked,
you will be able to see them, but you will no longer be able to edit them. Make sure the
Objects layer is current before you start.

Hidden

Now back in the drawing or model, use a Window pick to highlight all ofthe objects on
screen. Then from the Modify menu pick Properties and change the color to blue.

This can also be done on the command line as follows.

Command: CHPROP
Select objects:ALL

40 objects on locked layers

Select objects:...]

Enter property to change [Color/LAyer

/LType/ltScale/Thickness] :C

Enter new color <varies>:blue

Enter property to change [Color/LAyer/

LType/LtScale/Thickness] :.J

Step 14

Notice that only the objects on the Objects layer were
changed because the other layers were locked.

Try turning the Layers Off and On, and Freezing and Thawing them. The data for the
layers are still on file, but the information is not displayed.

* Freeze/Thaw

<it0i..·..•..>.'.·.·'~jf:

...................,
On/Off
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Exercise 6 Practice
Use different layers for the Hidden lines and Centre lines.
These are practice parts, not drawn to any scale. Draw at 1= 1.

COUPLING

1
2.50

I
R1.oo

r- 1•5O -j

1----3•00

07/8 2 holes

ROCKER ARM

3
4

58.0 82.0

~~J
011.0 ---J
4 HOLES

12.01-------112.0

1--------136.0--------j

SWIVEL HAMMER

01.00

t
1~

L....I-..J--I-----=r-----""'-t---~
Top Plate

LINK
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Exercise 6 Mechanical
Draw 6A using different layers for hidden and center lines.
Draw the same iwo views - Front and Top - for 6B, 6C, and 6D.

R1.25
0.75

I -, r.....---l-_+___'_-----,

4.00 2.50 1.00

LU= ~---_~-----Lo.75~- 4-'25~-r----
1-------6,75---------l

¢1.50

¢1.00

6A

0.75

~ --...&.::~::;t"~~~~- r075 1

n
2,50 4.00 5,50

~----.----I--.----.l

itl1.00

¢1.50

¢2.00

R1.20

FILLETS AND ROUNDS R.25

PICTORIAL VIEWS

6C

PICTORIAL VIEWS, AS SHOWN BELOW, ARE 3 DIMENSIONAL

VIEWS USED TO ILLUSTRATE APART.

CREATE WORKING DRAWINGS, AS SHOWN ABOVE, FROM THE

PICTORIAL VIEWS BELOW.
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Exercise 6 Challenger
Here are 40 different arches found in architecture.
Set PDMODE to 34, then use DIVIDE to section plines and arcs.

DEPRESSEDQ) CINQUEFOILCORBELLEDCD BYZANTINE

® DROP @ ELLIPTICAL CD EQUILATERAL o FLAT

@ FLORENTINE ® HORSESHOE ® ITALIAN POINTED

MULTIFOIL@ MOORISH MULTIFOILLANCET@

@ OGEE @ ORIENTAL ® PARABOLIC @ POINTED HORSESHOE
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Exercise 6 Challenger (continued)
You can never get too much practice.

\

\

\
\

\
\

\

V
A

r \
I \

I \

-------~

® POINTED SARACENIC @ POINTED SEGMENTAL @ POINTED TREFOIL @ POINTED TRIFOLIATED

PSEUDO
@ FOUR CENTERED @ RAMPANT @ ROUND HORSESHOE

SEGMENTALSCALLOPED®
ROUND

TRIFOLIATED

ROUND

TREFOIL

SEMI-CIRCULAR
SEMI-CIRCULAR

® STILTED @ SHOULDERED TANGENTAL

@ VENETIAN GOTHICVENETIANTRIANGULAR® THREE CENTERED
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About
Dimensioning

Dimensioning

COrrlj:lletloCI.ot this chapter, you should be able to:

up 0 <:Hrrlensiontf1lg styler using the dialog box

and aligned dimensions

)................. ))( •••••..~•..<S'~q t>()~tlinl~ .••~lnd continuous dimensions

it ):. ·.(".·.~·.·~ .••••~leJj:ijqmE~telraind radius dimensions

••·•••·••••· •••<•••••••• ·••••~ ••••~Ii·~r't~~~i~irtu:m~;iOIlS once they are in.

While the objects are being created, the size of the object is being programmed with
each part's geometry. Lines, circles, arcs, etc. should be created perfectly every time. If
you get into the habit ofcreating data in a lazy or slapdash manner, it will catch up with
you later when dimensioning the drawing.

Dimensioning shows the measurements, the locations, and the angles ofobjects. The
dimensioning commands are designed to extract the sizes that are already pro­
grammed with the part, and display them in accepted formats. Every discipline has a
different set of drawing protocols. The dimensioning variables and dimension styles
are used to set the dimensions to the required parameters.

AutoCAD offers a wide variety of ways to produce linear, baseline, radial, diameter,
and angular dimensions. Figure 7.1 shows some of the basic dimension types.

F
IWII!UNI!

r
VERTICAL

Figure 7.1

+

lH:AR (VERTICAl..)

Dimensioning Components

Every dimension has several components. The dimension text states how big the ob­
ject is. The dimension line holds the dimension text. The dimension text shouldbe off­
set from the dimension line by .625 mm or 1/16 inch. The extension line extends from
the object to the dimension line. The extension line is offset by .625mm or 1/16 inch
from the part itself and should extend 1.25mm or 1/8 inch past the dimension line.
These measurements are universal drafting standards and must be maintained in
computer-aided drafting as well as in manual drafting.
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Figure 7.2 shows the components ofa di­
mension.

The point at which you start your dimen­
sion is the reference point or definition
point. AutoCAD automatically puts a gap
between this point and the start of the ex­
tension line. AutoCAD also creates a layer
for this point called Defpoints that does
not plot.

/;

EXTENSION LINE OVERSHOOT

~
DIHENSION LINE

~ DII1ENSJON TEXT

~ !,..- ARRowHEAD

4.00 ~-:=EXTENSIONLINE

I rEXmGl~~

Figure 7.2

Accessing Dimensions

The Dimension toolbar, shown in Figure 7.3, can be accessed by right-clicking an­
other toolbar at the parallel lines. Once in, move the toolbar until it is docked.

Dimension a
STANDARD

Entering
Dimensions

Figure 7.3

The pull-down menu shown in Figure 7.4 is also useful.

Typing in the dimensioning commands is not recommended.

You may want to lock the objects layer before dimensioning.
This way the objects cannot be altered when using STRETCH or
another Modify command.

Dimensions should be placed on the dimensioning layer and
this should be a different color. The lineweight of the dimen­
sions when plotted should be significantly smaller than that of
the object lines. Having the layers in different colors helps to
make sure that the dimensions will have the same lineweight.

Horizontal and Vertical Dimensions

Figure 7.5 illustrates linear dimensions. Use OSNAPs.

-~,~~~~~!!'!
~ Quk:k Dimension .

H binear

'\. Aligned

If Arc Lengtb.

~~ Qrdinate
·-----1

i.9 !3.adius

1; Jogged

~ Qiameter

~ [l.ngular

H Basoline

rH Continue
------j

~ L~ader

~ lolerance" ,

e Center t1,ark

H ObJigue

Align Te~t

~ Dimension 2tyle,,,

~ O?{erride

~ l,!pdate

Reassociate Dime!lsions

Figure 7.4

2
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Figure 7.5

Command: (D~ension pull-down menu, Linear)
Specify first extension line origin or <select object>:.J
Select object to dimension: (pick 1)

Specify dimension line location
[Mtext/Text/Angle/Horizontal/Vertical/RotatedJ : (pick 2)

Dimension text = 4.00
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In the fITst example in Figure 7.5 the dimension is based on the line or object chosen.
In the next two examples, the first extension line is picked, then the second, and finally
the dimension line is placed. Use SNAP and OSNAP for accuracy.

Before specifying the dimension line location, you are prompted to change the dimen­
sion text (Text), the text angle (Angle), the dimension direction (Horizontal or Verti­
cal), or the dimension line angle (Rotated).

In the third illustration in Figure 7.6, either the horizontal or the verticallength could
be taken. Move your cursor to the position the dimension should be in, then pick the
spot.

Figure 7.6

Aligned Dimensions

Linear dimensions give vertical or horizontal lengths. Aligned dimensions, as shown
in Figure 7.7, give the dimension aligned to an angled surface.

Command: (Dimension pull-down menu,

Aligned)

Specify first extension line orlgln

or <select object>: (pick 1)

Specify second extension line

origin: (pick 2)

Specify dimension line location

or [Mtext/Text/Angle]: (pick 3)

Dimension text = 2.8284

Figure 7.7

3
2.8284

2

Like the vertical and horizontal, you can also simply choose the line itselfto be dimen­
sioned as in Figure 7.8.

Command: DlMALIGNED

Specify first extension line orlgln or RETURN to select:~

Select object to dimension: (pick 1)
Specify dimension line location or [Mtext/Text/Angle]: (pick

2)
Dimension text = 2.8284

The distance between circle centers can also be
dimensioned with either a linear dimension, if a
vertical or horizontal is required, or with an
aligned dimension.

To change the unit readout, change the dimen­
sion style (see page 126).

Figure 7.8
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Continued Dimensions

Once you have a horizontal, a vertical, or an aligned dimension,
you can create dimensions that continue at regular intervals along the same edge as
shown in Figure 7.9.

Sx
I 13.5000~4.5000 I 3.000°1

i = ~ ~=f---..........c==:X:5<4==::J'---f

:3
rZ.IOOOI1.900013.0000~Z.ZOOO~t~80001

*I !. 2 )(1 4 . I l: I7ll:. I-- -.;)~( 5 L x
7

Figure 7.9

Command: DIMLINEAR
Specify first extension line origin or <select object>: (pick

1)
Specify second extension line origin: (pick 2)

Specify dimension line location [M/T /A/H/V/R]: (pick 3)

Cornrnand:_DIMCONTlNUE (pull-down menu)

Specify a second extension line origin or [Undo/Select]

<Select>: (pick 4)

Dimension text = 4.5000

Specify a second extension line origin or [Undo/Select]

<Select>: (pick 5)

Baseline Dimensions

Similarly, for baseline dimensions, create the first dimension and continue from there.

6-lt------------.L

Figure 7.10

Command: DIMLINEAR

Specify first extension line
origin or <select object>: (pick 1)

Specify second extension line origin: (pick 2)

Specify dimension line location [Mtext/Text

IAngle/Horizontal/Vertical/Rotated] : (pick 3)
Dimension text = 1

Command: DIMBASELlNE

Specify a second extension line origin or

[Undo/SelectJ<select>: (pick 4)

Specify a second extension line origin or

[Undo/Select] <select>: (pick 5)
Specify a second extension line origin or

[Undo/Select]<select>:~
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Radial Dimensions

A radial dimension measures the radius ofan arc or circle. The dimension appearance
is determined by the Fit tab options, as shown in Figure 7.11.

~/
Figure 7.11

Command: (Dimension menu, Radius)

Select arc or circle: (pick 1 - the arc)
Specify dimension line location or [Mtext!

Text/Angle] : (pick 2)

Diameter Dimensions

Diameter dimensions are affected by the same dimension variables as the radius di­
mensions as seen in Figure 7.12.

Figure 7.12

Command: DIMDIAMETER

Select arc or circle: (pick 1)
Specify dimension line location

[Mtext!(Text!Angle]: (pick 2)

Aswith the linear commands, the text and the text angle can both be changed. These
are under the Text tab of the Dimension Styles dialog box.

Angular Dimensions

The angular dimension command
measures the angle between two non­
parallel lines or three points. It can
also measure the angle around a por­
tion ofa circle or the angle subtended
by an arc, as shown in Figure 7.13.

The dimension line for the angular
measurement is an arc that spans the
measured angle and passes through
the measured point.

Figure 7.13

Command: DlMANGULAR
Select are, circle, line, or <specify vertex>: (pick 1)
Select second line: (pick 2)

Specify dimension arc line location or [Mtext/Text/

Angle] : (pick 3)
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Dimension Styles Controlling Dimension Style

~

~
I O"""id"_H j
I Comp4le,.. I

Stando!lfd .. PteCi~on a 2, T01 pleci>ion ~ 2_
Fit 1Ell(1 mO'iemenl ~ 2

Always make a new one as
shown in Figure 7.14. You will
regret it if you don't.

To create a new style, enter a
style name in the Name box and
pick Save. Changes that you
make with the Modify Dimen­
sion Style menu will be filed with
the saved natTIe.

There are many variables in the Figure 7.14

Lines, Symbols and Arrows
menu. Pick the style you want,
but don't change any of the default sizes because that will affect your dimensions un­
less you really know what you are doing. Change the sizes in the Fit menu. See
Tutorial 7a and 7b for how to do this.

A dimension style is a named group of settings that determines the appearance of the
dimension. Every dimension has an associated dimension style. Ifno style is applied
before dimensioning, the Standard (imperial) or 180-25 (metric) default style is used.
The style controls the unit readout, the text style, the color, the linetype scale, and
many other factors.

If you remember nothing else
about dimensioning, remember
NEVER CHANGE THE STAN- Ct-rrentDim$ly!e:Stand""d

DARD DIMENSION STYLE. I SetCurrenl )

The Text Tab The Text menu allows you to set the size and position oftext on your dimension lines.

~0It

1\
15'..,r .1 5'-6"

:1
Figure 7.15

Mechanical drawings generally have the dimension text horizontally within the di­
mension line. Architectural drawings generally have the text above the dimension line
and aligned with the dimension line. These alignments are changed using the vertical
and horizontal text placement, as shown in Figure 7.15.

Again, do not change the text height here, change it in the Fit dialog box. Along with
the text height and the arrowhead size there are gap distances, overshoot distances, ex­
tension line distances, and distances between the text and the dimension line itself.
You must change ALL ofthese to make the dimensions work properly. It is easier to
change them in the Fit dialog box.

A different text style can also be chosen for the printing of text. Keep the text style
fairly simple for best results. In mechanical drawings Arial is generally the preferred
text style. In architectural drawings, City Blueprint is often used. In either case none of
the serif or script text fonts are appropriate for dimension text.
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The Fit Tab The Fit menu allows you to set the size ofyour dimensions and have everything printed
at the correct scale.

"'\:r=~.:..~~I_O.~I.sf~vws
I AIlRDW lAP

I I~ ...~I I
Figure 7.16

The overall size of the dimensions is
detennined in the Fit tab ofthe Mod­
ify Dimension Style dialog box. If
you change the overall scale, you will
change the arrowhead size, the exten­
sion line gap, the extension line over­
shoot, and the gap between the
dimension and the dimension line. It
is a much better idea to change the
overall scale than to change each size
individually. Figure 7.16 illustrates
all the different preset elements.

190'
333'-'"

1..3'-4'

1720 2280

2S;;.,'t---lf-=-+--=80='~ 25'
20'-1 • 67'-6'

I

300 960 300
2SO alO

Ifyou change the overall scale, all of these factors will change. Ifyou change just the
text size orjust the arrowhead size, all ofthe other parameters will remain the same.

Paper space dimensions are dealt with in Chapter 11.

"000

figure 7.17

When you dimension a drawing and plot it, the final drawing is a fraction ofthe origi­
nal size of the object.

Metric Imperial

1:50 1/50 ofthe original size

1:100 = I/I00oftheoriginalsize

1:25 1/25 ofthe original size 112"= I'_ON = 1/240fthe original size

1/4"= 1/-0" = 1/48 ofthe original size

1/8" = l'_ON = 1/96 ofthe original size

Changing the overall scale under the Fit menu shown in Figure 7.17 will expand the di­
mensions to fit the drawing so that when printed the dimensions are the correct size.
The dimensions are plotted at the same fraction as the drawing itself.

Metric Imperial

1:25

1:50

1:100

overall scale 25

overall scale 50

overall scale 100

1/2'1 = l'_On

1/4'1 = I'_On

1/8'1=]'_0'1

overall scale 24

overall scale 48

overall scale 96
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The Primary
Units Tab

The Primary Units menu allows you to choose the units print-out. This does not change
the size of the object, just the text units on the dimension line.

FRACTIONAL

DECIMAL

1:5·~~M
SCIENTIFIC

U"ll"""-'l I ;jJ
P'ec"",n ~_----,it!J

F,~tion ~ormet ~uRzDnl~I__ ".~:~·", __ ~ ,~fil

Declrr4! sepaH~tof: ~Y~~L

Rwndo~ c=\;~

Prefix ~

Sulloc c===:=-~

SCilleioctor C=~
OAjipJyio~<!mt;n,ioo",.,Jjr

-'·Zecoaup.pre;:ttClfl
-·L."d"g fidoi<oel

T'oiliOli 00ircll'"

UnltsJOImal

ZlMr;~~on

o Loadirg

OT,.iIn~

Figure 7.18

The Alternate
Units Tab

The Symbols and
Arrows Tab

Choose the primary units that you would like the objects dimensioned in, then choose
the precision that you would like to have. Angle measurements can also be pro­
grammed. The Measurement scale (known as DIMLFAC in previous releases) allows
you to provide detailed drawings. This is an alternative to the paper space layouts.

Note: In Figure 7.18 the text placement has also been changed to reflect discipline
standards.

On rare occassions you may need to show both metric and imperial measurements on a
drawing. These can both be displayed on the dimension line ifthey are set up under the
Alternate Units tab.

The major criticism of the teaching of AutoCAD over the past 10 years is that the
instructors concentrate on teaching AutoCAD, and ignore drafting conventions. Your
final AutoCAD plots must be recognizable as drawings and employ the basic drafting
protocols of your discipline. Here are some of the protocols.

Center Marks

The centers ofcircles must have center marks showing that the circle has a constant ra­
dius. The three styles of center mark are shown in Figure 7.19.

OEBO
MARK

Figure 7.19

LINE NONE

128 CHAPTER SEVEN

Also under the Symbols and Arrows tab
you can choose which type of arrowhead
you would like.

Mechanical operations use dots, architec­
tural use ticks.

Make sure you have chosen an appropri­
ate style.

III Closed filled
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Saving
Dimension Styles

Once you have created a dimension style that has all the correct settings for your appli­
cation, it is automatically saved with your file and can be transferred to other files.

Variations on that dimension style can also be saved. For example, you can create a di­
mension style in metric with two decimal places of accuracy. On some drawings you
may want to have the diameter lines forced inside, on others not. You can create differ­
ent dimension styles to accomodate the different styles illustrated in Figure 7.20.

~ crSI

•

26

BEST FIT

a l1ll

•

61

~I'OO ~I'OO

Figure 7.20

o
FORCE lINE INSIDE

II

Once you have opened the Dimension Style dialog box, pick the New button and cre­
ate a new dimension style. Add the name for your new dimension style, use 'Copy of
Standard' to start, then pick Continue to set the parameters for your new style for your
dimensions. Use OK to save. Figure 7.21 illustrates some of the variables you may
want to set.

Texr AND ARRowS Texr ONLy

Figure 7.21

ARRows ONLy LEADER

Editing
Dimensions

You will notice that once you have started dimensioning, a new layer called
'defpoints' will be part ofyour layer listing. This layer will not print, and is used to de­
fine the point to which your ditnension is pointing.

If you pick Properties from the Modify pull-down menu and select a dimension, you
are given the Modify Dimension dialog box. Pick the box that offers what you would
like to change. If you would like to change just the text, select DDEDITJ just as in
modifying text.

Adding PrefIXes

Under the Primary Units dialog box is the heading Prefix. You can add the prefix
0/0%c for the diameter sign to add diameter signs to all of the dimensions shown.

Stretch

You can also stretch the object and have the dimensions automatically updated. The
STRETCH command can be used in the same way that DIMEDIT is used to move the text
across the dimension line.

EXTEND and TRIM can also be used to ensure dimensions show up exactly correctly.
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Step 1

Step 2

Quickly draw the part shown in metric units by

selecting acadiso.dwt, or use STARTUP to make
sure that you are starting with a metric file. The
dimensioning defaults are set up differently in
imperial and metric. It is VERY important to
start with the correct units or this tutorial will
not work.

The dimensions are shown for your
convenience in this illustration. Do not try to
add them yet. Starting with the lower left arc at
0,0 and a SNAP set to .25 is the easiest way to do
this.

Once the part is drawn in, let's see what a
dimension would look like using the standard
dimensioning format.

Before starting dimensioning, create a layer called
Dims, make it red, and make it current.

Now set your object snap to ENDpoint and CEN­
ter. The object snap dialog box is hidden in the
Drafting Settings box under Tools.

RO.75
1.50

3
1'·ooo0r=x

2

Step 3

130 CHAPTER SEVEN

Comrnand:LlNEAR

Specify first extension line origin or <select object>:END

of (pick 1)
Specify second extension line origin:END of (pick 2)
Specify dimension line location or

[Mtext/Text/Angle/Horizontal/Vertical/RotatedJ : (pick 3)

Dimension text = 1.0000

The dimension line should be 1/2 inch away from the object line. With SNAP set at .25,
this should be easy to place.

Four decimal points of accuracy are not needed, and the scale of the dimensions is
larger than needed. The next step is to make a dimension styIe that will incorporate the
changes.

First, access the Dimension Style
dialog box, create a style called
Mechanical, and click Continue to
change the precision.

Note that the default style here is an
IS0-25.

If you were using imperial
measurements with your STARTUP
command in imperial, the default
would be called Standard. Ifyou have started this drawing in the wrong measurements,
close this file and start again in metric.
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Having set up your mechanical style, now set the precision to two decimal places un­
der the Primary Units tab.

'-<S New Dimemion Slyle. qllilllpf

···~~·fs;;;i;~~i;;;;;i'i~~~C:ij).;"·C:·FfJ~,;lfr.1fl~';~;"'tf~
j Linear tfmen:slon::.

Umtfo,mat

PrecisiM

FractionlOlmlll"

DeClm<llsepi>lato,

J Round oft

Suffo<

NOW pick the Fit tab, and change the overall scale to .75 as shown on the right below.

Pick OK to return to the Dimension Style
dialog box.

Make sure that your new dimension styIe is
current by choosing the Set Current button
on the Dimension Style Manager menu, then
close the dialog box.

rScale for dimension leatures

f!)Use averaH scale of:

eScaledimen$l9f'\Stokl,Ypul

1°,075 I

Now erase the first dimension and add the new
one made with the right parameters as shown
on the right. Make sure that your dimensions
are going on to the Dims layer.

Command: LINEAR

Specify first extension line

origin ... >:END of (pick 1)

Specify second extension line

origin:CEN of (pick 2)

Specify dimension line location

or J: (pick 3)

x......t--_--jko6

x---+--
5

Specify first extension line

origin or ... >:CEN of (pick 1)

Specify second extension line

origin:CEN of (pick 2)

Specify dimension line location

or [Mtext ..... J: (pick 3)

Command:.J

Specify first extension line origin or <select object>:CEN
of (pick 4)

Specify second extension line origin:CEN of (pick 5)

Specify dimension line location or

[Mtext/Text/Angle/Horizontal/Vertical/Rotated] : (pick 6)

Now that the style has been set, add the linear
dimensions. First create the horizontal
dimension between the centers of the two arcs
on the top, then create the vertical dimension on
the right.

Command:LINEAR

Step 4

If you are not getting the two
I zeros, make sure that there are
no zeros suppressed in Primary
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Step 5 Now add the other vertical and horizontal dimensions in the same manner. Don't
worry if the dimensioning defaults are different on your system.

5

1.50
6

4

Specify first extension line

origin .... >:END of (piok 1)

Specify second extension line

origin:CEN of (pick 2)

Specify dimension line location or

[ .... Rotated]: (pick 3)

Command:.J

Specify first extension line

origin or ... >:CEN of (piok 4)

Specify second extension line

origin:CEN of (pick 5)

Specify dimension line location or

[Mtext/Text/Angle/Horizontal/Verticall

Rotated]: (pick 6)

Command:LlNEAR

Step 6 Now add the radial dimensions. When you pick radial for the dimensions, you can
move the leader line either inside or outside the radius. Place the radii outside the object
as shown.

Command:RADIUS

Select arc or circle: (pick 1)

Specify dimension line location or

[Mtext/Text/Angle] : (pick 2)

Command:RADIUS

Select arc or circle: (pick 3)

Specify dimension line location or

[Mtext/(Text/Angle]: (pick 4)

lfthe radii do not respond in the way that you want,
return to the Dimension Style Manager and make
sure you are working in the correct dimension style,
then use Modify to change the parameters. The lines
of the radius dimension are under the Fit tab.

2
RO.75

Step 7 Your dimensions are fine, so now add center marks. From
either the pull-down menu or the toolbar, choose Center
Mark.

+ +

Command:CENTER

Select arc or circle: (pick the radii) +

+

+

The lines associated with the center mark are determined
under the Lines tab.

Save your drawing now if you have not done so already.

Step 8 The dimensions added are associative dimensions. This means that the dimensions are
entered relative to the points that you have identified. These are called defpoints, and
there is a special layer created for them under your Layer menu. This layer does not
plot, so be careful not to make it current.
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This means that you can STRETCH the part and
the dimensions will automatically update.

Command: STRETCH

Select objects to stretch by

window ...

Select objects:C
First corner: (pick 1)

Other corner: (pick 2)

Select objects:.J

Base point: (pick 3)

New point:@1<90 (or pick 4)

1.50

1.50

The resulting object should look like this.

Your objects should stretch and the vertical di­
mension should change. If only the dimensions
stretch and not the part itself, it is because the Ob­
jects layer, or whatever layer you have placed the
objects on, is locked. Under the Layer toolbar,
unlock the Objects layer.

RO.75
1.50

Step 9 Finally, if you have entered all the dimensions and then find that they are the wrong
scale or the wrong units, that the arrowheads should be ticks, or some other problem,
you can edit the dimensions singly or in groups by changing the options in the
Dimension Style dialog box. What if the dimensions should really be in fractional
rather than decimal? You can change the dimension style and apply it to the current
drawing.

First, save the drawing under a different name by using the 'Save as' function under
the File pull-down menu. Now you have two copies, one with fractions and one with
decimals.

The next step is to make a new dimension style that incorporates the necessary
changes. Access the Dimension Style dialog box.

From the main dialog box, pick New and create a style called Fractional using Me­
chanical as the base.

Once this is entered, pick Continue and go to the Primary Units tab to change the units
to fractions. Pick OK and you will return to the Dimension Style Manager.

Use the Set Current button to set the current style to Fractional and close the dialog
box.

21

i'--f---+-i-
Command:DIM
Dim:UPD
Select objects: (pick all the

objects with crossing or window)
Select objects:..J

Make a dimension anywhere on the screen. Pick
the Matchproperties icon. Pick the new dimen­
sion, then all the other dimensions. They will up­
date.

To use update, change the mode to dimensioning
mode, then use UPD.

To update all of your dimensions to fractional, use Matchproperties or the UPDate
command.
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Step 1 Open a floor plan drawn in architectural units.

Ifyou don't have one, open a new file in itnperial units
using acad.dwt, change your units to architectural, and
draw in a few lines for a small house, 25.1 by 35' with a
simple window and door.

I IL .l

Step 2 The Standard dimensioning is set up to be
printed at 1 - 1. For a floor plan, you will be
printing at 1/4"= 1.1_0" or 1/2" = l'_Of?

You will need to set up a dimension styIe
right away_

DO NOT CHANGE THE STANDARD
DEFAULTS!

Create a new dimension style and call it
Quarter for 1/4"= I? _ON.

Step 3 You will need to change three
things right away.

New Dimension Style: quarter

i,-A_rCh_it_ec_IUI_at~__~ r1
'[

Yii-!~
IHorizontal 1"
L---..---:-:-==~' ~l_ (~

\~)

Rl~~
,-------------, Angular dimensions

5ufliK

Prefi:<:

Decimal separator:

Round off:

fu;;;-] Symbols and AIJows~ Te><l ~!l Fit . J~p;;;';~;lTnit;'fAit;f~t;~rr~
: linear dimensions

! Unitlorma\:

'Ii Precision

Fraction formal:

The rounding-off factor is also
important. In this case do not
change it. By changing this you can
sometimes have drawings where
the smaller dimensions add up to
more than the overall dimension.

First, set your primary units to
architectural with a precision of 1".
Having a 1/8'.1 or even a 1/2.'.'

precision on a floor plan is
unrealistic. These are for details.

Now set your text position to be above the dimension line and aligned with it. This is
under the Text tab.

Vertical:

Horlzontat

Offset from dim line:

Above

ICentered

1°,0900

o Horizontat

@) Atigned w~h c!lmenslon line

o ISO standard

Architectural and construction applications generally have the text placed above the
dimension line. This is a standard discipline protocol. In a set ofdrawings, it is not un­
usual to find that those prepared by the designers and architects have different proto­
cols to the structural and mechanical drawings in the same set.
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Now pick the Fit tab, and change the overall scale to 48 as shown on the right below.

If there isn't enough room to place both lext and
arrol"ls inside e~temion ~n~, the first thing to
move outside the extension lines is:

@ Either teK! Of aHOWS (best fitl

o ArIOWS

OTe~t

o Both te~t and arrows

oAlways keep text between ext !ires

[] Suppte~sarlOWS if they don't fil inside
extension lines

Often architectural drawings have ticks
rather than arrowheads. Under the Symbols
and Arrows tab, change the arrows to archi­
tectural ticks.

First:

IIIArchitectural tick

Second:

IliMa".

I

I
Your dimension style should be set and ready to use.
Pick OK at the bottom ofthe dialog box, then choose Set
Current from the Dimension Styles dialog box.

Setup a new layer called Dims, and start dimensioning.

Step 4 Yau will want to set your OSNAP to ENDpoint and MIDpoint.

The dimensions on a frame building are set up for the carpenter, so the outside of the
frame is used as the definition point, not the outside of the veneer. Since the window
position is known, but the exact size of the window is not always known until it is
shipped to the site (due to changes in orders, etc.) the windows and doors are generally
dimensioned to the center point.

The interior walls are dimensioned to the outer edge of the wall to give the interior
dimension, or sometimes to the wall center.

11~1

t
I~'~II

t
11

......
1
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If the building is insulated with concrete or other masonry, these dimensions are
usually measured from the outer edges.

Save your file when you are done. Don't forget to use STRETCH to place the text where
you want it.
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Exercise 7 Practice
This reinforced concrete footing is used in Tutorial 14c page 276.
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FOOTING AND FOUNDATION DRAWINGS
FOOTING AND FOUNDATION DRAWINGS ILLUSTRATE THE SIZE OF THE FOUNDATION AND WHAT FASTENERS ARE USED
TO ATTACH IT TO THE STRUCTURAL MEMBERS. THESE DRAWINGS ARE GENERALLY PREPARED BY CIVIL

OR STRUCTURAL ENGINEERS AS OPPOSED TO ARCHITECTS.
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Exercise 7 Architectural
This is the first floor of the house shown on page 85.
Open the second floor plan shown on page 85. Use Save as and call it First Floor.
Erase what you don't need, and use STRETCH to adjust the windows.
Add the interior walls and fireplace, then dimension. Add the section arrow last.
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Exercise 7 Mechanical
With multiple views you must make sure all the views line up.
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Exercise 7 Wood
This is the top or bonnet for the dock base found on page 105.
To create the numbers use ARRAY then DDEDIT or ED.
The design for the top is created with PLINE.
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Text and Pictorial Views

G)fl~~brhpteti()n,ot this chapter, you should be able to:

},1'lrtr/:> Hn.::oru· tt:>vt in any size at any rotation angle

••.••••• ·'2:,t'IQ<:;e~)() oagf"oph text

}}i/ •• · T •..• ·•.···•• ··•· 3, C,'eQtel::Irl<:! CnOlnq(~oDlh~ctions of formats to make a text style

text

.••..•••·•.t>•• :>j~t ••.~)pi$2rnetrlc text and pictorial drawings.

AutoCAD provides two basic ways to create text. Linear text places simple entries of
one or two lines. For longer entries paragraph text is used. Text is entered in the cur­
rent text style, which incorporates the current format and font settings. Use the Text
toolbar for Inany text entries.

Text E3

W~I
,_,.,,,',_,,,::1:

Linear Text As stated in Chapter 5, the commands TEXT and DTEXT will place strings ofcharacters
on your drawing. When entering text, AutoCAD will prompt you to choose a height
for each character, a rotation angle for the string, and a point at which to place the text
string on the model or drawing. Many people prefer TEXT or Single Line Text from the
pull-down menu for titles and filling in title blocks, as with it you can see the style and
placement of the text as it is entered.

The TEXT or DTEXT Command

In Releases 2008 and 2007, the TEXT command functions in the way that the DTEXT
command functioned in releases prior to 2005. Release 2006 has only the TEXT com­
mand without the multiple line capabilities. This command is very useful for filling in
title blocks and adding data at a standard size and style in several spots on a drawing at
once. Multiline text is very useful for paragraphs and for importing ASCII data, but the
TEXT command is still the best for annotating drawings.

The command line equivalent is TEXT.

The TEXT command is as follows:

Cornrnand:TEXT

Specify start point of text or [Justify/Style]:J

Enter an option

Align/Center/Fit/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR:
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Where: Justify
Style

Align

Center

Fit

Middle

Right

the placelnent of the text
controls the style of the letters; the styles must be loaded
in AutoCAD to be accessible
an alignment by the end points of the baseline; the aspect
ratio (X vs. Y) will correspond to the preset distance
the center point of the baseline; this option will fit the

text through the center point indicated
an adjustment of width only of the characters that are to
be fit or 'stretched' between the indicated points
a placement of the text around the point, i.e. the top and

bottom of the text are centered as well as the sides
an alignment with the right side of the text

The examples in Figure 8.1 demonstrate
the standard justifications. The default
is left justification at the baseline of the
text string.

Height can be chosen by picking a point
to indicate the height, or by typing in a
number.

The double-initialed justification op­
tions illustrated in Figure 8.2 are as fol­
lows:

Default

)\\\9\\80:

III x F ~

Figure 8.1

Centered
x

Mid>dle

t Right

TL top left

Te top center

TR top right

ML middle left

Me middle center

MR middle right

BL bottom left

Be bottom center

-trop LEFT
TOptENTER
Top RIGH-F

Figure 8.2

-MIDDLE l.EFT ~OTTOM LEfT
MIDDLE-tCENTER BOTTOM..rCENTE
MIDDLE RIGHT+ BOTTOM R1GHlt

BR bottom right

Once you have chosen a point at which to place your text~ the command will prompt
you for the height ofthe letters, the rotation angle, and the text or string ofcharacters it­
self.

A text string is one line of text. Front ffevQ tion
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Command: TEXT (or DTEXT) Figure 8.3

Specify Start point or [Justify/

Style] :c
Specify center point: (pick 1)

Specify height<.2000>:.S

Specify rotation angle <O>:~ (to accept the default)

Enter text:Front Elevation~

In Figure 8.3, the justify option Center was chosen, so the other options for placement
were bypassed. If Justify had been chosen, the following line would have been of­
fered:

Align/Center/Fit/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR:
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Degrees

PIus/Minus

Diameter

O/o%.d

°/oo/op
%%c

If TEXT was the last command entered, pressing .J at the Specify start point [Jus­
tify/Style]: prompt skips the prompts for height and rotation angle, and immediately
displays the Enter text: prompt.

The text is placed directly beneath the previous line of text.

Special Character Fonts

You can underscore, overscore, or include a special character by including control in­
formation in the text string. In MTEXT, the special characters are found under the @
symboL

Almost Equal

Angle

Bound(lry Line

Center Line

Delta

Electrical Phase

Flow Line

Identity

Initial Length

Monument Line

Not Equal

Ohm

Omega

Property Line

Subscript 2

Squared

Cubed

\U+2248

\'U+2220

\U+EI00
\U+2104
\U+0394

W+0278

W+EI01

\U+Z261
\U+E200

\U+E102

\U+2260
\U+2126

\U+03A9
\U+214A
\U+2082

\U+OOB2

\U+OOB3

%%u
%%0
%%d
%%p
%%c

%%nnn

underscore
overscore
degree symbol
plus/minus tolerance symbol
diameter symbol
ASCII characters: %% 123 'ro%125 = { }

Non-breal<jng Space Ctrl+Shift+Space

Other."

When using special character fonts with the TEXT command, the special characters will
he displayed as you type, i.e., %%uFront Elevation%%u. The entry will be up­
dated to the desired text once the command is finished, as shown in Figure 8.4.

Comrnand:TEXT
Specify start point or [Justify/Style]:R

Right side: (pick 1)
Specify height<.2500>:~

Specify rotation angle<O>:~

Enter text:%%u%%c25 4 holes
Enter text:.J

Multiline Text

~25

Figure 8.4

4

A new text string will line up with the previously entered text string, if there are no
changes in the base point or justification options in both the TEXT and DTEXT com­
mands. If Center is chosen, all of the text will be centered (see Figure 8.5b); ifno op­
tion is chosen, all strings will be left-justified (see Figure 8.5a). Your last string oftext
will be highlighted to show where the next line will be lined up.

Ifyou do not want your text to line up with the last string entered, simply identify a new
start point. In TEXT use .J to reenter the command after the first text string, then press .J
again to accept the default position, size, and rotation.

If you use ESCape to quit the
DTEXT command, you will
loose aII th e text you entered.
Always use .J to exit from the
DTEXT or TEXT commands.

ALL F~LL!ETS ARE RAlD~US .5
BOTH SHOES

a
Figure 8.5

MOHAWK COLLEGE
FENNEL AND WeST F~FTH

HAMILTON! ON

b

Once your text has been entered, it is accepted as one item and can be edited using any
ofthe edit commands, such as COPY I MOVE, ERASE, ROTATE, andARRAY. To edit the
text itself, use DDEDIT, ED, DDMODIFY, or CHANGE.
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Paragraph Text Paragraph text or MTEXT is for long, complex entries that have many lines oftext. Any
number of text lines or paragraphs can be entered to fit within a specified width. The
paragraphs fonn a single obj ect that can be moved, rotated, copied, erased, mirrored,
stretched, or scaled. This is the default text command under the Draw toolbar in Re­
lease 2000 and subsequent releases.

You can apply overscoring, underlining, fonts, color, and text height to any individual
character, word, or phrase of the paragraph.

Creating paragraph text is a lot more flexible, but slightly more difficult than entering
single line text. Text is entered in the Edit MText dialog box. This editor can be
changed using the MTEXTED system variable. Use Preferences to setup a different edi­
tor. Ifyou are using a system with limited RAM and limited speed, the ability to have
your text spell-checked does not make up for the time necessary to access the MTEXT
dialog box every time you want to add a string oftex!. For large paragraphs, however,
this is a real advantage.

Paragraph Text

The Edit MText dialog box is a very efficient way to set properties that affect the entire
paragraph or selected text. As in a word processor, you should set the width before you
create the text. The paragraph will be displayed in a dialog box within the specified
width. The text will wrap or spill in the direction defmed by the current attachment set­
ting. The text boundary can be realigned. To create paragraph text, from the Text fly­
out on the Draw pull-down menu, choose Multiline text, or the button shown on the
toolbaLThis will invoke the MTEXT command.

A
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The command line equivalent is MTEXT.

You will be prompted to specify the insertion base point for the text as follows:

Command:MTEXT

Current text style: STANDARD Text height: 0.2000
Specify first corner or (Height/Justify/Line

Spacing/Rotation/Style/Width] : (pick a point where the text
will start)

Next you specify the width of the text by using one of the following methods:

• To define a diagonally opposite corner of a rectangular text boundary,
specify a point.

• To define only the width of the text boundary, enter Wand specify a width
value. Entering 0 causes the text to extend horizontally until you press..J.

• The Properties and Find/Replace tabs offer more settings.

The Text Formatting box will appear and your text will be displayed within the box as
you type it, as shown in Figure 8.6.

The width ofthe text that you have chosen will be reflected on the dialog box. Type in
the text you would like placed at the specified location on your file, then choose OK to
write it to the file. Once there, you can highlight it to change the size or properties of
the text.
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Text Styles and
Fonts

hoose YOUr
settings
above; -then
type in who t
y_o~_u_.~. __w_o__u.l.d.....Lj_k_e",._,

in
Figure 8.6

The text can be typed in as in a word processor; it will wrap according to the width cho­
sen.

To edit the color of one word or phrase, or to have it underlined or overscored, select
the text using the mouse, then choose Overscore, Underline, or Color.

Some fonts cannot be displayed in the Edit MText dialog box. If text isn't shown, se­
lect a substitute font to represent the original font, then choose OK. When you are fin­
ished editing, the original font selected appears in the graphics area.

The text will wrap according to the size of lettering that you have chosen. When you
have finished typing in the information you need, pick OK to have it placed in the area
on your screen that you specified earlier.

Text styles are what the user names the style ofthe lettering chosen. Fonts are the style
or design of the letters and numbers used to create the text string. The fonts can be
supplied by AutoCAD or a third-party developer. A text style is stored with not only the
lettering style but also a group of characteristic settings.

The simplest font files are shape files or .shx files. True Type Fonts can be loaded as
well. These are handy, but not always appropriate for drawing notation. They also use
a lot of space on your file, so be careful when loading them.

Using Text Styles

Each text style takes a font file from the AutoCAD list.

The default styIe is Standard using the txt.shx font. To use any other type of lettering
you must load that style. To load a text font onto AutoCAD from another folder, find
the path where the fonts are used in AutoCAD. On most systems this is C:\Program
Files\AutoCAD 2007\Fonts. Copy the font file there and it will be available through
the STYLE command.

The command line equivalent is STYLE.

Both the pull-down menu and typing will give you the dialog box shown in Figure 8.7.
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['jill Text Style 121~1

Figure 8.7

You can change the standard text font or add a new style. Next find a font that you
would like to assign to this name. City Blueprint is fairly standard.

Height can be specified in this style box or within the command itself. It is much better
to assign the height in the TEXT or MTEXT command than here.

To create anew text style, choose New, then pick a style from the font list. ChooseAp­
ply and it will be loaded. The word Cancel will be replaced by the word Close. Choose
Close and your style will be current.

ROMANS

AutoCAD

Aut.oCAD
AutoCAD
~D\c:;~h.\J

Figure 8.8

width fQctor ,5
width fQctor 1
width fQctor 1.5

Oblique angle 0
Oblique angle 30
Oblique angle -30

Upside down
Bo.ckwo.rds

VA
e u

AutoCAD r +

AutoCAD t 0
iC
C A
~ 0

VntOC\iD
OAJoJuA

Most ofthe options illustrated in Figure 8.8 you will never use; keep in mind it is com­
puter people not designers who make the software. They make these option available
simply because they can.

s
Monotext

7 line segments

Figure 8.9

s
Roman Simplex

19 line segments
English Gothic

70 line segments
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Using Text Styles

In Figure 8.9 you can see that the Gothic letter has 10 times the number of lines as the
Monotext letter; it may be appropriate for a title, but not for a notation or a dimension.
The text fonts marked TT are bitmap fonts, not made with lines. These are Microsoft
True Type fonts. To make a style current, simply pick it from the list and then click Ap­
ply.
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Editing Text A text string is considered an object and can therefore be moved, copied, changed into
different layers, and created in different colors. You can also alter the text string itself
as well as the height, the rotation angle, and the style of the characters.

Text objects also provide grips for moving, scaling, and rotating. A paragraph text has
grips at the four comers of the text boundary and, in some cases, at the attachment
point. Line text provides a grip at the lower left comer and another at the alignment
point. (Review Chapter 4 for more information on grips.)

When using Object Snaps, INSERT will snap to the insertion point you selected to cre­
ate the text.

Editing Line Text

You can change both the text characteristics and the text string with the CHANGE
command, as shown in Figure 8.10. This is useful for changing many lines oftext, par­
ticularly when making charts.

DDEDIT and DDMODIFY make editing
single strings oftext much easier. DDEDIT
can be invoked with the alias ED or sim­
ply by double-clicking the text string.

AutoCLAD
AutoCLAD

2

Command: CHANGE Figure 8.10

Select objects: (pick 1)
Select objects:.J

Specify change point or [Properties]:~

Specify new TEXT insertion point <no change>:.J

Enter new text style <STANDARD>:ROMANT (part 1, Figure8.13)

Specify new height <5.0000>:10 (part 2)

Specify new rotation angle <0>:30 (part 3)

Enter new text <AutoCLAD>:AutoCAD (part 4)

CHANGE gives you the options to change all of the variables in the TEXT command as
shown in Figure 8.10.

Ifyou pick more than one string, the command will repeat the prompts for each string.

The DDEDIT Command

In long strings oftext, DDEDIT makes the editing process much easier. You can change
only the text, not the formatting or properties of the text.

To edit the text string content:

The command line equivalent is DDEDIT or ED.

Select the line text object that you would like to edit. Within the text string offered for
editing, select the text where you want it to be changed, or type over or reenter the text,
then choose OK to have it updated. Pressing Backspace will delete the highlighted
text.

Select another line of text or press .J to exit the command.
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Modifying other Properties

Ifyou want to change more than the text line content, use Properties under the Modify
menu. This works on only one string oftext at a time, but
offers you a variety of things to change. ~~..•.••.~I

To edit the text string: ! i:t !:ropertles \

This works similarly to the CHANGE command in that you can change all ofthe prop­
erties associated with the line of text.

To change either the justification or the scale ofthe text using text paramaters choose:

Iii Justify text !ill Scale text

Using LEADER to
Create Notations

The LEADER command in the Dimension menu gives
you the facility of creating text with a leader line or
series of leader lines and an arrowhead as shown in
Figure 8.11. The leader arrowhead emanates from the
point picked. The command is as follows:

2 3
24.00¢ to.02

Figure 8.11Command: LEADER
Specify leader start point: (pick 1)

Specify next point: (pick 2)

Specify next point or [Annotation/Format/Undo] <Annotation>:

(pick 3)

Specify next point or [Annotation/Format/Undo]<Annotation>:~

Enter first line of annotation text:24.00%%c %%pO.02

MText:~

You can enter as many points on the leader line as are necessary.

All special text characters can be used in this dimension as well.

The arrowhead size is set in the dimension style or with DIMSCALE or DIMASZ.

To enter multiple lines oftext, either keep typing at the MText: prompt or enter at the
Annotation (or enter.J for options): prompt. Ifyou choose the latter, you will enter the
text editor and can continue entering text using it.

The options in LEADER include:

Tolerance

Copy

Block
Format

offers a control frame containing geometric tolerances using the
Geometric Tolerances dialog box
copies text, a text paragraph, a block, or a feature control frame to the
leader line
inserts a block at the end of the leader line
controls the way the leader is drawn and whether or not it has an
arrowhead. Options include Spline, Straight, and Arrow
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To enter a leader line without related text, enter a single blank space when you are
prompted for the dimension text. This can be done with all dimension entries.

As in the LINE command, you can use Uto undo the previous point entry without exit­
ing the command. Enter multiple arrows by starting another leader, then use the space
bar for the annotation.
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SNAP and GRID The SNAP and GRID Commands

¢1.50

RO.38

2,00

1..J8

SNAP allows you to indicate
points or positions on the
screen at preset regular inte-
gers. It also allows a rotated or
isometric drawing to be en­
tered. Set up your SNAP and
GRID commands using the
Drafting Settings dialog box
under the Tools menu.

First set SNAP and GRID to
.25 units. Then draw in Figure
8.12.

Figure 8.12

Next rotate SNAP by 45 degrees and set
the base point in the center of the large
circle, as shown in Figure 8.13. The
GRID will follow the SNAP angle. The
crosshairs will remain perpendicular,
but are seen at an angle.

It is possible to enter all ofthis data using
lines at specified angles and offset, but
using GRID and SNAP can be easier. !UOOJi}' I ..

GIld""" ..

Gl1dx.pacing:

S"'lllypa&O\YlfI·"

0Gromap

E>R~snop

Ol>ornellicOMP

O~IIOP

Figure 8.13

COffiInand: SNAP

Specify snap spacing or

[ON/OFF/Aspect/Rotate/Style/Type] <O.500>:R

Specify base point<O'-O.OOu,O'-O.OO">:CEN of (pick the

circle)
Specify rotation angle<O.OO>:45

Draw the other parts us­
ing the new rotated SNAP
as shown in Figure 8.14.

To return to standard
snap and grid values,
choose 0 degrees and 0,0
for the angle and base
points. You can turn the
SNAP, GRID, andORTHO
modes on or offby select­
ing or deselecting the
relevant box.

· . ,: .:), .: T-R!J..7:5 ..

-: .... " . -:/.'.,~~'.. -:' "":'R~.,3B
. ..,,2:50.,. . ..

· , .: .-:/',: :-:->'.:~'''X.~:;.:-:,.: .: :'S~:'I"... /:;.'1,' >:. "· .. /",' ' .. '/ .
...... .. ~"/.' .0,50.,
.. ". \ " ....:: {.~5 G:+. J. :.<: ..

, .~

· .... , .. , ''--....:.. ... ' .. , .. :- ....

Options on the bottom
left will allow you to
change OSNAP I and Figure 8.14

many other settings.
These options are only
available if you have entered via the pull-down menu.

GRID and SNAP can also be useful for placing dimensions at regular or graduated in­
tervals around the drawing. In traditional drafting there are set distances that the di­
mensions should be placed at. These are easier to arrange using SNAP.
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Step]

Step 2

In this tutorial we will create a title block.

Use PLiNE and LINE to create this title block. Ifyou set
the SNAP value to .25 to start, it will make drawing
easier. Change the SNAP value as needed.

The lower left area will be for Scale, Date, etc., the
central area will be for the company title, which is '3D
Design Studio' and the top area will be for revisions.

Set up a text style.

The command line equivalent is STYLE.

=\
1

-,- 0

0,20 :::l

--

Comrnand:STYLE

Create a new text style. Make Futura the
text font for it.

Scroll the bar up until you find Futura.
Choose this font, or another if this is not
available. Then choose Apply and then
Close to return to the command prompt.

Step 3 Use the TEXT command or, ifyou have an older version ofAutoCAD, the DTEXT com­
mand to allow multiple dynamic entries.

Make sure OSNAP is off and SNAP is set to .20. The pline distance is .40, so the text
placed with SNAP will be exactly halfway between the pEnes.

The command line equivalent is TEXT.

Command: TEXT

Current text style: "title U Text height

Specify start point or [Justify/Style]: (pick

Specify height <.5000>:.1

Specify rotation angle <O>:..J ~cale

Enter text:Scale ..J

0.00

1)
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Command:TEXT (use ..J)

Current text ... 0.00
Specify start point or

[Justify/Style] : (pick 2)~

Specify height <.1>:..J

Specify rotation angle <O>:~

Enter text:Drawn By
Command: ..J

..... (pick 3)~

Enter text:Checked By..J

..... (pick 4).J
Enter text:Date~

... (pick 5)

Enter text:Date of Print..J.J

2 ;Rrawn By

7 ~hecked By

-'\ ;k1ate

~ Rate of Prjnt
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The lettering is a bit large, so use the CHANGE command to make the letters smaller.
You can change them with DDMODIFY, but for this operation CHANGE and Match­
prop is quicker.

Step 4

:Cont~ntslDrawn By
[~~i~, '-TTiTLE~c

:Justify. -Left_r--o.o-s--II
!R9~~JO
!~~j~~~c.~,.:,:.,:.",~l:liJ
[~'9~i~;O

StepS

Corrunand:CHANGE

Select objects: (pick 1)

Select objects:~

Specify change point or [Properties]:~

Specify new TEXT insertion point

<no change>:.J

Enter new text style <STANDARD>:~

Specify new height <5.0000>:.08

Specify new rotation angle <O>:~

Enter new text <Scale>:.J

Command:MATCHPROP

Select source object: (pick 2)

Select destination objects: (pick 3,4,S)

Now use the MOVE command to move the text up a bit.

~2

~~By

~By

Dat~
?

Date of Print

Step 6

Command:MOVE
Select objects:P

Select objects:.J
Specify base point or

displacement: (pick 1)

Specify second point as

displacement: (pick 2)

For the other text in this box, create a new
text style and add the text as shown. The
text font illustrated is CityBlueprint.

The command line equivalent is STYLE.

Then add the text as single-line text.

For title blocks paragraph text is used only
for large notations.

Scale 2x
IX

Drawn By

Checked By

SC&Je
a5 noted

Drawn By

5, ~le5
----_._--------""",,------
ChedtedBy

tI, ~Iackman

Date

04/01/08
Dale of PrInt

04/21/08
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Step 7

Step 8

Now make a cube with isometric lettering. Change the
SNAP and GRID values to draw in the cube. From the For­
mat menu, pick Drawing Aids. Change the rotation angle of
the SNAP to 30 degrees.

Command: SNAP

Specify snap spacing or

[ON!OFF/Aspect/Rotate/Style/Type] :8

Enter Snap grid style Standard/Isometric <Standard>:I

Specify vertical spacing <0.01>:1 (will rotate at 30

degrees)

The grid size will follow the snap size unless it is changed by the GRID command.

Use the line command to draw in the cube.

Now use the STYLE command to load the ROMANT font and change the obliquing an­
gle in order to load letters onto an isometric plane.

Note that the text font has changed.
The oblique angle has also been
placed at -30 degrees.

Now add the text.

Command: TEXT

Specify Start point or [Justify/Style]:F

Specify first endpoint of text baseline: (pick 1)

Specify second endpoint of text baseline: (pick 2)

Specify height<.2000>:.5

Specify rotation angle <O>:.J (to accept the default)

Enter text:3 .J

Enter text:.J

152 CHAPTER EIGHT

Now modify the text style to create the D. You
will need to change the oblique angle.

For practice you can copy this cube and place
your initials on it as part of your personal title
block. The top face is either a 30 degree oblieque
angle or a -30 degree oblique angle, depending
on the bottom orientation.
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Step 9 Change the oblique angle ofthe romant font to 0 and add the title and address using the
Center option. Set SNAP back to nonnal before you start.

Command: SNAP

Specify snap spacing or

[ON/OFF/Aspect/Rotate/Style/Type] :S.J

Isornetric/Standard:S

Incrernent<l.OO>:~

Command: STYLE Change the oblique angle.

Command: TEXT

Specify start point or [Justify/Style]:C

Specify Center point of text: (pick 1)

Specify height <.5000>:.1

Specify rotation angle <O>:~

Enter text:Desiqn Studio @
Enter text:Slip Gate Road ~ ~

Enter text:Frog Hollow ~ ~

Enter text:New Hampsh~re

Enter text:.J

Beach Design
Slip Gate Road

Reigate
Surrey

Step 10 Use PAN to move the screen down so that you can change the STYLE to Italic and add the
notes regarding the revisions.

Revisions

Date Description
I I
I I

Cornrnand:TEXT

Specify start point or [Justify/Style]: (p~ck the first
point)

Specify height <1.5000>: .J

Specify rotation angle< O>:~

Enter text:Revisions

Text:~

Use the same command for

Text:Date

Text:Description

Step 11 Now create another box above the Revisions box, and add a paragraph oftext regard­
ing the date oftender for the drawing. Use PUNE to quickly draw in a rectangle. Then
change the style to romans. Finally add a paragraph of text using MTEXT.

The command line equivalent is MTEXT.

.•...••A··.••..•.i.·.....•....·.·.·•.·i...·..n
Cornrnand:MTEXT

I I I II I I II I I II I 111

pra;f~gs;filbe... ser:i I

k>ut for tender on
}June 7 2008. Any
~honqe orders will
!follow. _
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SOlIe
as noted

~~

o-nBy
5,~le5

CtlecIGId By

l?,~

D8I&

04/01/08
Dlll&ofPlfnl 04/21/ 08

drawings will be
sent out 10 tender
on June 2 08.

Once the area has been picked, type in the text that you want, then highlight it to
change the size of the text or the text font, as shown in this example.

tmg

Step 12

I ~ Futura U 8T

as noted

I...."BI S. Kyles

Ch""i«ldlll

D. Blackman

04/01/08

04121/08

Use ZOOM All to view your title block.

Id;;;;i~~~:;iill:>~ ....
Isent OlJtto tender

n June 208.

Change some ofyour text using DDEDIT and file it
for future use under the name Titleblock.

Revisions

Date Description

~-

-

Beach Design
Slip Gate Road

Reigate
Surrey

Once you have a title block, you can insert it into
drawings before printing, so don't lose it!

You can get title blocks that are made up by Auto­
desk on-line. Most companies, however, have
their own title block.

Attributes are very useful in title blocks for setting
up the parameters for the size of lettering, the text
font, the format, etc. So that the information on all
drawings fits a format.

- as noted

-Br S. Kyles
_.~

a.r.oIBr D. Blackman- 04101108_01...
04121108

cIrawlngrwdJ be
_out101llnder
onJunoo2OB.
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Make sure that your title block fits your discipline,
i.e. Tfyou are making a mechanical drawing, don't use an architectural title block.
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Step 1 Start a new file in imperial units. You are making a rabbet corner for wood. No limits
are needed, but you need to make sure you are in imperial, then set an isometric SNAP

and GRID. Use acad.dwt or

Command: NEW

(Choose Imperial) or acad.dwt

Command:UNITS

Set units to architectural.

Under the Tools pull-down menu, choose
Drafting Settings and go to the Snap and Grid
tab. Each release of AutoCAD has a different
layout for the dialog boxes. The infonnation
is generally the same, but it is in a different
place.

GridspaClng

GridX spacing-

\1/4" ! GridY spacing:

Snap X ipaci1g:

Snap Y spacing-

Snap type

@Gridmap

o Re.ctangular snap

@lsomfllric~nllp

Major line evely:

Grid behavior

o Adapliytl grid

oAllow $lJbdi."mion below grid
spacing

D Di;pk;y llli(j b~ond Limils

[JFollowDynilJllicUCS

Set the SNAP and GRID values as
shown. Your spacing for the Y
value will be ~". TheXvalue will
be relative to the Yonce isometric
is chosen. Both GRID and SNAP
should be on. Choose OK to exit
this dialog box.

!1J PoW TlocI«>!i Un (Fl01

1'>101 A"!jl. ~ ,tOng,­

Ir~~~

~-·--1~J

Set Polar Tracking to 30 degrees.

Make sure you have POLAR, OSNAP and OTRACK on.

Step 2 Start by drawing LINEs. Start at 0,0, then move your cur­
sor along the direction ofthe grid points and enter a polar
value. Follow the direction of the arrow as shown.

Command: LINE
Specify first point:O,O

Specify next point or [Undo] : 6 up
Specify next point or [Undo] :3 across
Specify next point or [Undo]:6 down

Specify next point or [Undo] :c

Text and Pictorial Views 155
More free ebooks  :  http://fast-file.blogspot.com



Step 3

Now create lines in the opposite direction and use the ENDpoint OSNAP to close the
object. If ENDpoint does not automatically come on with your OSNAP button de­
pressed, right-click the word OSNAP, choose Settings,
and indicate that you would like an ENDpoint setting. ~

2

Command: LINE

Specify first point: (pick 1)
Specify next point or [Undo]:4 across

Specify next point or [Undo]:6 up

Specify next point or [Undo]: (pick 2)

Specify next point or [Undo]:~

Now create the top portion ofthe box. Follow the direc­
tion of the arrow as shown.

2

Cornmand:LINE
Specify first point: (pick 1)
Specify next point or [Undo]:3 across

Specify next point or [Undo] :END of

(pick 2)
Specify next point or [Undo]:~

Step 4

156 CHAPTER EIGHT

Now use the MIDpoint object snap to create the wedge.
Type in MID if a triangle doesn't show up.

Cornmand:LINE

Specify first point:MID of (pick 1)

Specify next point or [Undo]:2 down
Specify next point or [Undo]:4 across

Specify next point or [Undo]:~

Use TRIM to remove the end of the line as shown.

Cornmand:TRIM

Current settings: Projection=UCS

Edge=None
Select cutting edges ...

Select objects: (pick 1)

Select objects:..J

<Select object to trim> or

shift-select to extend [Fence/

Project/Edge/eRase/Undo] : (pick 2)

It .........
....

................

.... 2....x
...........
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Step 5

Step 6

Step 7

Use the LINE command to place the next two lines.

Command: LINE
Specify first point:END of (pick 1)
Specify next point or [Undo]:4 across

Specify next point or [Undo]:~

Command:LINE
Specify first point:END of (pick 2)
Specify next point or [Undo]:4 across

Specify next point or [Undo]:~

Use the LINE command to place the next three lines.

Command: LINE
Specify first point:END of (pick 1)
Specify next point or [Undo]:4 across

Specify next point or [Undo]:~

Command:LINE

Specify first point:END of (pick 2)

Specify next point or [Undo] :END of

(pi.ck 3)

Specify next point or [Undo] :END of

(pick 4)

Specify next point or [Undo]:~

Now trim the line ends as shown and erase the line on
pick 5.

Command: TRIM

Current settings: Projection=UCS

Edge=None

Select cutting edges ...

Select objects: (pick 1, 2)
Select objects:~

<Select object to trim> or
shift-select to extend [Fence/

Project!Edge/eRase/Undo] : (pick 3,4)
Command:ERASE

Select objects: (pick 5)

Select objects:.J

Use TRIM again to trim off the last two lines so that the
file looks like this. In woodworking, this is the first part
ofa rabbet.

Use PAN to get the objects fully on screen. Then move
them a bit to the right for the next step.

2

2
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Step 8 The GRID and SNAP should still be on. Use these to line up the next set oflines. Start at
the top.

Command:LINE

Specify first point: (pick 1)
Specify next point or [Undo]:2 down

Specify next point or [Undo] :1.5
across

Specify next point or [Undo] :1 down

Specify next point or [Undo] : 4 across

Specify next point or [Undo] :3 up

Specify next point or [Undo]:c

Step 9 Now draw lines in the opposite direction. Use the GRID as a guide or the lines will not
be straight.

158 CHAPTER EIGHT

Command:LlNE
Specify first point: (pick 1)
Specify next point or [Undo]:4

across
Specify next point or [Undo]: ~

Command:LlNE

Specify first point: (pick 2)

Specify next point or [Undo]:4

across

Specify next point or [Undo]: ~

Cornmand:LINE
Specify first point: (pick 3)

Specify next point or [Undo]:4

across
Specify next point or [Undo]:~

Finally use ENDpoint in OSNAP to draw in the
final two lines.

Command: LINE

Specify first point: (pick 1)

Specify next point or

[Undo] : (pick 2)
Specify next point or

[Undo] : (pick 3)

Specify next point or

(Undo) :.J

Tutoria18b has illustrated how to
rotate the SNAP and GRID, how to
use POLAR with Object Snaps on
a rotated SNAP, and how to TRIM.

3

2

2
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I ~ I i Compa.ny Dawn BlacKmanDeSiqlll1c' Project
4 Holhs Street...
BriX1:on ROBICHEAU YACHT CLUB

II I! R~ RfItJ. No. DGH Dra.wing
I floor Plan5~

a
a
a
(\j

Exercise 8 Practice
Make a sample drawing using Iineweights with a lineweight key as shown in 8A.
Then make a sample title block that you can use later as shown in 88 and 8e.

-"'"'"""--1

I
OUTLINE .30

WALLS DEFAULT

VENEER/DIMENSIONS .18

HATCH/DRYWALL .05

8A PRACTICE TEXT WITH DIFFERENT L1NEWEIGHTS.

ASSOCIATE THE LAYERS WITH THE L1NEWEIGHTS NOTED ABOVE

YOUR L1NEWEIGHT WILL DISTINGUISH A GOOD DRAWING
FROM A GREAT DRAWING.

10 1/2' I
-----3 1/4·------ir2·-lI-----3 1/41

-----

r-..-
-t

88 Imperial

-----110-----0+1---80---

CLIENT MTL:
TITLE FINISH:r 35-t-45--r-30-1 65 100MM CASTER ASS. SCALI:..: f:l
TOl. UNLESS SPECIFIED DRN: I1J-y:. W'~
DECIMAL O.O=tO.1 DATE: Ron. q 1008

0.00=+,0.05 CHK. BY: ,b.rAX.

Walker Inc. NUMBER
R£V. lW'E ElY DESCRP110N J - 2288A

ae Metric

--.E 5

10

t
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Exercise 8 Architectural
Notations are extremely important in steel shop drawings.
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SHOP DRAWINGS: STRUCTURAL STEEL
STEEL BEAMS SUCH AS THESE ARE MANUFACTURED IN THE PLANT WITH THE FASTENERS IN PLACE AND READY TO
INSTALL.

THE SHOP DRAWINGS TELL THE MANUFACTURERS WHAT FASTENERS - L BRACKETS - ARE NEEDED AND WHERE THEY GO.
THE HORIZONTAL MEASUREMENTS ARE NOMINAL, BUT THE VERTICALS MUST BE DRAWN TO SCALE.
ALL NOTATIONS MUST BE PUT IN EXACTLY AS SHOWN. BOTH THE MANUFACTURERS AND THE INSTALLERS WILL KNOW

WHAT THEY MEAN. THE BEAM MARK W460 X 82 X 4960 MEANS THE VERTICAL HEIGHT X THE MASS X THE LENGTH OF

THE BEAM WITHOUT THE FASTENERS. THESE PARAMETERS ARE MEASURED TO A CENTERLINE OF THE RECEIVING BEAM OR
GIRDER.
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Exercise 8 Mechanical
Draw all of this example, including the title block.

TYPE-A

R1/4

3.0058

R15/16

¢ 3/8 6 HOLES

1 1/2

+

02

R3/16

..:;t

"­--+--+----7f------+ (Y)---l...--+----+-===-~=-:-=~+_--_._

C\J

R1/2

1 5/8 -----+---1 1/8 -"--1 3/8

1----------5---------J

l----------6---------l

PART REVISIONS

The making of any portion of this drawing or any portion thereof by any means

is expressly prohibited unless authorized in writing.

Job Gasket
Drwn

Date

Scale

App

Company Cribbin Limited
OWG No.
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Exercise 8 Wood Millwork
This page shows a section and side view of a train station bench.
The wood hatch is made with plines.
The concrete hatch can be found in Chapter 9.

NOTE:
ARMRESTS TO BE PROVIDED
AT BENCH TYPE 2 ONLY

25 CUBE ALUM
GRI LLE (TYP)

19 HARDWOOD CAP

CONTINUOUS
38 THK HARDWOOD
BENCH WI
STAIN FIN ON
WD FRAMING
PS REQUIRED

",--------

~
2S THKHRDWD
ARMREST
SEE NOTE
ABOVE

40 TERRON
METAL LATH ON ----?>

90 CONC BLK

varies 125

LIGHT FIXTURE AND
MOUNTING BRACKET
SEE ELEC. DRAWING.

varies 125 425

325

25

1"--~ 15...:.....:--.30~~!-_~~ 1680 (FOR TYPE 1 ONLY) ---J,
Section

scale 1:50

BUILT-IN WOOD
BENCH TYPE 2

NOTE
To show dimensions at twice
the scale factor on the same
page, create a new dimstyle.
Under the Primary Units tab
change the Measurement Scale.

162 CHAPTER EIGHT

SKTI
NJOVf!.

3000

90 DIAHDWD
/ ARMREST CAP (TVP)

o
0.

Side View
scale 1: 100
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Exercise 8 Wood Millwork (continued)
This pictorial view of the bench found on page 162 helps to describe it.
A rotated SNAP makes this much easier.

CAVALIER AND CABINET PROJECTIONS

PICTORIAL VIEWS ARE USED TO HELP DESCRIBE AN

OBJECT. THE CAVALIER VIEW, SHOWN BELOW, IS A

STANDARD WOOD DETAILING PROTOCOL. THE

FRONT PLANE IS SHOWN AT A SLIGHT ANGLE TO
THE VIEWER WHILE THE BACK RECEEDS AT A 45
DEGREE ANGLE.

ISOMETRIC VIEWS, AS SHOWN ON THE NEXT PAGE,

HAVE ALL ANGLES AT 30-35 DEGREES.

OBLIQUED VIEW

FRONT

CLR ANOD 25 CUBE
ALUM GRILLE
(TYP)

S. ST COVER TO
SUIT OPENING 250 X375
e/W 19 WIDE EDGE TRIM
& ENGRAVED SIGNAGE
BY SECTION 10800

BULLET END
(TYP)

WASTE

\
\

\
\

\
\

>
I

25 ;';50 25

I
/

EQ EO

6 RADIUS (TYP
ALL OUTSIDE
EDGES)

RECESSED TERR
BASE --------Ir-----3>

HDWR ARMREST ---- ~

REMOVABLE SST
CONTAINER, 250 WX
4000 X550 H
SHOWN DASHED

5 5T PANEL C/W
ACCESS DOOR
LOCK & ENGRAVED
SIGNAGE (TYP
OPPOSITE SIDE TO
NEWSPAPER
RECEPTACLE)

Cavalier View
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Insulated Concrete Form
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The BHATCH
Command

HATCH, SKETCH, and
GRADIENTS

On completion of this chapter, you should be able to:

f .. Use the BHATCH command

"",",,,,",, .~. hatches

command

fhe;(jRA..DIE:NJ command

This chapter will deal with graphic patterns that will make your drawings look more
professional. Hatches are used in mechanical and civil drawings to show cross-sec­
tions or the delineation ofdifferent materials. In architectural applications, hatches are
used to show the types of material used e.g.brick/stonel wood/concrete/sand.

The BHATCH command fills an enclosed area with an associative hatch pattern that will
update when the boundaries are modified. In addition, BHATCH allows you to preview
the hatch pattern and adjust the definition or options of the hatch such as scale and
angle. BHATCH is accessed through a dialog box. To access BHATCH:

. ,

.

The command line equivalent is -HATCH for the command line, BHATCH for the dia­
log box.

Command:-HATCH

Current hatch pattern:ANSI31

Specify internal point or

[Properties/Select objects/draw

boundary/remove Boundaries/

Advanced/DRaw order/Origin] : (pick 1)

Figure 9.1
The hatch will be drawn within the area specified. The area
must be a closed boundary, as in Figure 9.1.

When placing hatches, consider the boundary as containing something liquid: if the
shape is not closed, the hatch will simply pour out until it meets with a boundary that
will contain it. Close comers with Fillet radius 0 and try to avoid overlapping geome­
try.

In earlier releases there was a command called HATCH that created a hatch that was not
associated with the boundary. This was useful particularly in architectural applica­
tions for showing dappled light on textured surfaces. The boundary hatch could be
copied to make several regular patterns.

In Releases 2007 and 2008, this is under Options in the BHATCH menu.

HATCH, SKETCH, and GRADIENTS 165

More free ebooks  :  http://fast-file.blogspot.com



The BHATCH dialog Box

The BHATCH dialog box offers many good options.The GRADIENT command is under
the same menu but has a different tab. Ifyou don't get the full menu below when you
open the BHATCH command, use the small arrow on the bottom right.

I~l!optioo$

0u~<;l,ll'!I~,wongin

o Vie' ~O\lfCe fh>llq;hOliSin

opti=
~A~ociaWe

oCreate Sepal',*,h$Che~

Scale:

Predefined Sf:!

ANSI31---'i~~Q

W'/%?7)/j'

Hatch Qflgin

G Use cunel"ll origin

o Specified origin

Swatch:

Type and pattern

Angle and scale

Pattern:

Type:

The BHATCH dialog box controls every aspect of the hatch pattern.

Type tells you if it is a user-defined or an AutoCAD-defined hatch

Pattern controls the ACAD standard hatch patterns. Hatch patterns are
listed by name in the dialog box. Click on the down arrow to
view the available patterns. This area lists only the names of
the patterns

Swatch illustrates the pattern

Preview allows you to preview the hatch before applying it

Angle controls the angle of the hatch patterns. Angles are generally
counterclockwise

Scale shows the scale of the pattern to be used. The default scale
factor is 1. This means that the hatch is calculated to be
displayed at the default screen size or an 11" x 8 1/2" sheet

Hatch origin used for setting bricks or stone to start points

Boundaries refers to the objects that are to be hatched; either closed
objects, such as circles or ellipses, or sets of contiguous
objects

Options allows for the hatches to be non-associative

Inherit properties acts like the MATCHPROPERTIES command, matching the
pattern scale and angle of a chosen hatch and applying it to
another hatch
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Layers

In Figure 9.2 the hatches are contained by boundaries
that are placed on a different layer then frozen. Only
the hatch is seen on the final drawing.

Figure 9.2

Scale

Each hatch pattern has a specific number of lines per inch. For example, the ANSI3]
pattern generates three lines per inch at a scale of I: 1. Ifyou have changed the limits
and the model is larger than 11 units in X, you must change the scale factor.

When working in inch units, the scale factor of the hatch should be the lnaximum X
value ofthe screen divided by 12, the same as the scale factor for LTSCALE. For exam­
ple, limits at 0,0 and 24,18 would have a scale factor of 2.

406,2:74 ?OII~(Y

----_._._----

Scale I Scale 2 Scale I Scale 20 Scale I Scale 48

a b
Figure 9.3

Other scale sizes are shown in Figure 9.3. Remember, if you are using architectural
units or feet and inches, each 11l1it is an inch, not a foot.

Always use the Preview option on the bottom left ofthe BHATCH dialog box before ap­
plying the hatch to see if it is correct.

In Chapter 11 there is a discussion on scale with regard to the size ofthe hatch and line­
type scales and the size of the drawing. Before producing the final drawings, check
Chapter 11 to see that the hatch is accurate.

Identifying the Boundary

For many students, this is where the difficulties begin because objects must form a per­
fect boundary.Lines, circles, and other objects are sometimes not entered accurately.
SNAP and OSNAP are not always used effectively and consequently the lines are
crooked, do not have tidy intersections with adjacent items, or are otherwise defective.
This means that these objects do not provide an adequate boundary for hatching.

Angle 90

ba
Figure 9.4

Angle

If you are picking a hatch from the pull-down
menu, the rotation angle will be exactly as
shown. For example, Figure 9.4 a uses ANSI33,
which is displayed at an angle of45 degrees. To
pick this pattern as it appears on the screen, do
not change the rotation angle; leave it at zero,
because that is the angle of the pattern itself.

Figure 9Ab has ANSI33 at the default rotation
and at a rotation angle of 90 degrees.

When using user-defined hatch patterns, the ro­
tation angle is calculated at the horizontal, ro­
tating counterclockwise.

If you do not adjust your scale
factor, AutoCAD will attempt to
create the hatch at the default
scale. There is a good chance
you will run out of room on your
floppy disk and be forced to exit
from the file. Save your file
before hatching, and preview
the hotch just in case.
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Use FILLET with Radius 0 to clean up your comers, or make the objects into a continu­
ous boundary with the PEDIT command and the Join option.

There are two basic ways of identifying the boundaries: by picking points and by se­
lecting objects.

Add: Pick points identifies a boundary from existing objects that form an
enclosed area. AutoCAD defines the boundary by
analyzing all the closed objects in the area. Once you
have chosen the Pick points option, the dialog box
disappears and AutoCAD prompts for point

specification.

In Figure 9.5, pick 1 is
within the outer closed
boundary and outside the
circle, so the circle is Xl

shown not hatched.

Add: Objects

Figure 9.5

allows the user to identify the boundary by object
selection rather than as an internal point. Sometimes
both Select objects and Pick points can be used

successfully to identify one batch boundary.

2

Figure 9. 6

I@)(c?)ll~~l

l[Cl1'G I

i I Te~tI I i,.,', Test 1,1

"'~ : - !

,_~_ l ~_~

In Figure 9.6, the objects are picked up with a window selection using Add: Select oh­
j ects. In both cases the geometry must fonn a continuous boundary.

Preview displays the hatching before it is applied. This can save a lot of
time

Advanced Options Dialog Box

This dialog box controls the definition of the boundary set.
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Object type AutoCAD's hatches are created either in regions or in
polylines.
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a b c
Figure 9.7

In Figure 9.7a, all of the objects were picked by Select objects. The resulting alternat­
ing hatch is the saine as in Figure 9.7b where the hatch boundary was chosen by a Pick
Points option.

In Figure 9.7c, the second circle in from the center was re­
moved from the selection using the Remove boundaries op­
tion of the Boundaries section. This allows you to control
which boundaries will be hatched.

The resulting hatch will he associative. You can modifY or
delete it as one object only; the individual areas cannot be
modified by themselves.

~. Add: .Pick point~

[iJ Add.SeJectobjecls

i'l Removeboundaries

,~~emz!;:::r~<?a%fdl}'

~ View Selections

Solid Hatches All Releases after 2006 allow for solids in undulating
boundaries, such as that shown in Figure 9.8. Pick the
Solid hatch pattern from the BHATCH dialog box under
pattern.

Solid hatches for circles are also a good idea when plot-
ting; for SOlne reason a solid round hatch is easier for a Figure 9.8

plotter to calculate than a donut.

Editing Hatches There are two ways ofediting associative hatching. The first is to edit the boundaries;
the second is to edit the actual hatch itself.

Editing Boundaries

With associative hatching, the hatch will update when the boundaries are changed.

x 4 r7"7""77";'777"-::>"77771

>f:c---------,

x3

Figure 9.9

Command: STRETCH

Select objects: (pick 1)

Other corner: (pick 2)

Select objects:~

Specify base point or

displacement: (pick 3)
Specify second point of

displacement: (pick 4)

In Figure 9.9 the hatch has updated along with the boundaries. Hatches will also
MOVE/ ROTATE/ MIRROR and SCALE along with the boundary. The hatch layer must
not be locked for the hatch to be edited.
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Editing the Hatch Properties

Figure 9.1 Oa shows the base hatch.

In Figure 9.10b, the pattern has been changed
from ANSl35 to ANSI38.

In Figure 9.1 Oc, the scale of the hatch in Fig­
ure 9.1 Oa has been changed.

To edit a hatch, double-click the hatch and the
BHATCH dialog box will appear. Change the
properties there. (In Releases prior to 2007, a
right-click is needed.)

q

Figure 9.10
b

The SKETCH
Command

SKETCH provides freehand sketching capabilities
on a drawing. Ifyou want to be taken seriously as
a designer, lolly-pop trees will not do. The tree in
Figure 9.11 is shown in context on page 180.

The motion of the mouse determines the position
ofthe sketch segments; the accuracy ofthe sketch
segments is determined within the command.

The SKETCH command will prompt the user for
the increment or the distance between segments;
for smoother curves, use smaller increments.
Segments are not recorded on the disk until you
use the Record option.

The command line equivalent is SKETCH.
Figure 9.11

Command: SKETCH

Record increment <0.01>:.1

Sketch, Pen eXit Quit Record Erase Connect:P
Sketch:

Where: Record

QUit

Pen

eXit

Erase

a save of all the lines drawn so far. Rwill make a permanent
record of your lines without exiting from the command.

a cancellation of the segments to date. Q will leave SKETCH
without saving the segments you have drawn.

the pen is lowered. The system prompts to put your pen down;
whatever move you make with your cursor will be recorded. P
a second tinle will lift the pen up.

the end of the command. X will exit from the Sketch
command, retaining all segments created up to that point.

an erasing of some of the line segments drawn. Ewill allow
you to erase lines from a certain point; it acts as a
"backspace" over segments created.
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Connect = a continuation of a previous sketch. C lets you pick up sketch
again at the last entered endpoint after it has been ended.

The SKETCH command is useful for making landscaping and rough-edged sketches.
The number of lines created by the SKETCH command may be a problem. Be sure to
save your file before you start to sketch.
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Gradient GRADIENT, like HATCH, is used near the end of a drawing session to add the finishing
touches to a drawing. Like the SKETCH command, this is more ofan art than the normal
AutoCAD process. Because of this, it is suggested that you use GRADIENT sparingly.
What may look really fantastic to the unpracticed eye may seemjust silly to people who
have some experience of reading and looking at drawings.

ie. ~
..

The command line equivalent is GRADIENT.

Most of the options of the GRADIENT dialog box are similar to those of the BHATCH
dialog box. First you lnust identify a closedboundary. Once this is done, you choose the
pattern that you would like to have shown within that boundary.

The Pick points and Select objects
options are the same as those for
the HATCH command. The Inherit
Properties option is also the same.
Like hatch, the gradients can be
either assocative or non-
associative.

Bounrillrie~

!iii Adde Pick points

l!i] Add Select obiects

Angje:

Shiode Tlnl

1];' J '_••.~: ~ :- '

! J ••'1

~
1111

0Cenlered

Col",

Gnne colol 0 Iwo ';;0101

Ori~ntallon

E [j

11 Hatch dnd GrudJelit IIJ~I

The major difference with gradi­
ents is in the choosing of colors.
Once you open the color section,
you will see that this is more com­
puter graphics than computer
aided design.

The GRADIENTS are loaded in a
pixel address format as opposed to
the usual vector format that Auto­
CAD uses. This takes up a lot of
space, and care is required for

(i) plotting. Do a trial plot before sub-
11...- --1 mitting your drawing.

The colors are also designer colors, and the palettes are RGB (red/greenlblue) and
Pantone colors. Most students need little encouragement to 'play' with the color pal­
ettes and tones. Keep in mind that there is a thin line between cutting edge design and
overuse of colors.

PrmtingyourGradkn~

When choosing your color palette, be aware that the colors you see on screen are rarely
the same as in a print-out. The final color depends on both resolution (dpi) and palettes.

RGB are on-screen colors. Printing machines are generally calibrated for CMYK
(cyan, magenta, yellow and black). In addition, the Pantone colors are usually a bit dif­
ferent to those seen on screen.

Practice printing your gradients well before the time that your project is due. Each col­
or printer will produce different results.
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Veneer

Veneer

Pins

Concrete

Insulation

Walls

In order to make this cavity wall section, you need to have the outline of the sections
drawn. See page 174 Step 6 for the final version. Open a metric file acadiso.dwt.

Make up several layers :

Stepl

Draw the pin and the veneer on the respective layers. Make sure that the veneer layer
has all the lines for a continuous boundary' i.e. the area where the pin is inserted into
the veneer is part of the concrete layer, not the pin layer.

The insulation layer is between the veneer layer and the concrete layer.

~NSULAT~ON

CONCRETE

400

Step 2 Once these outlines have been drawn, the rest is relatively easy.

Freeze all layers except the veneer.

r----------------------¥2

fDDLLJDD

i[j
D
Gq

___________________ J
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11 Now access the BHATCH dialog box.

Once in the BHATCH dialog box:

• Choose the ANSI31 hatch pattern.

• Change the scale to 10.

• Choose the Add Select objects
icon, then use a window to select the
objects as shown above in picks I
and 2 to place the veneer hatch pat­
tern in the boundaries as shown.

lfthe hatch does not look like the one
on the facing page, some ofyour cor­
ners are not closed. Window each
brick individually and put hatches in
one by one. You will soon find the
faulty comer.

Type and pattem

Type:

Step 3 Make the insulation layer current.

Pattern

Swatch:

Step 4

Freeze all the layers except for the insula­
tion.

Using the Boundary hatch menu, add the
insulation using the insulation hatch.

Make sure that you have closed all the rec­
tangles or the hatch will not work. Use FIL­
LET Radius 0 to clean up comers.

Now thaw your concrete layer. Notice that
the pin layer shows the pin from the outside
edge of the concrete. The concrete layer it­
self is a continuous boundary with the area
for the pin removed.

Once the boundary is continuous, add in the
text and PLiNEs as shown to indicate that this
is the concrete column.

~x

r
I
I

. . ..... ]

:",."":~~N:~~E~E
·.·.··.C?l~N: .

•• : ... J ~.. -# ...

• 011 ... ..t t .....

l_~' : .' :., ~~J

Your hatch will leave a space for the text so
that it can be properly read.

Now go to the BHATCH dialog box.

Change the hatch pattern to ar-conc (architec­
tural concrete.)

You will also need to change the scale. The
architectural patterns are 12 times larger than
the mechanical patterns, so a scale of 1is fine.

Choose the Pick points icon and pick a point within the concrete boundary as shown in
pick 1 to identify the hatch boundary.
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Preview the hatch.

If the concrete hatch doesn't look like
the one opposite, use ESCape to go
back to the BHATCH menu and make the r ~I·I

necessary changes. ~

D 7I 2.J

Step 5 Finally put a hatch in your wall section.

...

I~~~-'
" "'.d ill ~ ~ Jj

T~peand palteln

T~p<I ~~

P..lIi"An ~__!'JO
S_ch 1111111111111111

Thaw all of your layers.

In construction drawings, unless you
are seeing the entire expanse ofan area,
there is a break line as shown at the
edges of the walls, insulation and
veneer. Put in the break line on your wall sec­
tions before hatching so that the ends of the
walls are shown to be broken as well.

As in the previous two hatches, you will
need to copy some data over to the
walls layer to make a complete bound­
ary.

Step 6 The wall section is almost complete. All you need is to finish the drywall on the inside.

Create another layer called
drywall. Put in the boundary as
shown, and find an appropriate
hatch for it.

I~-~--~~~. ~.

~.'(C~N'~~'E~Y-=[Elir
. ":C~U'N ~ i

'G' J " ...1 ..

This is a construction detail of
a concrete column.

There is a thin layer of insula­
tion on the outside of the exte­
rior wall and the column.

The veneer, in this case either
brick or decorative concrete
block, is pinned to the column,
as is the wall itself.

The inside finish is drywall.

To do this kind of detail with­
out using layers is possible, but
much more difficult.

A •

.:
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Exercise 9 Practice
Sections are used to show what an object is made of
as well as where the indentations and cuts are within it.
In the case of the wheel, almost nothing can be gained
from looking at the front view alone. The section tells everything.

!II )

~I 3'

1v"1---9'--j
!:II !:II -J11

~~ ,.. }.7'5'
~ l 1

II
165 175

Stair

Fft
·511.5

I-L

Die Ring

t 420

1~3B'O-1

I

Section 'A-A'

Plate Section

9l100.0

¢38,O

l,ll22,O
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Exercise 9 Architectural
In architectural applications hatches and gradients are often used
in elevations. These are elevations of the house shown in plan on pages 85 and 137.
The foundation, shown in hidden lines, has a break line. Note that the
elevations are lined up on the page.
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ELEVATIONS
ELEVATIONS ARE A VIEW OF EITHER THE EXTERIOR OR THE INTERIOR OF A BUILDING AS SEEN FROM ·STRAIGHT-ON", THE FINISH MATERIALS ARE

INDICATED BOTH WITH HATCHES AND WITH NOTATIONS. THE HEIGHTS OF FINISHED FLOORS, CEILINGS AND/OR DOORS AND WINDOWS CAN BE
SHOWN AS WELL. THIS GIVES AN INDICATION OF WHAT THE PROJECT WILL LOOK LIKE WHEN COMPLETED.
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Exercise 9 Mechanical
Using the dimensions on this page, create the
assembled section for the tool post shown on page 179.
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Exercise 9 Mechanical (continued)
Using the dimensions on the previous page create a section of the toolpost as shown.
Then try creating a section of the battery pulley.

4 5/8

PICTORIAL VIEW'
SECTION

TDDLPDST

1/2 DIA

3/32 DRILL

/'
........

-"-.....

17/64 DIA X 318

All FILLETS AND
ROUNDS l/8R

BAT"TERY PULLEY

SCl'ew

/BI"D.Cket

,
Jo.w
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Example 9 - Challenger
This is a stunning use of gradients. Try designing a facade yourself.
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Using Blocks

Blocks and Wblocks

Oncofflpletionof this chapter, you should be able to:

Create o· block

2.Creoteo·wblock

3. lNSERTboth blocks and wblocks

4,Use Copy/Paste

5.t)se COLOR, LAYERS, and other data with blocks

6. lJse blQcksform the AutoCAD Design Center.

Blocks are a way of compiling lnany different drawings and drawing details onto one
final drawing. By using BLOCKs on large projects, you can cut down design time by
creating portions ofthe drawing separately and then assembling them on a final draw­
Ing.

There are two types of blocks used in AutoCAD. An internal block created with the
BLOCK command is part ofthe base drawing and cannot be accessed except within the
drawing. An external block or wblock is a drawing file.

Any drawing file can be inserted onto another drawing file at any time. Drawing files
are already external blocks.

Dimensions and hatches are also considered blocks by AutoCAD because they are
groups ofinfonnation, but these are not made with the BLOCK commands.

The six commands that are connected with blocks are:

BLOCK

WBLOCK

INSERT

MINSERT

BURST

EXPLODE

creates an internal block

creates a .DWG file or external block

inserts either a block or a wblock (external drawing file)

inserts blocks in rectangular arrays like the ARRAY command

reverts the blocked data back to individual objects

reverts the blocked data back to individual objects

The BLOCK
Command

The BLOCK command is used to create a group or set ofobjects that are identified by a
given name. Once blocked, an object can be inserted into your drawing many times.
Blocks created with the BLOCK command are internal.

The command line equivalent is BLOCK or -BLOCK for no dialog box.

When creating a block, you must identify three things. The name ofthe block, the in­
sertion base point, and the objects contained within that block. The dialog box can be
accessed either through the icon or by typing in BLOCK. If you find the dialog box
cumbersome, type in -BLOCK. It is much quicker.
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Adding the (-) before the command brings up the command without the dialog box.

If you don't like dialog boxes, most
can be turned off by adding a
hyphen, for example, -block,

Command:-BLOCK

Enter block name or [?) :STENO

Specify insertion base point:

MID of (pick 1)
Select objects: (pick 2)

Other corner: (pick 3)

Select objects:..J

2
r -----------¥
I I
I I
I I
I I
I I
I I
I I
I I
I I

3 I I* J

Figure 10.1

If you use .BLOCK, your block will
disappear. With the dialog box, it
will only change color.

The INSERT
Command

182 CHAPTER TEN

Both the Block Definition dialog box and the command string above will create a
block of information, as shown in Figure lO.l.

The insertion base point on a block is
particularly important, because it is the
point of reference for inserting, much
like the base point in the COpy or MOVE
commands. If this point is placed logi­
cally on the object, the insertion of the
block should be perfect every time.

The Pick point button on the dialog box
DsC<lle urAfotmly is for you to pick the insertion base point.
0Albwexpj~ If you don't pick this point, your block

will not show up where you want it.

Once you have given the block a name,
chosen the insertion Base point, and cho-
sen the objects to create that block it is
ready to insert into a drawing.

With the Block Definition dialog box, the objects identified for the block are formed
into a block and left on your screen. They can now be manipulated as one object. With
the -BLOCK command, the block will disappear from the screen and you will then in­
sert it where you would like it.

The INSERT command is used to place previously defined blocks into the current
drawing.

The command line equivalent is INSERT or -INSERT for no dialog box.

The INSERT command places the block on the drawing in its original size. The X scale
factor defaults to 1. The Y scale factor defaults to X If you make the X value 2, the Y
value will also be 2, unless you change it. Changing the Yvalue relative to the X value
will distort the image of the original block.

The rotation angle is a counterclockwise rotation around the insertion base point. The
insertion base point is the one you chose when blocking the items. If you have made
the insertion base point in a bad place on the object, use EXPLODE and reBLOCK it.
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Inserting blocks is much like using COPY, except that
you identify objects by a given name and not a pick. In
Figure 10.2 the steno chair is inserted at a desk.

Figure 10.2

Command:-INSERT

Enter block name or [?] :Steno

Specify insertion point or
[Scale/X/Y/Z/Rot .... ate]: (pick 1)

Enter X scale factor, specify

opposite corner, or [Corner/XYZ]

<1>:.J

Enter Y scale factor <use X scale
factor>:.J

Specify rotation angle <0>: (move your cursor around until

the chair is properly positioned, then pick)

In the Insert dialog box the Browse op­
tion allows you to insert external
blocks. Use the down arrow to access
all internal blocks or blocks already
used on the current drawing.

As an example take the title block
from Chapter 8. The Browse option
on the Insert dialog box will offer a
list of all drawings on your C: or D:
drive or on your floppy disks or stor­
age cartridges.

External blocks are AutoCAD files that
have already been created. They are
used to compile final drawings. Title
blocks, drawing arrows, sections, no­
tations, or views of objects that are
used on more than one final drawing
can all be used as external blocks.

External Blocks

Figure 10.3

In Figure 10.3 we have opened the
desk layout from page 68, created the
steno block, inserted it, and then inserted a title block from Chapter 8.

Use either the Insert dialog box or -INSERT to place the title block.

Command:-INSERT

EnLer block name (or ?)<STENO>:a:title

Specify insertion point or [Scale/X/Y!Z/Rotate/PScale/PX!

PY/PZ/PRotate] : (pick 1)
Enter X scale factor, specify opposi te corner, or

[Corner /XYZ] :.J

Y scale factor <use X scale factor:.J

Specify rotation angle <O>::.J
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1

The WBLOCK
Command

You can insert a drawing file
onto your current drawing at any
time.
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Once the block or drawing has been inserted into the file, it is referred to as the block
instance. The original still exists in memory, but a copy ofit has been put in the current
drawing. This is similar to a rubber stamp and the stamp impression.

Any file on disk can be inserted onto the current drawing. All layers, dimension styles
and text files associated with this block will also be copied to the receiving file.

Blocks created with the BLOCK command exist within the drawing and cannot be
accessed except within the base drawing. This is why they are referred to as internal

blocks.

The WBLOCK command creates a separate file with the extension .dwg from a portion
ofyour current drawing. For example, ifyou have drawn the steno chair from Figure
10.2 on the desk layout and then want to copy it onto another layout use WBLOCK.

WBLOCK should not be blocked with BLOCK first.

WBLOCK is used when you want to take only a portion ofan existing file and use it on
another file. Because the wblocks exist outside of the current file, they are referred to
as external blocks.

An example ofWBLOCK use is the ex­
traction of a North arrow from one
drawing for use on another drawing, as
seen in Figure 10.4.

To start, you must open the file that con­
tains the information that you would
like to export as a block. Then access the
WBLOCK command through the com­
mand line.

Figure 10.4

Command:-WBLOCK

Enter name of existing block or [=(Block=olltput

file)/*(whole

drawing)] <define new drawing>:~ (you will be taken to a

file menu)

Block name (or ?) :A:NORTH

Specify insertion base point: (pick 1)

Select objects: (pick 2)
Specify opposite corner: (pick 3)
Select obj ects : .,-.1

Once you have chosen the WBLOCK command, the Create Drawing File dialog box
will be invoked. Enter the name of the file in the File Name box.

When you press.J, the dialog box will disappear and the command will continue.

When you are identifying the file name, be sure to type in the drive or directory as well.
Ifnot, the WBLOCK will go onto the default directory, and no-one will know how to get
back to it.

To place this file on another drawing, open the new drawing and use -INSERT or the In­
sert dialog box.

The North arrow will be inserted as a block. As in a regular insert, all layers, dimension
styles and text files associated with this block will also be copied to the receiving file.
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Figure 10.6

-1 1.4000 t-

o

Copy/Paste Another way to transfer graphics and data from one file to another is with copy and
paste. Copy is an editing function that is global throughout most computer applica­
tions. It is found under the Edit pull-down menu, as seen in Figure 10.5. The COpy
command in AutoCAD is found under the Modify menu. They are not the same com­
mand.

CTRL+V

CTRL+SHIFT+V

Del

CTRL+A

Figure 10.5

In Figure 10.5 the Copy with Base Point command from the Edit menu is being used.
This is a standard computer command for copying text, graphics, or indeed anything at
all from one screen to another. Copy with Base Point is used so that you can align the
data with the receiving file. Once the data have been copied, switch to the receiving
file and insert it with Paste.

The function Copy with Base Point does not work the
same way as the WBLOCI( command. In WBLOCK the
data are taken as a closed unit. None ofthe infonnation
within the block is affected by the parameters ofthe re­
ceiving file.

InFigure 10.6 a dimension has been placed on the steno
chair to be copied along with the file to show the differ­
ence between the WBLOCK command and the copy
paste function.

Figure 10.7 shows two steno chairs. Both have been taken from the first file and placed
into a second fil e.

-1 1.4000 r ~ 1//o ' ),) 0
WBLOCK

Figure 10.7 a

COPY/PASTE
b

In Figure 10.7a the chair was first blocked using WBLOCK and thus there is a separate
file called Steno in the directory. The dimension, in the layerDIM and set up according
to a dimension style called Furniture, was blocked along with the graphics. When in­
serted into the receiving file, the dimension shows up exactly as it was in the original.

Figure IO.7b shows a chair and dimension that have been placed with Copy/ Paste. In
the receiving file there was a layer called DIM and a dimension styIe called Furniture.
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The MINSERT
Command

Editing Blocks

The dimension with the CopylPaste chair is updated to the receiving file's parameters.
It is not a block, there is no file on the directory, all objects are individual.

Inserting Existing Drawings as Blocks

The origin or 0,0 ofthe drawing is the default base point for drawings inserted into the
current drawing. To change the default, open the original drawing and use BASE to
specify a different insertion base point. AutoCAD uses the new base point the next
time the drawing is inserted.

MINSERT is used to insert multiple block instances
of a block in a rectangular array. The command

melds the INSERT command with the ARRAY
cOlnmand. If used properly, this can be a very
useful command. It is only accessed through the
command line.

Command:MINSERT

Enter block name or [?]<STENO>:~

Specify insertion point or Figure 10.8

[Scale/X/Y/Z/Rotate/PScale/PX/
PY/PZ/PRotate] : (pick 1)

Enter X scale factor, specify

opposite corner, or [Corner/XYZ]:~

Y scale factor <use X scale factor>:~

Specify rotation angle <0>:90

Enter number of rows (----)<1>:3

Enter number of columns ( ):6

Enter distance between rows
Or specify unit cell (---) :4'

Specify distance between columns:5'

Minserted blocks like those shown in Figure 10.8 cannot be individually edited or ex­
ploded. If you erase one, you erase them all.

Once a block has been placed in a file, it is edited as a single entity. An entity select
pick will pick the whole block. Ifyou pick up one object on the block, the whole block
will be selected. If you erase a block, only one pick point is needed to identitY the
block. Move the block back to its original position using U.J.

Ifyou want to edit or change the block once it has been inserted, you will need to return
the block to its original objects. The EXPLODE command is used for this purpose.

The EXPLODE Command

The EXPLODE command reduces an object to its original entities. A block can be ex­
ploded into its original parts, a polyline or polygon canbe exploded into line or arc seg­
ments, and a dimension can be exploded into lines, arrowheads, and text.
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The command line equivalent is EXPLODE.

..
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Title blocks are usually saved with only the general information such as scale, date,
etc., and not the information regarding the specific drawing. If you would like to
change any of the information already on the drawing, use EXPLODE then DDEDIT.

Updating Blocks

There can be only one definition of a block under each specific name within a file.
Should you change or update the original block, the new block instances will be the
new block and the old block instances will update. This can be very useful, and very
troublesome.

Figure 10.9 shows four desk units and four stenochairs. These were inserted as inter­
nal blocks making them easier to Inanipulate. The client wants a chair with arm rests
on one desk, so the block is exploded.

Command:EXPLODE

Select objects: (pick the block instance 1 Figure 10.9)

The block of the chair will now revert back to the original lines and arcs.

Figure 10.9 Figure 10.10 Figure 10.11

Blocks, Wblocks,
Color, and

Layers

Figure 10.10 shows arm rests being added.

In Figure 10.11 the chair is blocked again using the original name. Because this is the
typed-in version, the original chair disappears. The other chairs have been updated
with arms.

Command:-BLOCK
Enter block name or [?] :STENO

Block STENO already exists. Redefine it?<N>:Y

Insertion base point:MID of (pick 1)

Select objects: (pick the objects)

You may have noticed that the default layer is 0, and that this layer cannot be renamed
or deleted. Layer 0, the universal layer, cannot be changed because it is used
extensively with regard to ByBlock and ByLayer settings for color and linetype. The
layers blocks sit on and the color of the block can be set either by layer or by block.

Once you have created a number of blocks or wblocks, file management becomes
more difficult because you must remember the directory and the layers used.

If items are created on a layer other than 0 in a wblock, these new layers will be added
to the list of layers in tht~ current file when the wblock file is inserted.

All objects on layer 0 will be automatically placed on the current layer ofthe drawing
on screen, and will assume the current layer color and linetype when the block is in­
serted. These are not necessarily added by layer. If color or linetype are not set by ­
layer, the current setting overrides the layer setting. To check to see what the current
settings are type in STATUS.
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Ifyou want a particular wblock to always have a specific layer, linetype, and color, as­
sign it explicitly; do not leave it on layer O.

When in doubt, use 0,0 as the insertion point. Ifall ofthe files are created at a 1: 1 scale,
the data will always fit.

The BURST Command

The BURST command works like the EXPLODE command, but it allows attributes to re­
main as "values" instead of "tags". BURST is not available in all versions of Release
2006.

Removing Unwanted Blocks with the PURGE Command

Each time a block or drawing file (wblock) is in­
serted into a file, a copy of it is placed in the draw­
ing memory or default area. If you want to clean
your file, you must PURGE the blocks. The
PURGE command will erase all unused blocks,
layers, text styles, linetypes, etc. from a file. Any
blocks, layers, etc. that have been brought into the
file but never used can be purged. It erases the in­
formation from the file defaults and settings.

When a drawing file or wblock is inserted, then
erased, the copy of the wblock remains in the
memory in case it is needed again. The original
file must be purged in order to accept a new file.
PURGE removes unused named references, such
as unused blocks or layers from the database.

Command: PURGE
Enter type of unused objects to purge

[Blocks/Dimstyles/LAyers/LTypes/PLotstyles/SHapes/textSTyl

es/Mlinestyles/All] :A
Enter names to purge <*>:

The AutoCAD Design Center

AutoCAD has an extensive database ofsaved
blocks for your use saved in the ADCENTER.
Use ADCENTER or Ctrl2 to access the design
center. Under the Folders tab you will find a
variety of categories for saved blocks.

Pick the category that you would like to
choose from, then pick the block that you
need. Each block has a logical insertion base
point. They are all drawn to a 1: 1 scale.

Some of these blocks are dynamic blocks.

Figure 10.12

Dynamic Blocks

Autodesk has provided seven new software upgrades for AutoCAD since 2000. In
2006, the big feature was dynamic blocks. For those who need such things, dynamic
blocks provide flexible blocks that can be placed within drawings. There are tutorials
on how to make and use these blocks under the Block Edit icon. Essentially they allow
you to create a door, window, bolt, etc. that can be sized dynamically when placed on a
drawing.
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specify opposite corner, or

[Scale/X/Y/Z/Rotate/Pscale/PX/PY/

Command:-INSERT

Enter block name:chair

Specify insertion point or

PZ/PRotate] : (pick )

Enter X scale factor,

If you use the command line, the
chair will disappear from the
screen. Re-insert it.
Now draw a table 1800mm by
1250mm and insert the chairs
around it.

The command line equivalent is -BLOCK.

Command:-BLOCK

Enter block name or [?] : chair

Specify insertion base

point:O,O

Select objects: (pick the chair and dimensions)
Select objects:.J

Make layer 0current, then use BLOCK to create
a block of this data.

Make sure the center of the bottom left circle is
at 0,0 - the origin.

Create a dimension styIe called Furniture. Set
it to an overall scale of 10 under the Fit tab and
two decimal places of accuracy under the Pri­
mary Units tab.

Dimension the part on the Dims layer.

Draw in the chair as shown on the Objects layer.

In this tutorial we will draw a standard chair, block it, insert it, insert a title block onto
it, and then see the difference between this and Copy/Paste.

Use STARTUP or acadiso.dwt to start a metric
drawing. Create a layer called Dims and another
called Objects.

Step]

Step 2

Step 3

The insertion base
point is REALLY
important!

[Corner/XYZ] :-1

Y scale factor <use X scale factor>:-I

Specify rotation angle <O>:90.J

You can use MIRROR and ROTATE to place the
chairs. Notice that the chair on the left has the dimen­
sions in backwards - it was inserted with a 180- de­
gree rotation. The bottom two chairs were mirrored.

Freeze the Dims layer.

Blocks and Wblocks 189
More free ebooks  :  http://fast-file.blogspot.com



Step 4 Save the file as Dining room.

StepS Open a new file in metric units. Create the title block below and name the file
ChaplOtitle. (Draw the lines and the text of the title block, but do not dimension it.)

m

The outside line represents the
outline of a 297 x 210 Inm pa­
per. The title block fits inside
it.

Save the file as Chap lOtitle.

-

I

- ~I I
1- ...... --.-- ..
~, ..- .-- F

D
When scaling, make sure that the scale is rea­
sonable; 1:10 or 1:20, not 1: 17. For this drawing
use 20.

Now go back to the chairs and INSERT the title block in. Make sure you have layer 0
current. If not, the title block will be placed in the current layer and will take on that
layer's properties. If layer Dims is current (now frozen), the title block will simply not
appear.

You will notice that the title block is much too
small.

The scale that you will print the file at on a 297 ~

by 210 sheet will be detennined by the scale that
you must use to expand the title to fit the draw­
ing.

Step 6

Step 7 The title block here is scaled by 20. This means
that when the title block is printed at its original
size, the table and chairs will be 1/20 of their
size or a scale of 1:20.

Scales are discussed in Chapter 1] .

Freeze the Dims layer. Copy one chair over to
the side away from the table setting.

---

0
II:~, "I"'" I......

ISCAIo r--

Step 8 Now explode the chair that is not at the table,
and add arms as shown.Then block the chair under the original name.

Command:EXPLODE

Select objects: (pick the chair) r 366---,
R2-4 I

2-4

Draw in the anns as shown.

Command:-BLOCK

Enter block name or [?] :Chair

Block Chair already exists. Redefine

it?<N>:Y

Insertion base point:CEN of (pick 1)

Select objects: (pick everything)
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Your chairs will now have updated to include the
anTIS.

This can be a very dangerous function. Always
backup your files every few hours in case you
really make a mess. Three copies is always best.

0 0

.-
1- ~ r-

R579Si!73

r
L~+--

We are now going to take a look at the difference betweenWBLOCK and Copy /Paste.

Zoom into the chair placed away from the table or
insert one away from your drawing. Thaw the R24 r 366i
Dims layer. EXPLODE the block. 24 ~---...:...

Make Dims current and add all the dimensions as
shown here. Make sure you use the Furniture di­
mension style.

Comma nd :WBLOCK
Enter name of existing block or [=(Block=output

file)/* (whole drawing)] <define new drawing>:TESTCHAIR

Block name (or ?):~

Specify insertion base point: (pick the 0,0 area)

Select objects: (pick all the objects show in Step 9)

Select objects:.J

Command:U"J

Make a text style called Label and set the font to
GothicE - (English Gothic). Add the text 0,0. Then
WBLOCK it. Use U.J to bring it back.

Step 9

If you WBlOCK an existi ng
block and use the same
name, it will be unusable.
AutoCAD will not be able to
find the file. Always explode
it or use another name.

U will bring back your data but maintain the wblocked file.

Step 10 Finally we are going to open a new file, INSERT one chair from the hard drive and
Copy/Paste another from the existing file. You will have two chairs on screen.

Open a new file in metric units. Make a Dimension style called Furniture. Set the Fit
size to 10. Under the Primary Units tab, have no decimal places underprecision. Under
the Alternate Units tab, tum on the Alternate Units. Make it current.

r 366---.,
R24 I
24~----':'"

+ O,OR73

46

R579

Make a text style called Label and set it to Gothic E.

INSERT the file Testchair.

Now go back to your Dining room file and under the Edit menu pick Copy. Select the
objects shown in Step 9.

Go to the new file and pick Paste from the Edit menu. See the difference? The dimen­
sions are updated to the current file with Copyl Paste, the text style is updated in both.

Remember: Afile is not a block until it is inserted into anotherfile. You do not need to
block a drawing to insert it into another file.
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Exercise 10 Practice
Use INSERT to compile a set of drawings as shown here.
Don't change the size of the floor plan or elevation, change the title block.
A third page could include details, Heating, Ventilating and Air Conditioning

(HVAC), a Section, or electrical plans.
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Exercise 10 Mechanical
Create the template, bushing and jiglegs as shown.
The BLOCK them and place them onto the part to make the assembly.

4.00

¢3.00

¢2,50

--3.00 -------I

0,50

f------- 6,00 ------------.

RO,25

¢O,50

¢0,60

¢O,60

¢O,90

~
;O'25¢O.22

/':.. ¢0,45,,:/
¢0,75

950.90

LOCK SCREW BUSHING

PRESS FIT BUSHING

¢O,30

¢0,45

Assembled Part

ASSEMBLY DRAWINGS
MACHINES AND MECHANICAL UNITS ARE

GENERALLY COMPOSED OF NUMEROUS

PARTS. A DRAWING THAT SHOWS ALL
OF THE PARTS ASSEMBLED IN THE
COMPLETED SHAPE IS CALLED AN
ASSEMBLY DRAWING.
AN ASSEMBLY DRAWING USUALLY

SHOWS EACH INDIVIDUAL COMPONENT
AS WELL AS ITS RELATION TO THE

COMPILED PART AS SHOWN ON PAGE

196. SOME ASSEMBLIES ARE COMPILED
UNITS IN THEMSELVES t BUT WHEN

FORMING PART OF ANOTHER ASSEMBLY t

THESE ARE CALLED SUB-ASSEMBLIES,
AS IN A DRIVE SHAFT IN A MOTOR.

ASSEMBLIES CAN ALSO BE FOUND IN

CABINETRY t FURNITURE, AND MODULAR

DESIGNS.

Blocks and Wblock 193
More free ebooks  :  http://fast-file.blogspot.com



Exercise 100 Architectural
This award winning building by Brian McKibbin illustrates the use
of sections and details in creating an elevation and construction drawings.
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Exercise 1Db Architectural
Use the section on page 194 to determine the height of this elevation.
The building is 10 meters wide. You would get this from the plans.
The windows would be on another drawing as well.
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ELEVATIONS ARE INTENDED TO GIVE AN IDEA OF WHAT THE

FINISHED BUILDING WILL LOOK LIKE. THERE ARE GENERALLY
VERY FEW DIMENSIONS. THE HEIGHTS ARE GIVEN IN THE
SECTION VIEWS. THE SIZE OF INDIVIDUAL PARTS OF THE
DESIGN, FOR EXAMPLE THE CORNICE, WOULD BE GIVEN IN
DETAIL DRAWINGS.
ELEVATIONS SHOW THE FINAL FINISH MATERIALS OF THE
BUILDING WHILE SECTIONS AND DETAILS SHOW THE
CONSTRUCTION.
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Set Up and Scale
for Simple 20

Drawings

Setting Up Drawings and
Plotting

..•.•. >~~l'1 C(;)ffil:>le'tiOrlQ'tth.is chapter, you should be able to:

single view

and UNETYPE sizes for any drawing

•. ···••••• ·~i.l.,lse bJ,)cks1(>c<::>mplle multi-view drawings

4..l.)ses,ection c,rrrovvs·c)nd break lines

·•····•• •.•·ii:'}.Ait:id rlofaticlOSbvifTmortmQ text
plotting drawings

fllc>tttle(jro'win~Q with plotters and PDFs.

So far we have been working on creating AutoCAD models and drawings as individual
sets of data. The geometry is entered relative to the origin (0,0).

All AutoCAD drawings should be entered at a scale of 1: 1 and then the drawing infor­
mation such as dimensions, notations, title blocks, etc., should be added according to
the scale for printing.

There are two ways of creating a scaled plot: with paper space and without paper
space. Paper space drawing is covered in Chapter 12.

To plot without paper space, draw the model at I: I, then insert the title block at an ap­
propriate scale factor and plot the file at a specific scale.

For example, ifyou have a layout for a house that is 40' x 30' drawn in real units at a scale
of 1:1, you want to have this plotted at 114'" = 1'- 0"'. As you can see from Chart 1 (page
198), 1/4'" = 1'- 0'" isl/48 of the original size.

In metric, a house that is 12 meters x 10 meters would be plotted at a scale of 1:50 or
1/50 of the original size.

Title Blocks

Your title block should be drawn at 1: 1 as well. It must also be large enough to contain
the floor plan. In this example it is set up for a 24 x3 6 sheet. In order to have this visible
at the correct scale on the layout, you can insert the title block at a scale of 48. Then,
when plotting the model, use a plot scale of 1/48 or 114" = 1'-0".

This is by far the best method ofplotting and scaling, as it allows you to maintain the
model at a scale factor of 1:1. For all of the information that requires scaling such as
overall scale in the dimension style, hatch, linetype, text size, etc., 48 can be used.

Title Block, Dimension, Hatch, and Linetype Scale

The ANSI standard for the text in dimensions is 3/16'" or 5 mm. This is also the default
for the dimension text in AutoCAD. This will need to be changed, however, ifyou are
plotting the part or view at a scale different to 1: 1. You want the part to be scaled, but
you still want your dimension text to show up at 3/16" on the paper.

To do this, you must determine the text size needed for each particular scale. Remem­
ber, by resetting the overall scale under the Fit tab of the Dimension Style dialog box
you can automatically change the size ofthe dimensions if they are not the correct size
for the plot ofyour drawing. The following is a chart ofsizes to be used in dimensions,
linetypes and hatches.
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Chart 1: Determining Scale for Drawings

FractionDecimal ValueScale Factor

Architectural or Imperial
_._-_._-_._---_.__._--_.__."._----~_. __..~----------_.--------

3" = 1'-0" 3:12 .25

1" = 1'-0" 1:12 .0833333

1/2"= 1'-0" .5:12 .0416666

114" = 1'-0" .25:12 .0208333

3116" = 1'-0" .1875: 12 .0156246

1/8" = 1'-0" .125: 12 .0104166

1116" = 1'-0" .0625: 12 .0052083

Mechanical

3/4" = 1" .75:1 .75

112" = 1" .50:1 .5

114" = 1" .25:1 .25

Metric

1: 10 .1

1:50 .02

1:100 .01

1:1000 .001

1/4

1/12

1/24

1/48

1/64

1/96

1/192

The first step is to determine the scale factor for the plot, and change the overall dimen­
sion scale factor under the Fit tab
of the Dimension Style dialog
box. Remember that it is not only
the dimension text but the arrow­
heads, overshoot, dimension text
gap and other variables that need
to be adjusted.

Always change the fit size not the
dimension text size.

On a simple drawing with only
one scale factor,. Chart 1 can be
used to detennine the plotting
scale factor and the block insertion
factor for title blocks and other
blocks.

For example, if you are creating a
plot or drawing that will be 3116"=
l'-0", draw the floor plan at a scale
of 1: 1. Add the dimensions at an
overall scale, under the Fit tab, of64. Add the hatch at a scale of64 (unless it is an ar­
chitectural hatch), then insert the title block at a scale of64. Finally, plot the drawing at
a scale of 1/64 or 3/16" = 1'-0". Chart 1 will help you to scale the model correctly. The
dimensions, text, hatch, and linetype must be scaled to fit the drawing.

198 CHAPTER ELEVEN
More free ebooks  :  http://fast-file.blogspot.com



Scaling the Text and Annotations

6'-()"

!lO'-o'

9'-0'

Figure 11.1

When creating text and dimensions, you must change the scale factors in order to see
them on the screen. This is even more of a difficulty when working with very large
drawings.

If, for example, you want to make sure the text
on a floor plan is at 118" on the final drawing,
you would need to find 1he relationship be­
tween 1/8" on the paper and the size of the text
on the floor plan. If 114" on the paper will be
equivalent to 12 inches on the model, then 118"
or half of that value will he 6"on the model. If
you create your notations and dimensions at 6",
as shown in Figure 11.1, the final drawing plot­
ted at 1/4" = 1'-0" will show text that is 1/8" in
height.

Text, dimensions, and related notations must be scaled to attain the appropriate size on
the paper. You can always tell a novice AutoCAD user by the size of their text.

Ifyou can read the text when you ZOOM
All, the text is too big.

!EL 31750

FLOOR
EL 32770

Figure 11.2

When creating metric drawings, use the
same formulas. For 3 mm text on the final
drawing, you will need to create the text at
300mm high in order for it to print at the
proper size when plotted at a scale of
1: 100. See Figure 11.2.

U/SIOE SASE PL
EL 33100

Chart 2 (see page 200) shows you at what sizes to scale your text to obtain the proper
size on the final drawing. Find the size that you want your text to be, then the scale you
intend to use, and make the text the suggested size.

If you take your final plot scale and multiply it by the default sizes and scale factors,
you will arrive at workable scales and heights.

LTSCALE and HATCH Scale

While working with views to be placed on a drawing, you must also consider hatch and
linetype. In creating these drawing aids for display on a screen, we determined that the
scale for these functions should be the furthest value ofX on your screen divided by 12.
This provided a working area that was visible on the screen and easy enough to work
with.

To place views onto a sheet ofpaperwith the linetype and hatch at the proper paper for­
mat, use the same setting that you would for dimension scale or final plot scale. Archi­
tectural hatches such as arcane and arroof are set to be viewed on floor plans, so ascale
of 4 can be used for a drawing to be plotted at 114" = 1'-0".

Using Blocks to
Compile

Drawings

For plotting different drawings at different scale factors, you can insert drawings as
blocks on a title block or another accepted drawing sheet. However, although this will

work, it is not recommended because any changes will have to be made in the original
file.

In Figure 11.3 there are two separate files inserted onto a drawing sheet that is 36" x

24".
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Chart 2: Dimension and Text Size

Plotted Text Size Scale Text on the Model SCALE

(Architectural or for Fit

Imperial) To plot drawing at. tab
~-~--~~--~_._~~--

1/8" 1/16"= 1~-O" 24" 192

1/8"= 1~-0" 12" 96

3/1 6"= 1~-0" 8" 64

1/4"= 1~_0" 6" 48

1/2"= 1~-o" 3" 24

1"= 1'-a" 1.5" 12

1/411 1/1 6"= 1'-0" 48" 192

1/8"= 1~_011 2411 96

3/1 6"= 1~-0" 16" 64

1/4"= 1~-0" 12" 48

1/2"= 1~-0" 6" 24

1"= 1'-0" 311 12

3/16" 1/ 16 11 = 1'-0" 36" 192

1/8"= 1'-0" 18t! 96

3/16"= 1'-0" 12'~ 64

1/4"= 1'-0" 8" 48

1/2"= 1~-0" 4,5" 24

1"= 1~_011 2.25" 12

Mechanical

.25" 1:20 .5 2,0

1:10 25.0 10.0

2:10 ,125 0,5

.125" 1:20 .25 2,0

1: 10 12.50 10,0

2:10 ,0625 0,5

.1875" 1:20 .375 2.0

1: 10 18,75 10,0

2:10 .09375 0.5

Metric

3mm 1:10 30 10

1:25 75 25

1:100 300 100

1:250 750 250

1:500 1500 500

1:1000 3000 1000
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F1reploee Detail
t" - t' o·

Figure 11.3

The drawing shown in Figure 11.3 consists of three separate stored files:

1, a title block at 36" x 24"

2, a fireplace detail at 16' vertically

3, a floor plan 35' x 30'.

Since the floor plan is the most important view and the one most likely to have changes
made, it is the base file. The other two files are inserted onto it. The title block was in­
serted onto the floor plan at a scale of 48. The drawing will be plotted at 1/48, so the ti­
tle will get back to its original size.The fireplace, being a detail, was inserted at a scale
factor of 4, four times its original size. It will be plotted at a scale of IN = 1'-0",

Command:-INSERT

Enter block name or [?] : Fireplace
Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/

PY/PZ/PRotate] : (pick a point)

Enter X scale factor, specify opposite corner, or

[Corner/XYZ] :4

Y scale factor <use X scale factor>:~

Specify rotation angle <O>:~

o

Ii 11
1-0.0-00-0----1

r Linear dimensions---------~

I Unit format:

'I' Precision

I

Fraction format:

DecimaJ separator:

I Round off:

I Prefix: II RO

I Suffix: I IrAn

Ir~::~=: >C~·-----I0-'2~5-00---1""""".1."1~!... U,

I
I mr1 . . I .• PrEl 6 Apply tolayouH:limensionsonfy !

!' "

Ifany dimensions need to be added
at this time, the fireplace is four
times its original size, so the Meas­
urement Scale factor under the Pri­
mary Units tab of the Dimension
Style dialog box will need to be
changed to .25.

If a drawing is to be plotted at
many different scale factors, cre­
ate different dimension styles for
each different size.

You can insert drawings at the
fractions noted in Chart 2 onto the
title block and plot at a scale of 1:1,
but this allows for no changes in
text or dimensions.
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View Titles and
Drawing-Related

Notations

Once you have created your drawings and are ready to plot, you will want to add the
[mal drawing-related information. Each view should have a title. If there are section
drawings, these sections must be noted on the plan, front or elevation view. Finally, if
you are showing details, the place where the detail attaches to the main portion of the
object lnust be shown with a break line.

Figure 11.5

Figure 11.4

ggl
'~'

R12.f/' .... ."JIOX1lRJ

• llIBlJIII8fW:I!.

~
IlE _ 211l1l.E11 rt

12... \~( J­
. . j .
~1l2~ a"

Section views are for all types of drawings, and these
show a vertical or horizontal slice through the object to
show how it fits together and what is used in the construc­
tion or manufacture of the object in question.

In Figure 11.5, the view title indicates where the object is
cut, in this case through the hinged shelf (page 177).

When the title for the section view is not sufficient to de­
scribe where the section is taken from, a section line is
used.

The same orientations are used in civil and architec­
tural applications, but the views are labeled differ­
ently.

The Top view becomes a Plan or Floor Plan, the Front
view becomes an Elevation, and the Side is also an Eleva­
tion. These are labeled North Elevation, West Elevation,
etc. for those buildings where the designer has actually
taken the trouble to orient the building on the lot. Other­
wise they are called Front Elevation, etc.

In applications with orthographic projection, as
shown in Figure 11.4 (from page 138), the views are
lined up and the titles are directly beneath each view.

This is fairly straightforward in a simple part like this,
but there are times when the parts are difficult to dis­
tinguish if they are not properly labeled.

View Titles

View titles are always shown below the view. These
can be slightly to the left or the right, but never above.

111100.0

022.0

11139.0

Wheel

Figure 11.6

Section 'A-A'

Section Lines

Section lines are used to show where a cut
goes through an object. Figure 11.6 shows
a simple mechanical part cut through to
show where the section is. A more compli­
cated mechanical part with several section
lines is shown on page 238.

In civil and architectural applications, sec­
tion lines are most often shown on floor
plans. The section is often jagged so that
the section of the building (page 1] 7) is
taken through all the 'difficult' parts, or the
parts where the builder may want more
clarification. Note the section lines on the
floor plans on page 192. The section in ar­
chitectural drawings is often used to find
the height of objects on the elevation since
these are not generally added to the eleva­
tion views. To see how this works, look at
pages 194 and 195.

Section lines are made with PUNEs at varying widths (page 91).
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Break Lines

Break lines are used at the edge ofobjects to show that there is some material extend­
ing beyond what is being shown. In Figure 11.7a the stone at the top ofthe fireplace ex­
tends beyond the detail up to the roofline.

NTSo

.1
3/4

'-----d---ir----r-----',

PEDIT

PLINE AND

R1I2

I

I
I

----\t---v-
I
I
i,_...J

I
IL _

Q b
Figure 11.7

Break lines are also used to show that the full length ofan object is not being shown, as
in Figure 11.7b. Here the foundation ofthe building, under ground, is a full 8', but only
a portion is shown. Both of these applications are lised in every discipline.

In mechanical applications, the break shown in Figure 11.7c is typical because it illus­
trates that the object being broken is cylindrical.

Importing
Notations

Often you have notations on drawings that are standard or typical of many drawings
such as manufacturing requirements, notations concerning adherence to building code
or national code requirements, or materials requirements. If this is the case, you can

type these up in a word processor and import them onto your file using MTEXT.

le~n about MTEXT

.. . i ~ show Toolbar

. ... . ! ~ Show Options
~ Show Ruler

Figure 11.9

To test this out, type up a few sen­
tences in Wordpad or Notepad.
Open either ofthese programs under
the Programs area of the start menu
on your computer.

Save the data as a .txt file or simple
ASCII text file format, as shown in
Figure 11.8. Make sure you are
aware of what directory the text is
being saved to. If you have a flash
drive or floppy disk, that is the best
place to put it. The extension will be
.txt. The .rtf (rich text format) files
work as well. Figure 11.8

Invoke MTEXT or multiline text,
pick the location for your nota­
tion, and then right-click to get
the Import Text function, as
shown in Figure 11.9.

Find the directory that contains
your .txt file, and bring the file
onto the current drawing.The
text will be imported onto your
file where required. You can
change the size and font once it
is in by highlighting it and ad­
j listing the properties on the
MTEXTmenu.
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Using
Lineweights

To have a professional-looking plot, you must have different line weights for each
type of information. The object lines will be the darkest. The dimension lines will be
lighter, and the hatch lines should be lighter still. The lineweights ofyour objects are
best set up within the Layer Properties Manager.

Lineweights and the Layer Properties Manager

You will want to spend some time finding out what lineweights work best with your
plotter. Do a few test runs to make sure the settings are correct, then make note ofthem.
Each plotter will plot at a slightly different scale.

• white CON_OUS~- Default
• white CON_OlJS ~- O.13mm
• white CON.GUS~- 009mm
III m.ta CON.GLlS -- Defau.:ll

~~ Q ~. wMe CON_OLlS -- DefaIljI
~ Q Jlh Cl 9-" CON ..GUS -- Defaull
;; 0 tID. white CON.GUS --~._- 013mm

Plotting

I

IDo not leave the plotting of your
idrawing to the day it is due. Any
Isystem will have difficulty printing
'the first time. You need to know the
final plotter destination and have
the necessary driver before you can
even start to plot. Practice some
plots first.
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Before you plot, in the Layer Properties Manager, set all your layers that you want to
print to black. The Defpoints layer, which appears automatically with dimensioning,
will not print. The other layers used for page set up you can toggle to unprintable as
shown on the right above.

Leave the object lines and text as default or increase them to .3, as in the examples in
this book. Change the lineweight ofyour dimensions and hatches to be much smaller.
Try 0.13 for dimensions and 0.09 for hatch. By making a .pdfof the page you can test
these lineweights out before sending them to paper (see page 206).

Plotting is only easy after you've done it a few times. Ifyour text sizes, notations, and
lineweights are all good, you should get a good plot.

There are three main ways to plot: directly to a plotter or printer, plotting to a .plt file,
then taking this .pltto a plotter, or printing to a .pdffile, which can then be sent over the
Internet. The way you plot will depend on how your system is set up.

Plotting Directly to a Plotter

Ifyour printer or plotter is hooked up directly to your computer and working properly,
you should have no trouble printing. Simply pick the PLOT command from the File
menu or type in the word PLOT.

Comrnand : PLOT

Ifyou are working with an older version ofAutoCAD, the command listed under the
File menu may be Print. It changes every few versions. Both Print and Plot do the same
thing.

Once you have accessed the PLOT command, you will get the Plot menu. The title on
this dialog box will say Plot-Model unless you are in paper space (see Chapter 12).
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( ..prev.iew.., 1

If your page is smaller than
this, choose the expand arrow
in the lower right corner.

]

Ifyou want to accept all of the defaults, press OK and your plot, ifthe plotter is set up,
will be produced. The system defaults to printing the display from the screen. Ifyour
system is set up to a laser or inkjet printer, then you should be able to simply pick up
your print. Should you wish to change any of the defaults or print to another plotter,
another size, or another area ofthe screen, pick the related button. Always Preview be­
fore printing.

Printer/Plotter Selection

The PrinterlPlotter tab lets you direct your plot to a series ofplot devices. The one you
are set up to should plot directly. It also allows you to have the plot written to a file as
opposed to being sent straight to the plotter. The file types are .pIt, which will allow
you to take this to another printer and get a hardcopy, or .pdf, which is a portable docu­
ment file for Internet use.

Use the down arrow beside the Printer/plotter name to choose a plotter. If the one you
want to use is not configured, you need to add it to the list.

Configuring a New Plotter

If the plotter you need is not on the list provided,
use the CONFIG command to load a new one. At
the command prompt, type in CONFIG, or go to
the Tools menu and choose Options at the bot­
tom of the list.

Add-A-Plotter Wizard
Shortcut
1 KB

Command: PLOT

Then choose Add or Configure a Plotter, as in
Figure 11.10.

You will get a choice ofplotting options. Choose
the Add-A-Plotter Wizard.

Choose the plotter you want from the many listed
(Figure 11.11) and work your way through all the
dialog boxes. If the plotter you need is not there,
you can generally get the plot driver from the
Internet.

Figure 11.10

:~~~-5i;pT;:l~s~rPl;;t'~~~rp~bii~hT

Defau~ plot settings for new drawings

e Use as default output deyice

!'* \\FE·WIGNALG·01 \HP LaserJel 6P

o Use last successful plot settings

Figure 11.11
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Once the plotter driver is loaded, go back to the Plot menu and change the
Printer/plotter to the one you have just loaded.

Plot to File

Plot to File will create a .plt file for transfer either into a word processing file using a
HP driver or to a plotter not connected to your machine. Always take a copy of your
drawing file with you if you are plotting off-site in case there are errors.

Paper Size
The paper size can only be changed once the plot device has been chosen. Ifyou have a
laser printer as your plot device, you can only get a small paper size. Change to another
plotter to get a larger size of paper.

Plot Area

The system is set to Display. Window gives you more control. Choose the window,
then Preview.

Plot Preview

This will give you an idea ofhow big your plot is, and how it fits on paper. Use either
the Full Preview or the Partial Preview before you spend the time or money on a paper
plot. Always preview your plot before clicking OK.

Plot Scale

The drawing will be set in terms ofplotted inches = drawing inches or plotted milli­
metres =: drawing units. Use Fit only when the actual scale of the drawing is not
needed.

Use Chart 1 to determine the plot scale. For a drawing at 1I4u
= 1/-0", make the scale

1/48. To make a drawing that is 1:50, use a scale of .02. Always preview before you
plot.

The plot origin is always assumed to be the bottom left comer ofthe paper. Ifyou want
to relocate the origin ofthe plot to another portion ofthe paper, reset this parameter by
changing the X and Yvalues in the edit box. This is usually done to place a title block
onto an existing drawing or to place a missing view onto an otherwise cOlnpleted
drawing. Some skill is needed here, so try placing the view or plot onto a test sheet bef­
ore placing it on the final papere, especially if there are drawings on the paper that
could be ruined.

PDFs

PDF files (Portable Document Files by Adobe) are a quick and easy way to both check
the lineweights and quality ofyour plots prior to printing, and send plots over the inter­
net.

In Releases 2007 and 2008 AutoCAD has added a built- in PDF driver. Configure this
driver using AutoCAD e-PLOT under the Add-a-Plotter wizard Manufacturer's list,
then from the Models list choose PDF.

In Release 2006 and earlier, try the PDF995 software available on the internet.
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In this example we will take a tloorplan ofa house, copy a window, and plot so that the
floor plan is at a scale of 118" = 1'-0" and the window is at a scale of 114"=1'-0".

Step] Retrieve the file for Tutorial 3b.

Ifyou haven't got it, quickly draw it up. It isOnlY/, I I

about 20 commands, see page 61.
~

~r---50__' ?Once in, draw a line from the MIDpoint ofthe central
window to the right 50'. ARRAY this window unit
around the central spot. This will make anice second
story or well-lit tower.

Now just add some lines to place walls between
these windows, and a small opening for a staircase.

Make sure all of your lines are on Layer O.

SCALE it by 2.

The Inain obj ect that you are concentrating
on is the floor plan. The window is a detail
added to it.

COpy the window unit on the right over to
the right.

Step 2

~ 15'-6' ~

Step 3 First dimension the floor plan. Make a
new style called Eighth for 1/8"= 1'- 0".
Set the Overall scale to 96. Just add a few
overall dimensions (the dimensions in this
image are larger than on your drawing).

44'-6'

Make sure you put the dimensions on a sepa­
rate layer.

Now we are going to add some dimen­
sions on the detail view. The view has
been scaled by 2, so you want the Meas­
urement scale to be .5.

Measurement scale

Scale factor:

o Appl,y to layout dimensions only

Make a new dimension layer called
Quarter, and change the measurement scale to .5.
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l) 13mm

!0n IFree~e ILockl Color ~ tLinetype iUneweight
t11J • white Corttinoous Default

• 'l.'lhite Continuous Defawt

•
When you are setting up your layers,
change the lineweight of the Dims layer to
0.13.

Notice that your dimensions for the detail
show up at the same size as your other di­
mensions' but the readout reflects the
changed measurement size.

Step 4 Ifyou have an 8.5 x I] title block, use it. Ifnot,just make a simple title block 10.75
x8.25 in size. INSERT it onto the drawing at a scale of 96.

~ Insert 11J[~

Name: ~felabtjtle

Path:

.~ .Ij [..Browse... DO

r OK I r Cancel l ( Help

Insertion poinl

l.EJ Specify On·screen

Scale

o Specil9 Olrscreen

X: l 96 I
~--~

Y: lS6 r

2 ISS I
~ Uniform Scale

Rotetion

.'·0.Specify OO'"screen

Angle:!'---0 _

Block Unit

Unit; ~~

Faclor: .L....11__~

StepS
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The views fit well within the title block. If
they don't, you have the imperial/metric
problem. Ifyou have started in metric, all
the numbers will be wrong, regardless of
the fact that you may have changed your
units.

Scale the title block by metric numbers ­
25.4, 2.54, etc. and it should eventually
fit.

Look on Chart 2 for the size of text that
you want for your titles. Since you will be
plotting at a scale factor of 1/96, you will
want text that is 12" high to show up as
118" on the final drawing.

The title should be underlined. Under the
title should be the scale of the view:

Floor Plan

Scale 1/8" = 1'-0"
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Step 6 Plotting the Views

Use the default printer that is set to your machine. This will be plotted at a scale of 1/8"
= 1'-0". Set up the plot file as shown below. Using the option Window in the Plot area
section will allow you to pick which area you would like plotted.

Once everything is set up, be sure to use Preview to get a preliminary view ofthe plot.

Zoom Window

Zoom Original

At this point you may notice any errors in placement,
line quality, or size that have been overlooked in the
menu. Use the roller ball on your mouse to zoom into
the drawing and check out the lineweights.

If there are errors pick Exit to get back to the Plot
menu.

Ifthere are no errors pick Plot to continue with the plot.

IE~-~

I Plot
I---~--~=~~

I Pan

I" Zoom
i
!
I
1

If your plot works the firsttime,
consider yourself a genius.
Allow a few hours to get your
first plot. Get someone to help
you who has experience on
THAT plotter. If anyone else
uses it, you can assume that
the plotterwiJl be messed up.

The menu choice Plot to file can be used to make a .pIt file that can be taken to a plotter
for printing. Not every plotter accepts .pIt files, so unless you are certain that the plot­
ter will accept these files, making a .pdf is probably a better choice.
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In this example we will take a mechanical part and plot it at a scale of 1:40. The final
drawing will be plotted on a letter-size sheet (8 1/2" xlI" or 297 X 210).

Stepl Open a new file in metric using acadiso.dwt. Set up your layers as shown below. Don't
forget about the lineweight. Different plotters print at different weights. These li­
neweights are good for some printers. Others print well at a larger lineweight.

The standard is minimum 0.30 mm, with thicker lines at 0.60 mm. The plots in this
book are printed with objects and 0 layer at 0.30 mm. Try this, but if it' s too dark, set
up as shown below.

, ayer roper les anager

~~. ~ ~)( +J Currenlla)'er: DIMENSION

• white Cootinoous -- 1109 mm
• white HIDDEN -- 0.13 mm

HATCHF
HIDDEN

: Name : On; Freeze j Lockl Color l Linetype 1Lineweight
~ ··D-·······J~·-O . :l'tD -'·i~Wnjte· Cootinoous '-=:=-OefauJt ----.--

CENTRE "" a 1jt). white CENTER -- n.13 mID

DEFPOINTS ) 0 Jr:. 0 Y-.•w eootinoous -- Default

•

Status

Now draw up the obj ects below.

R20

101

Step 2 Make a new dimension style for these dimensions called Forty because it is being
plotted at a scale of 1:40. When you open the Dimension Style dialog box, if the basic
dimension style is Standard, you have started the drawing in imperial units.

The base style should be ISO-25.
~,~--....~.. ~ ~ ~ ~,-.

II] Create New Dimension Style W]~I

J

1 • .
Use for: !All dimenSions

New Style Name:!\....F_or..::.;t~~ _

SlarlWith: ~,_SO_'2_5 ----,-,,;,=;m

Ifyou are in the wrong units, open a
file in metric using acadiso.dwt.
You might need to SCALE the draw­
ing until the dimensions are correct.

Continue Cancel Help
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!Side

oth texl and
:1 thing 10

(' Scale fOI dimension features~.•_~.~ .. w.<._.<_. ~~"\

! E> Use overalf scale of: ~Il
:'~.:':':::.~.:~:~.::~:"=::: i 0 Scale dimensions to layout j

L .._~.__~ ._.~..__.~~.~~_.._.w.~-j

Many people set their text height, arrow­
head size, gap, overshoot, etc. If you
have a template file - a base file that al­
ways has your settings - this is a good
idea. It is difficult, however, to remem-

3S
ber to change all the settings each time,
so an overall scale is a lot simpler. The
graphic image will reflect what settings
you have.

Now change your Primary Units so there
are no decimal places.

Change the overall scale under the Fit tab
to 40.

Dimension the object as shown above.

210-3 UNC-2
485 DEEP

R92S

105/165 DIA
2 HOLES THRU

Note: Fillets Qnd
Rounds R20

RiOlO

R1170

101

Section A-A

Step 3 In mechanical applications, often the notations for threaded fasteners:screws, bolts,
etc., are not shown with a diameter. Instead they are shown with class notations.

For example, the top left thread is
shown in this diagram. The diame­
ter and depth ofthe fastener are thus
not needed in the drawing. This no­
tation says it all.

210 - 3 UNC - 2A

Update your drawing using the no­
tations above. The height ofthe text
should be 120. Then add:

~
NOHINAL DIAMETER

l
NUMBER OF THREADS PER CENTIMETER

~
THREAD FORM AND SERIES

CLASS OF FIT

.f;-A IS EXTERNAL. B IS INTERNAL
10-3 UN -21¥

485 DEEP'--DEPTH AND NUMBER OF HOLES

View titles

Section A-A using PLlNE and TEXT

Notations for both sets of 'holes', as shown

The notation for all fillets and rounds.

Erase the dimensions that are better shown in notation
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Step 4 Zoom into a small portion of your screen. Make a PLiNE rectangle 265 X 185 units

which will fit onto a 297 x 210 paper.

TITLE
MECHAN~CAL PART

DATE ~7/03/08
SCALE

~:40

PROJECT SECT~ON DRAWNBoB EDMONDS
NUMBER

M~

Zoom into the right COIner and cre­
ate the title block shown at the side.
The distance between the lines
should be 6 mm.

Now scale this block by 40. You
drew it at the size it will be when
plotted. Then you scaled it to fit the
image. The objects will be plotted at
a scale of 1:40.

Move the title block over so that it
fits the image.

".~es 105/165 DlA
194 2 HCIlES THRU

,a{J ",.' "'"" ~
Rounds R20

1=

IJ,,'.",

Step 5 If your linetypes don't show up hidden and centered, use LTSCALE to change the dis­
play. Just change it until it looks good.

Double check your layer lineweights as in Step 1.

Step 6 Set to the default printer, use a scale of 1:40 and a paper size ofA4, and you should be
fine. You may need to Window and Preview a few times to get the image properly on
the page.

~Plot Model t~l~]

Learn <wout Plotting

Plot style table (pen assignments:)

---~.. --_." '1
···IL-<_No_ne_> ~ ............;;~,M Add".

Plot .optioo$

Dplot in bad<.ground

~}Plot with plot ~Jf';S

o Plot st.emp 00

DSavechangesro.1aycut

Or~irIQ(ll'"lentation

OPortrJ!lit
o Landscape

OPlotUP~ide"down

Number of copies.

i 1 .•i&~.

~._JunitsoCenter the plotx. 1-13,65 Imm
• ,=l ..,.J

Name:

Plot offset (qrigin set to printable area)

Printerjplotter

·'~i••••!I-g"'''I·I••••-••••I(j!.I .Properties".

PlQtarea

Wnattopfot:

fw~~il

( Preview:." .1 Apply to layout 11· OK J( Cancel JI Help J.<i
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Exercise 11 Architectural
This illustrates four types of drawings made for commercial applications.
Use ARRAY for the curved text.
Print it out with differing lineweights on a letter sized or A4 sheet.
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Paper Space for 2
Dimensional Drawings

Paper Space

QI1Cjom,pJ~~tiQn¢lttrljslchc)pt~~r you should be able to:

••••...•,.</ .•.•••..••'••..••.•••••• < Y < •• ·.·,1·••• !..l:sepolPefcSf;:lcOCe to access Q paper environment

i< ••••••·•••••••·••.'•••/i<i:ii;;<:i2j, ~:~~iM~{'~'tt1'f.f~~~tup 0 drawing with four views on a standard title sheet

i:(( /.j•..•• j.jil .!•••~[.:~~!;~~~~~ ::;:dl~::lv~:i:.S:i~blle in selected viewports only
•••.••...•••• to layout a drawing.

So far you have been working in model space, the part ofAutoCasd that creates designs
or models. In Chapter 11 we discussed creating drawings in model space by adjusting
the title block size. In this chapter we will use paper space to create drawings. Paper
space is much easier to use when you are dealing with multiple views.

The most efficient way to compile a drawing that has details to be shown at different
scale factors is through paper space.

Essentially, paper space is a 2D document layout facility. Once the views are com­
pleted with all the dimensioning required, paper space takes these views and places
them on a 'paper' much like a cut-and-paste routine, so that they can be compiled as a
drawing.

Paper space makes use of the multiple viewport facility. Multiple viewports are used
to place the various views ofthe objects onto different portions ofpaper layout both in
3D and2D.

Figure 12.1
Model space Paper space

In Figure 12.1, the object on the left is in model space and the layout on the right is in
paper space. Both are filled with the same drawing. One has one view, the other has
three views at different scale factors and different dimension styles.

The image on the left is in a tiled space, the TILEMODE system variable is on. The im­
age on the right is in a non-tiled environment: the views can be anywhere.

Note that the view title and scale are always shown beneath the view in a drawing.

In paper space the crosshairs cover the screen. On the left in Figure 12.1 is a regular
DeS icon; on the right is the paper space icon.
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Accessing
Paper Space

Getting from model space to paper space is quite
simple. Pick Layoutl from the Layout tab, shown
in Figure 12.2, at the bottom of your graphics
screen. If this tab is not at the bottom of your
screen, type in the word TILEMODE and then enter
o(see bottom of page).

Figure 12.2

Once in paper space, right-click the Lay­
out! tab for the Page Setup Manager. This
will allow you to set up the page that you
are working with. Either make a new page
or accept the current layout.

Similar to the Dimension style and Text
style menus, it is always a good idea to set
up a new page so that you never lose the
defaults of the original page setup.

The next screen is the Page Setup dialog
box. It looks much like the Plot dialog
box. You must set your paper size before
you begin. If you do not, you will waste a
lot of time later adjusting the views.

First pick your plotting device from the Plot tab, then pick your paper size from the
Layout tab. Ifyou are trying to set up a drawing, and all you have loaded are laser print­
ers, you will need to get another plotter driver loaded before you can access any paper
bigger than 297 x 420 mm (11 x 17 imperial). In AutoCAD, at the command prompt,
type in CONFIG, then choose Load a Plotter to add a plotter.

OPorl:r,,1t

@L<W1ds<:ap<;

OPlotupsjde-dOfflt

0f'lotwithplot~

oPlot l'bPI.!I'IP/lCI.! l{,~t

OHItW PllPE,np~.eobjW$

prot <tyle t~bll' (pen "5s19nments)

~erJet 6P (missing) ~p

DDiSPlllY plot styles

I'Jo(';I;-Il!e

~Fittop~r

Window<

Plotter: DWF6 ePlot D\o\If ePfot • by Autodesk

Where; Flie

P1at.area

Whlll: to plot:

!WindoVl -in
Plot offset (Cl'igin Si1t t<:>prlntab!e area)

x: I0.00 I rom D Center the plot

Y: c~~J rrrn

"Printer/plotter

~: !!ar DWF6 ePlotpc3_~~_~.~.__.~_~'j Propertles

Your page will now have the correct size. Return to the paper space layout to compile
the various views in your drawing.

Setting up a paper space environment toggles the TILEMODE system variable to off.

You can access the paper space mode through the command TILEMODE as well as the
Layout tab. You will still need to set up your paper size in the Page Layout Manager.

Command:TILEMODE

Enter new value for TILEMODE <1>:0

Regenerating drawing.
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Floating Viewports or MVIEW

The MVIEW or Floating Viewports command is used to identify views that will be used
in paper space. The Page Setup Manager dialog box forces you to pick a paper size,
then fits whatever is currently on screen within a border on that paper. You can adjust
the size of the view using the comer grips, then add more views with MVIEW.

Figure 12.3

In Figure 12.3, the left screen has the model space object. The central screen has the
paper space views, two new ones have been added with MVIEW. The third screen
shows the three views in model space with some layers frozen in two of the views. To
add new views use MVIEW.

The command line equivalent is MVIEW.

The pull-down menu offers the same choices as the command line: 1 Viewport, 2
Viewports, Restore, etc. The border for the viewport will be in the current layer. Make
sure you have a new layer for the borders.

Once paper space has been accessed and the views have been made, you can toggle
between model space and paper space quite readily. The Layout tab means the system
variable TILEMODE is off, you can place your views anywhere, they don't need to be
placed like ceramic tiles, side by side. When you return to TILEMODE on, AutoCAD
restores the drawing as it was before paper space was entered.

When using the Floating Viewports or MVIEW command, you can create various con­
figurations of viewports and have different layers active in specific viewports.

Using Model Space and Paper Space

When the Layoutl tab is on, you are creating a drawing in pa- "j'~ Layout1 r
per space. The TILEMODE system variable is off. The model is
still accessible.

When the model tab is on you are working in model space. TI- ~.ij Model,(Layoutl/
LEMODE is on.This means eithera paper or non-paper environ-· -- -
ment.

When working in paper space (TILEMODE is off), each view can be accessed as if in
model space by using the MODEL/PAPER toggle.

In the Layout mode you can toggle from paper space to model space in order to access
your model for dimensioning. You can type in MSPACE or MS and PSPACE or PS, or
use the toggle switch.
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,····'l\VI•••••·tpAPER,···

Command:MS (toggles back to model space)

Command:PS (toggles back to paper space)

Scaling Views
Within a
Drawing

Paper space (PSPACE) only lets you access the paper view ofthe model. Model space
(MSPACE) lets you access the modeL These can both be used in the Layoutl tab.

When you use the ZOOM command in paper space, it affects the entire page or paper.
A ZOOM .5X will result in the paper with the views intact at half the size that it was
before.

When you use the ZOOM command in model space, the model or drawing within the
view will be affected. Be careful not to ZOOM the views in model space after you have
scaled them with ZOOM XP.

In model space you can PAN the objects within the viewports; in paper space the PAN
command will affect the view of your paper environment.

In model space the MOVE command will move the objects within the views. In paper
space the MOVE command will move the views relative to the other views.

Manipulating the Views

Any of the ModifY commands will work on the viewports in paper space in the same
way that they work on the objects in model space. You can use MOVE, COPY/
STRETCH, etc. to place the viewports where you want with the necessary infonnation.

In model space, the command ZOOM All causes you to lose any relation to the actual
scale of the part being designed; the image expands to fit the space provided. Use the

ZOOM "times paper space" XP option to set the drawing size relative to the paper.

Command:MS
Command: ZOOM
Specify corner of window, enter a scale factor (nX or nXP)

or [All/Center/Dynamic/ Object] <real time>:.5XP

220 CHAPTER TWELVE

If you are creating a standard page setup for use
with many objects of similar layout, this page
layout zoom factors can be saved with the layout.

In paper space you want the views to be scaled to a
relative size. Use the ZOOM XP option to scale the
object relative to the paper scale units.

While the ZOOM X option scales the object rela­
tive to its current size within the viewport, the
scale factor of XP gives you a zoom factor times
the paper scale or relative to the paper and also
relative to the actual part. Zoom XP scales can be
seen in Chart 12.1.

""b~!J ••••fPAfiR"'·'-

You can also scale with the Properties menu as
shown on the right.

Pick the Viewport border, then Modify, Proper­
ties. You must be in paper space to do this.
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Layers Within
Viewports

Chart 12.1

For a Scale of Use Size Relative to Actual

1:1 ZOOM lXP

1/2 =1 ZOOM .5XP 1/2

1:50 ZOOM .02XP 1/50

1/4 = 1 -0 ZOOM lj48XP 1/48 or ( % x 12)

The easiest way to control your layers is within the active viewport. Viewport­
dependent layers are only possible in a non-tiled environment, with the Layout tab

showing that you have TILE MODE off.

Both in the layer pull-down menu
shown on the left and the Layer
Properties Manager dialog box shown
below, you can set the layers to be
viewport dependent. Some layers are
visible in some viewports but not in all.

StalU$ _ i N<1lllle
~ {)

• BORDERS
~ CENTER
"'*" DEFPOINTS
J DIM1

"$' DIM2

-%iI UNES
OBJECTS

fOrti f)~~1 LockiColor J LineWPei lineweight: PIe<tStyle! PloI{CUllenl.VPI NewVPFre"~L2~
oJ Q If[) • ....nne CON_OUS - DefauJt (;>:_7' t1 Q.l

o fO. 'hMe CON_OUS - Default {;fu Q]
'#' Q "b. v-Me CENTER - Default 'i!J (2:1
j Q ~. wtme CON_GUS - DefaLilt (2.),~

~) Q "W. 'Nhi1e CON_GUS - Defawt ~ ,~.~.•.
Q • v.tlite CON_OUS - Default <,l·•

Q • wMe CON_nUS - Default
o • white CON_GUS - Deflrult

This allows you to have dimensions in different scale factors as well as notations and
geometry that are not visible in all views.

I~IIA

,~IA
Paper Space

Three viewports

Figure 12.4

Paper Space
Zoomed views

Model Space
Layers frozen in viewports

In Figure 12.4, the first view shows three viewports in paper space. In the middle view,
the two details have been zoomed with 2XP to be twice the size of the full part. The
third view shows the non-relevant layers frozen in the two detail views.

Once the layers are frozen, a new layer for dimensioning is added and the dimensions
are added to the various views. This dimension layer will then be frozen in the other two
views. Dimensions are added in model space because it is the actual size of the model
that is to be recorded with the dimensions.
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The VPLAYER
Command

VPLAYER is useful for manipulating many viewports. The Layer functions are easier for
just one or two viewports. You can set the visibility oflayers with the Layer dialog box

and the Layer pull-down menu or you can use the VPLAYER command for a large

number of views.

As with the Floating Viewports or MVIEW command, this command only shows up in
paper space.

The command line equivalent is VPLAYER.

Command:VPLAYER

Enter an option [?/Freeze/Thaw/Reset/Newfrz/VpvisdfltJ:

Where: ?

Freeze
Thaw

Newfrz

Reset

Vpvisdflt

lists the LAYERs that are frozen in any selected
viewport
freeze a LAYER or LAYERs in selected viewports
the reverse of freeze; turns on selected LAYERs in

selected viewports
creates a new LAYER that is frozen in all viewports,
and is primarily used for creating a LAYER to be viewed

only in one viewport ever.
the default display for layers created in the LAYER
command is thawed; with the Reset option, the layers
are returned to their original default setting
set a default visibility for any layer in any viewport.

Command:VPLAYER
Enter an option [Freeze/Thaw/Reset/Newfrz/Vpvisdflt]:F

Enter Layer names to freeze or select objects:DIMl (name of

the LAYER)

Enter an option [All/Select/Current]<Current>:S

Select objects: (here you can pick any number of viewports
by their frames)

Dimensioning in
Paper Space

Your final drawing, regard­
less ofthe scale factors ofthe
views, should have all text
and arrowheads the same
SIze.

In Figure 12.5 the dimension
arrow and text size are the
same in each of these views.
The part is shown in four dif­
ferent viewports with four
different scale factors. The
dimension text reads the
same dimension regardless
of the dimension scale
factor.

-1 6.00 r

~RI.22
SCALE .75

RI.22

SCALE I

Figure 12.5

~ 6.00 r-
IC:B~RI.ZZ

SCALE .5

--T-t-6.00

~RI.ZZ
SCALE .25
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To use different scales in different viewports on the same drawing, set the DIMSCALE
value to O.
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In the Modify Dimension
Style dialog box, set the over­
all scale in the Fit tab to O.

This paper space scale will
automatically cause all di­
mensions to be shown in the
default size regardless of the
scale of the view. A dimen­
sion scale or fit size of 0 is
useful if you are happy with
the defaults of the system, ie,
the size of text/arrows/gaps
and offshoots.

There are some cases where
another size of dimensioning
would give a better result. In
this case, always create a
new layer, then set the fit size
to be a fraction of the zoom
factor.

If Ihe:r. 1Sn' enough roOOl to place both teKt ood
"rrol"l~ inside eHleOSlon lin~, the fO.1 thing '0
move out-ide the eHtension lines j.:

, @ E~her lexl or alrows Ibest fill

:o Anows

'0 Tel!!

o Bolh lexl and "rrow~

.: 0 Alwa~ keep teHt between ext rnes

.0 Suppress alrows II they don't iii inside
exlemion lines

'-I~;.,;~~:-~""~=-~~ ... -
When text i3. nol in t~ default position, p!acel

Scale for dimension tl'!~blJlp.:<: . .

o Use overall scale of:

o Scale dimensions to layout

Scale ofview

~ = 1-0

1:100

ZoomXP

1I48XP

1/100

Fit

48

100

Dimensions can be adjusted to

40 - 48

90 - 110

Ifyour dimensions just do not look right, you can adjust the size of a custom dimen­
sion. Changing the zoom factor on a drawing to adjust the automatic paper space size
will not help. The scales for a drawing must be standard. A view scale of 1:46 or 1;4 =

1 -2 is just not going to work. Flexibility is only on the dimension scale factor.

You can use these, or you can set up your own
template file that also has layers and dimension
styles. Simply set it up and save it as Mytemplate.
Once the bugs are worked out, you can use it every
time you start a drawing.

AutoCAD's
Template

Drawings

AutoCAD has a series ofdrawing templates that
canbe used. These title blocks are set up in paper
space and will not interfere with your drawing as
you develop it. For a list of AutoCAD's

templates, use NEW as in Figure 12.6.
Command: NEW

The ANSI (American National Standards Insti­
tute) templates are imperial, the ISO (Interna­
tional Standards Organization) and JIS are
metric. All are professional layouts like the one
in Figure 12.7.

IIANSlB ..NameciPlot Stoyles.dwt
ilANSI.t: ~Color. i)epengenl:PJot..•.
IIal\NSIC~f\@J1leclPlotStyl~.gwt

AN$f.)~Color.Dep~nc1ent~Jot ••..
ilA.[\JS10~Nami::d.PlotStyles·dy.t

lE"ColorD~pen.ntPtot, ...
ANSIE -Narned Plot Styles.dwt

II·AN51~9Yout teropl.at~.dWt
AfchitecturalJEngfisb .units ..C•••
I?d'chite~turall.···EngJisb .·units ...N•..•

IIOIN Afl;'Color DeperlclentPfot. '.'
iiiDIN AO."Namegp.lot Sty1es.dwt
r::::I: ...... ~._,...:.' 4. .Jt- ~_ • _ '.' - ,f""\.; .. ....... ~J ....... ....., L r-.I _ L

Figure 12.6

Figure 12.7
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In this example we will take a floor plan ofa house that has a circular fireplace and a
kitchen, and we will create one drawing sheet with a plan view and the two details de­
scribed. Take your layout from Chapter 7, or use another floor plan. This drawing will
have three scales as follows:

Step]

Plan view ofhouse

Detail of fireplace

Detail of kitchen

Retrieving the File

1/4 = 1 -0

1 = 1 -0

1/2 = 1 -0

Final Drawing

[~

~
~-.c;,...

~
--'\r- §~~

Retrieve the floor plan file on which you want to create a drawing.

Ifyou would like to use an AutoCAD template, open a new file and choose Architec­
tural English Units. Then you won't need to draw a title block. Insert the floor plan or
CopylPaste into model space.

Now create the following layers:

Layer name
DIMI

DIM2

DIM3

BORDER

Pspace

Detail

Color
red

yellow

green

magenta

blue

cyan

!'\i&¥!}O Layout1 r

Step 2 Opening Paper Space

Make sure your BORDER layer
is current.

'l!:J Pdge Setup Setup1

224 CHAPTER TWELVE

Pick the Layout tab at the bottom
of your screen or use the T1­
LEMODE system variable.

Command:TILEMODE

Enter new value for

TILEMODE <1>:0
Regenerating drawing.

This will get you into a non-tiled
space. There will be a view of
your model on screen with a ma-
genta border.

Right-click the Layout tab to set the size ofyour paper. Make a new layout called Floor
plan.
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Step 3

Now you want to pick the plotter size that you need for this drawing. We are going to
use a 34 X 22 sheet.

Ifyour plotter options do not include a plotter this size, go back to AutoCAD and use
the CONFIG conunand plus Configure a Plotter Wizard to configure a Designjet or
similar plotter. Just accept all the defaults. The driver should come with AutoCAD.

Then right-click again on Layoutl. Setup your page as above, and be sure to make this
layout current on your way out.

Creating the Views

Now you can add your views relative to this paper with the command MVIEW.

First, in model space zoom the current view to a scale of 1to 48.

Command:Z

Specify corner of window, enter a scale factor (nX or nXP)

or (All/Center/Dynamic/ Object] <real time>:1/48xp

or in paper space pick the border and choose 1/4 =: I -0 in the properties menu.

You must be in paper space to use the Properties toolbar.

4

3 .--- ~

2

Now adjust the size of this viewport using the grips on the corners.

Go back to paper space lllode for this.

Pick up the frame on the comer and drag it into place.

Now add two more views with MVIEW.

Command:MVIEW

Specify corner of viewport or

[ON/OFF/Fit/Hideplot/Lock/Object/

Polygonal/Restore/2/3/4] : (pick 1)

Specify opposite corner: (pick 2)
Command: MVIEW

Specify corner of viewport or

[ON/OFF/Fit/Hideplot/Lock/Object/

Polygonal/Restore/2/3/4J : (pick 3)
Specify opposite corner: (pick 4)

Each new view added will have the full floor plan on it.
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Step 4 Zooming the Views

On the lower right view, toggle into model
space, then zoom into the views so that you get
approximately the fireplace view.

Then use ZOOM with the xp scale to zoom it to
1 =1 -0 This will be a zoom of 1/12XP.

Command: Zoom
Specify corner ... <real time>:1/12XP

Go back to paper space and move your screen so
that you can see the upper right view. Zoom into
the kitchen, then zoom it to a scale of lh = 1 -0 or
1I24XP.

Command: Zoom
Specify corner ... <real

time>:1/24XP

The ZOOM command is viewport dependent. You
must be in the view in model space to zoom the ob­
jects with ZOOM, and in paper space to use the
Properties menu.

rni'\

~
r

~[S~

StepS Dimensioning the Views

With your kitchen still on screen and zoomed at the correct view, go to the Dimension
Styles dialog box and create a new dim layer called Pspace.

() Ute ovelllll scale cI

>1~;d,;~~;;:,;;;;t:::'WW' ::::.,. :.. :::.:.:..."..".~<::: :.' €> Sqll; dimentlOflt rolayoiA

Toggle to paper space to zoom
into the view so that you can see
it properly.

Once you have the kitchen on
your screen return to model
space so that you can access the
information within the viewport
in order to dimension it.

Since this is a drawing done in imperial, make sure
that your primary units are set to imperial as well.

In model space, go to the Layer pull-down menu
and make DIM1 frozen in the current viewport.
Then make DIM3 current.

Use the linear dimension to dimension the room as
shown.

Under the Fit tab, change the
overall scale to O. This will size
all of the dimensions to the re­
spective views.

Set this dimension style to cur­
rent.
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v~~~D dim2 You can use either the Layer dialog box or the
Layer pull-down menu to freeze and thaw lay­
ers within individual viewports.

This must be done in model space.

Once it is completed, toggle to paper
space to pan the drawing over so that you
can access the fireplace.

Then toggle back to model space, make
the DIM 1 layer frozen in that viewport,
make DIM2 current, and dimension the
view as shown,

Now go back to paper space and zoom
the full paper. Notice that you must make

D.IM2 aynd DIM3 fro~ehn il1
h
the

L
floor pla11n ::I!

VIew. ou can use elt er t e ayer pu - ,
down menu with model space on, or the
VPLAYER command in paper space. .....0..- _

2/-6'"

Command:VPLAYER
Enter an option Freeze/Thaw/Reset/Newfrz/Vpvisdflt:F

Layer(s) to Freeze:DIM3,DIM2

All/Selected/<current>:S
Select objects: (pick the plan view)
Enter an option [Freeze/Thaw/Reset/Newfrz/Vpvisdflt:~

You may notice that the default dimension
size sometimes just doesn't work. The num­
bers look too large and clumsy for the layout

It is always useful to know how to create a
custom-scaled dimension layer for cases like
this.

Automatic dimension scaling is OK for
many applications, but in this case a dimen­
sion scale of 10 may be better than one of 12,
which is the default for this window zoom
factor.

Go to the Dimension Style dialog box. Cre­
ate a new dimension called fireplace. Set the
Fit factor for the overall size to 10, then make
it current.

Put one dimension on with the new size. If
you like it, use Match properties to update
the other dimensions.

You should never deflect more than a few units from the default size or the dimensions
wi1llook wrong, but sOluetimes a little 'tweeking' is the difference between a good
plot and a great one.

If, when you go to paper space and zoom the whole paper, you can read the dimen­
sions, they are too big.
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Step 6

Step 7

Adding the Notations

Your three views are ready to be la­
beled. In paper space, make your
pspace layer current.

Add the title for each view at a scale
of 1;4 lettering. The TEXT command is
easier here than MTEXT. The toggle
for underlining is %%U.

Remember that the view titles are al­
ways placed under the view.

In addition, when the borders are fro­
zen you will need break lines to show
that the wall continues past the bor­
ders of the frames. AutoCAD draw­
ings must maintain the same
protocols as manual drawings.

Placing the Title Block

~

~
~ ~ I'

il -Nf:§
....... I-l": z--00

c=~ 1
N tt'

fireplace Oetall
5alIe 1",,1'0"

The dimensioning layers are frozen within certain views and not others. In paper space
you want to do a global freeze on the border layer.

With your border layer frozen, you often
see that the layout could use a bit of mi­
nor adjustment to make it look better.

:~) CJ4®1i. 0
'5 .;~ :~fII r.~::;!i·~,:~"i;.·.·.·":.·.·.·.·.·:::":""::".·:":::::::: :...·:.·.·:...·.~·:.·:::: .....·.·.·.·..•I.11
':1 Freeze or thaw in ALL viewports

~iJ1jIl DIM'

Bring the borders back. Move them around ifnecessary, go into the views to tighten up
some ofthe dimensions, and move the view titles around so that there is room for a title
block.

Finally, if you have not used the AutoCAD architectural template, add a title block.
Your drawing is now ready to plot.

Use the PLOT command and plot to a scale factor of 1: 1.

x

~~---

l~lI-r~

I'!··.·~.3.~-.....>••.T.c."i __ .r..'.·<~..·.1--,~i /~

~

oo
ErJ

Drawing using custom title block
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Drawing using AutoCAD architectural template
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Step]

In this example we will draw two footings
and show how they are assembled on a
footing layout. The footing layout will be
at a scale of I:500. Footing A will be at a
scale of 1:50. Footing B will be at a scale
of 1:25.

Be sure to start in a metric drawing. aca­
diso.dwt.

This will be plotted at 297 210 in land­
scape orientation. We will add our own ti­
tle block.

First create the following layers

I

Draw the footings. Make the footprint (darker
lines) in the Footprint layer, and the other details
of each view in the Detail layer. Do not

dimension the footings yet.

Laver name
DIM!

DIM2

DIM3
Border

Footprint

Pspace

Detail

color
red

yellow

green
rnagE~nta

blue

blue

cyan

~
0

'"' .
~

lD
ru
0

0

'"<"l

g
t

I

230 1- -"'- I- 230
920

2000

Footing A

co
N

o
f-

Footing B is half the size of
footing A. Clearly COpy and

SCALE will make the drawing a
lot simpler.

The footings will be assembled
on a layout grid. On the detail
views you want to show the
outside dimension or footprint
of each footing (the darker
line) as well as the pin and up­
per level details.

o
o
o

2000
680

r 514 ~

I
•~ fl.

'<t :Jf .t

I

.3
u..~

w
z
::i

On drawings oflarge construc-
tion projects, the footings are Footing B

often laid out in bays or grids.
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Step 2 The Layout

On Layer DIMl draw in a
grid of eight vertical lines
spaced at 8000 units each
and five horizontal lines at
6500 units each.

Draw bubbles along the top
and side corresponding to
this grid. Put in the letters
and numbers shown.

[

I
I

Layout Grid

Use COpy to place the foot­
ings on the grid intersections.

Use the grid lines to place
the footings centered on the
grid lines. ARRAY will also
work.

Note that the footings are
centered on the grid lines
so the base point is quite
important

If you have not done so al­
ready, save the drawing at
this point.

Step 3

230 CHAPTER TWELVE

Layout grid with footings

Opening Paper Space

Make sure your Border layer is current.

Pick the Layoutl tab at the bottom of your screen or use the TILEMODE system vari­
able.

T~ Layout' [

Command:TILEMODE

Enter new value for TILEMODE <1>:0

Regenerating drawing.

f,;;J ~ ;] f,;;l r.;\ ;\ f,;J ~ ~ [,;]

r~ ~ ~ r~ ~p l~ r~ ~ ~ r~

[,1;] r.~ [,1;) r.~ f,iJ r.J ~ ~ r.J
C~ l'~ ~~ r~ r~ r ~ ~ ~ r~

L ~
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~Clrwne:

P/ott/j(:

Plotsi:l&,

wtw."

This will get you into a non-tiled space. There will be a view ofyour model on screen
with a magenta border. If the border is not magenta, you are not in the correct layer.
Make sure your frame or border is on
the Border layer.

Right-click the Layout1 tab to get to
the Page Setup Manager.

Make a New layout called Setup.

Now you want to pick the plotter size
that you need for this drawing. Weare
going to use an 8.5 x 11 sheet or 297
x 210 mm.

Set the plotter to the one you generally
use. Pick the paper size.

Make sure that the plotter will plot
from 1: 1. Then click OK and return to
the drawing.
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..................
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;
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.. ...... - ...........
..... . ....•••• >

i .. ··.·.·...t·.:
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.........

Layout ;1 . -.. : ....
.'...... .........

...... ..,
I n

.. ~ iTIi!m".
..

10.00 rfIl'I'l
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Step 4 Setting up the First Viewport

Now you can add your views relative to this paper using either the Floating Viewports
or the command MVIEW. First set up the existing viewport. In model space, ZOOM the
current view to a scale of 1 to 500.

Command:MS
Command:Z

Specify corner of window,
enter a scale factor (nX

or nXP)

or[All/Center/Dynamic/ ...

. ... . Object] <real

time>:1/500xp

This zooms the view to exactly 1I500th
or 1:500.
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L ----~

You must be in paper space for this.

Pick up the frame on the comer and
drag it into place.

There is no standard scale for this in
the Properties manager. Use the Prop­
erties toolbar to set up a custom size of
1-500 or use ZOOM.

-_.' - ---. - - - ~- -~ - - - "1

.. -_ _---_ _ .

1:'·-----------····-·----------·-------------------1---
:~'fIlI'rr~f~,.~

IV- - .

0- - : '!

: ,·~--·-~I
, !

.................~

i
I

Now adjust the size of this viewport I

using the grips on the comers. Pick the I

edge of the frame to highlight the :
grips, then pick the comer to stretch I

the frame smaller. . II
I
I

r-Gil
....-.,

(

1
'"

i

I

-----J

'---------'-~~ J

Command: Zoom
Specify corner ... <real

time>:1/50XP

Command: Zoom

Specify corner ... <real time>:1/25XP

Toggle into model space, then zoom into
the footing views so that they are approxi­
mately centered in the view.

Then use ZOOM with the XP scale or
Properties to zoom them. Footing A
should be at a scale of 1:50. Footing B
should be at a scale of 1:25.

Command:M for move

Then pick the view and move it.

Keep the view that is zoomed at 1:500 on
the bottom.

Zooming the Views

It is more practical to have the smaller views on
top, so move the views and stretch them until
they look like this.

Making New Views

Now add two more views with MVIEW.

Command:MVIEW
Specify corner of viewport or

[ON/OFF/Fit/Hideplot/Lock/Ob

ject/ polygonal/Restore

/ 2 /3/ 4] : (pick 1)

Specify opposite corner: (pick 2)

Command:MVIEW

Specify corner of viewport or

[ON/OFF/Fit/Hideplot/Lock/Obje

ct/ Polygonal/Restore

/2/3/4] : (pick 3)

Specify opposite corner: (pick 4)

Step 6

StepS
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Step 7

Step 8

The ZOOM command is viewport dependent. You must be in Inodel space to zoom the
objects using ZOOM, or in paper space to change the scale using the Properties menu
shown on the left.

Adding View Titles
So you don't forget what scale you have zoomed the views to, add the notations.

Make the Pspace layer current, then use the TEXT command. The underline toggle is
%%U. Make the title text height 2.5 mm for the title and 2 for the scale.

Command: text

Specify start point of text or [Justify/Style]: (pick a point

beneath the view)
Specify height<10.000>:2.5

Specify rotation angle of text<O>:~

Enter text: %%UFo()ting A.J

Command: text
Specify start point of text or [Justify/Style]:~

Specify height<10.000>:2

Specify rotation angle of text<O>:~

Enter text:%%UScale 1:50~

Add the titles and scales for Footing B (scale I :25) and the layout (scale 1:500).

Dimensioning the Views

Toggle to paper space to zoom to
the outside of your border so you
can see your footing well enough :ition,prace it:

to dimension it.

Go to the Create Dimension Style
dialog box and make a new
dimension layer called Pspace.

Under the Fit tab, choose Scale
dimensions to layout. This will
make all of the dimensions sized
to the respective views.

Choose OK to exit this dialog
box, and set current to have the
Pspace dimension style active.

9 both text and
first thing to
is:

lines

t inside o Use overall scale of:

@ Scale dimensions to layout

~ .0
v~~ fl. border
V(I~~. Defpoinls
V~@I~. details
\) ~ fJ fb. DIM1

V(i~fbD~••••••oG7J tJ ~ltJ dim3o(I ~lfbEJ footprint @§J
V~~ 'lJ. pspace

Toggle back to model space to access the in­
formation within the viewport in order to di­
mension it.

In model space, go to the Layer pull-down
menu and make DIM! frozen in the current
viewport. Then make DIM2 current.

Use linear dimension to dimension the part as
shown.

~
g
("l

•
0 ro0

~0
~

a
'oj)

~

0
0
("l

t

230 1- -.- r-- 230
920

2000

«)
('l

o
t-

N
w
z
:J
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Once it is completed, toggle back to pa­
per space to pan the drawing over so that
you can access Footing B.

Then toggle back to model space, make
the DIMl layer frozen in that viewport, g
make D1M3 current, and dimension the
view as shown.

2000
680

514

I
j

"o ~j I
~ ~, I ., I

Do the same for the layout view. Notice that you must make DIM2 and DIM3 frozen as
well. You can also freeze the Detail layer in this view.

You may also find that you need to freeze the Footprint layer to place the dimensions
properly. Once the dimensions are completed, thaw the Footprint layer.

You may notice that when the Footprint layer is turned back on, the default dimension
size just doesn't work. The numbers look too large and clumsy for the layout.

It is always useful to know how to create a custOln-scaled dimension layer for cases
like this. The automatic dimension scaling is OK for many applications, but in this
case a dimension scale of 450 is better than one of 500, which is the default for this
window zoom factor.

Go to the Dimension Style dialog box. Create a new dimension called Fullview.

Set the Fit factor for the overall size to 450, then make it current. Put one dimension on
with the new size. Ifyou like it, use Match properties to update the other dimensions.

;e both text and
~ first thing to
~ is:

t lines

fit inside

6349,38

@ Use overall scale of:

cD Scale dimensions to layout

234 CHAPTER TWELVE

It is a good idea atthis pointto go into each view andre-zoom at 1I500XP, lIS0XP, and
1/25XP just in case you have zoomed the views while dimensioning.
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Step 9

Thaw the Footprint layer if you
have frozen it.

The convention for a repetitive
dimension like that ofthe footing
bays is to put in one dimension F

and assume that the rest are the
same.

The footings must be labeled: A H

beside all A footings, and B be­
side all B footings.

Adding the Title Block

Your three views are n~ady, and
they are already labeled. Now all
you need to do is freeze the Border
layer and add a title block.

With your Border layer frozen, you
often see that the layout could use a
bit of minor adjustment to make it
look better.

Bring the borders back. Move
them around if necessary, go into
the views to tighten up some ofthe
dimensions, and move the view ti­
tles around so that there is room
for a title block.

Finally add a title block. Either
draw a new one or fill in the one
that you opened. Your drawing is
now ready to plot.

Use the PLOT command and plot
to a scale factor of 1: 1.

i'DOG

.wr~~

I I
f L

I ~I~

"1~ .

A A

fltXX ~~al

~1:!700

l

l
'--f- .

Ii: I!

"I~
f--

il

23lI -.- -~aooo

Assemb Drowin - Footi B A &: S
ASSOIBLY BUILDING

MAY '06 R er Ali B noted 82
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Exercise 12 Practice
Create the fireplace drawing, then open new viewports
in paper space to create the details.

6'8 8

A 2' x 4'-16' a.c.

A I

~Ievatictl
~cale 1/ 2" ~ 1'-0"

I 9' t

I l M <
~"

7
/ ,

( J
t 6'

Mt<::t"
-_._-

3. 3'l f-13 -1~(~

~
\11

Sl£ETl11F'l

Title I

Flreplo.ce

Column Detail
5cale III :- I' -0 I

Section A - A
5cale I/ 2" ~ I' -0' I

COl'lpa.ny

.A~ fJ/wJxvr.t HMTIiIb ~tytv

l'

Half Plan
~cale 1/211

"" 1'-0 '

Mantle Detail
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Exercise 12 Architectural
Use the drawings on pages 194 and 195 to compile this commercial
building in paper space. Use ISO A1 sheet size.

WORKING DRAWINGS

I:

~
~i~

UII

~l

WORKING DRAWINGS ARE COMPILED IN

SETS. THE FLOOR PLANS ARE USUALLY

ON THE TOP, THEN THE ELEVATIONS,

SECTIONS, DETAILS, MECHANICAL, AND

HVAC.
DRAWINGS ARE NUMBERED ON THE

BOTTOM RIGHT CORNER IN THE TITLE

BLOCK STARTING WITH AI, A2, ETC.

WHEN COMPLETED, THEY ARE SENT OUT

FOR ESTIMATING AND QUOTES.
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POINT, DIVIDE, MEASURE, and
Inquiry Commands

Qocompletion of this chapter, you should be able to:

1. Change PDMODE and PDSIZE
2,lJs~PtVI()EondMEASURE to place points and/or multiple obiects

where desired within a model

·3;Use··tneSBUNE· command

4.Ch¢ckfheporqrneters and properties of obiects within the model

O.Cnecktheo'leroll size ofthe model

6~Colculotethearea of a model with AREA or BOUNDARY
I. Use the SPLINE command.

Points, Point
Display and

Point Size
Options

Points are used in spline generation, in many 3D applications, and as node or reference
points which you can snap to or offset from, When you DIVIDE or MEASURE an obj ect,
points are used to show the divisions. You can set the style of the point and its size
either relative to the screen or in absolute units.

The command line equivalent is POINT.

The default point display is as shown on the icon, simply a one pixel point. In order to
make use of points along other objects it is necessary to change the point display.

!::ielp I"--.....OK ~ I Cancel II

In PDSIZE, a positive nmnber will represent the actual
size in drawing units ofthe point. A negative number is
taken as a relative percentage ofthe screen and a differ­
ence in the zoom factor will have no effect on the size of Point Size:

the point display.
G} SetSizeJielative to 5Cl.Elen

First choose whether you want the point to be relative to ()SetSizein8bsoJuteUnii$

the screen or in absolute values. AutoCAD stores the
point size in the PDSIZE systelll variable. All points will
be added relative to the new size, and all existing points
will be updated according to this size on the next regeneration.

Points, either created by MEASURE and DIVIDE or entered using the POINT command,
can be accessed with the OSNAP option NODE. This is particularly important when
entering blocks at specific points or, in 3D, when finding centers for fillets, etc.

Point Style

The Point Style dialog box is found under the format
menu or by typing in DDPTYPE.

To set the point size or style without using the dialog
box, use PDMODE for the style and PDSIZE for the size.
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Using DIVIDE
and MEASURE
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The points will then be added in at the points determined by either the DIVIDE or the
MEASURE command, as shown in Figure 13.1.

Ifyou have an object or space that needs to be cut into equal pieces or portions, you can
use DIVIDE or MEASURE.

DIVIDE will visually divide any linear element- an arc, a circle, a line, or a pline - into
a specified number of equal parts.

MEASURE will visually measure a linear element into segments ofa specified length.

The DNIDE Command

DIVIDE places equally spaced point objects or blocks along the length or perimeter of
an object.

The command line equivalent is DIVIDE.

DIVIDE with Points

Using the Point Style dialog box, set the current point to one that can be easily seen, not
the fIrst one.

Command:DIVIDE

Select object to divide: (pick the object)

Enter the number of segments or [Block]:6

Figure 13.2

The selected object is not altered in any way, but as can he seen in Figure 13.2, there
are points in the current style at regular intervals. The points become objects on the
current model. To access these points with OSNAP use NODE.

This command is particularly useful for placing lines and arcs along a polyline, as can
be seen in the arcs on pages 119 and 120.
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DIVIDE Using a BLOCK

DIVIDE can also be used with blocks. In the follow-
ing example, a mullion block is used to divide a
window into equally spaced sections. Both a
curved window and a block called mullion are
needed.

In Figure 13.3 we have a curved window and a
block called mullion, which is the shape of a mul­
lion. The insertion point on the block is the middle
of the bottom line.

Figure 13.3
The command will place this block at regular inter-
vals along the window. The base point ofthe block
is very important. In Figure 13.3a the mullion is placed on the lower arc and rotated, in
13.3b the mullion is placed on the upper arc without rotation.

Cornmand:DIVIDE

Select object to divide: (pick 1)

Enter the number of segments or [Block]:B

Enter name of block to insert:MULLION

Align block with object? [Yes/No] : (Y for a, N for b)
Enter the number of segments:8

The MEASURE Command

The MEASURE command is very similar to the DIVIDE command in that it divides a
specified object into a series ofequal portions. The difference is that the equal portions
are given a specific length, and thus there may be a portion ofthe object left over when
the command is finished. Again, the MEASURE command works on lines, arcs, circles,
and plines, and again, the markers can be either points or blocks.

The command line equivalent is MEASURE.

MEASURE with Points

In the following example, use point display 4, or
the vertical line in the dialog box, and change the
length to 18m withPDSIZE 18. Then use MEASURE
to divide a road illustrated by a pline, Figure
13 Aa, into equally spaced lots, Figure 13 Ab.

First draw the pline representing the road. b

Type in the system variables PDMODE and
PDSIZE. Figure 13.4

Command:PDMODE

Select new point mode <1>:4

Command:PDSIZE

Enter new point size< 1.000>:18

Command:MEASURE

Select object to measure: (pick (a)

Specify length of segment or [Block] :15

We now have a road that is divided into equal portions of 15 ill lengths with a depth of
18 ill each. Notice that the road is created with pline and thus has line and arc segments.
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MEASURE Using BLOCKs

In the next exalnple, we will place a block of
a toilet along an existing wall. Both a LINE
representing a 19' wall and a BLOCK that rep­
resents a toilet will be needed.

Create a toilet that has an interior space of 3'
x 5,' as in Figure 13.5.

Now BLOCK the toilet, making sure that the
insertion base point leaves enough space for a
2" wall on the back and on the sides.

Insl!1"'t;Oft Bast' po;,,1;~
2" '-"01'1 bock _all

2'" Sl)act' 1'01" s;ck> _all

1
1

~3'4'~
Figure 13.5
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Now use MEASURE to place the toilet along the 19' long wall, as in Figure 13.6.

--------------19'0°---------------1

Figure 13.6

Command:BLOCK

Block name:TOILET

Insertion base point:corner

Select objects: (pick up all the objects)

Command:MEASURE

Select object to measure: (pick 1) (take the left side of the
wall)

Specify length of segment or [Block]:B

Enter name of block to insert:TOILET

Align block with object? [Yes/No]:~

Specify length of segrnent:1000

When creating the block to be used in a MEASURE command, be sure that you have no
overlapping items.

If you use points in either the DIVIDE or the MEASURE commands, you will have to
change the PDMODE to be able to see the displayed points. Once placed, these points
become objects in the file and will be affected by editing commands such as ERASE,
MOVE, COPY, etc. Ifyou do not change the pOMaDE, these points may be difficult to
see.
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The SPLINE
Command

In Chapter 5 we looked at polylines and how to edit them into splines. There is also a
command to create splines or smooth curved lines without accessing the PLiNE
command,

AutoCAD uses the Nonuniform Rational B-Spline (NURBS) formula to describe the
splines entered. A NURBS curve produces a smooth curve between control points;
this spline can be either quadratic or cubic.

Ifyou are creating a large drawing with multiple splines for mapping or airfoil design,
a drawing containing splines uses less disk space and memory than a drawing with
polylines. To access the SPLINE command:

The command line equivalent is SPLINE.

In Figure 13.7 a spline is drawn dynamically as the
vertices are being entered. 2

10
Cornmand:SPLlNE X 3
Specify first point or [Object]:

(pick 1)
Specify next point: (pick 2)

Specify next point or

[Close/Fi t tolerance] <start point>: Figure 13.7

(pick 3 through 9)

Specify start tangent: (pick 10)
Specify end tangent: (pick 11)

7

9

8
llX

Entering Points

Enter points to add additional spline curve seg­
ments until you press.J. Like the LINE and PUNE
commands, Ufor Undo will remove the last entered
point.

As the points are entered you can see the spline be­
ing created.

Start and End Tangency

The Enter start tangent: prompt specifies the tangency
of the spline at the fITst point; the Enter end tangent:
prompt does the same for the end point. You can spec­
ify tangency at both ends ofthe spline, and you can use
point, TANgent, or PERpendicular object snaps to
make the spline tangent or perpendicular to existing
objects.

Specify start tangent: (pick 12)
Specify end tangent: (pick 13)

Points 12 and 13 in Figure 13.8 and 14 in Figure 13.9
are points of continuity for the spline curve.

Figure 13.8

14X
Figure 13.9
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Close

As in the PLiNE command, the Close option defines the last point as coincident with
the first and makes it tangent there.

Fit Tolerance

This changes the tolerance for fitting the spline through the points. The number is
higher or lower depending on how you want the spline to fit through the points.

Object

This option converts either 2D or 3D polylines into splines.

The SPLINEDIT Command

The SPLINEDIT command edits the spline object.

The command line equivalent is SPLINEDIT.

The options for this edit command are similar to those of PEDIT.

Inquiry
Commands

The Inquiry commands are used to see and list
the parameters of a model. Objects are put in
relative to the origin, 0,0. The size, shape and
properties of the objects can be listed with the
Inquiry commands.

;.~~PI~~~"~"W~~SWbQow .~
~. Work$p""e<; •

i( P<llett(l$

·H~J Command Line CTRL+9

Clean Screen CTRL+O

:.;;,;: Qistance

: !lArea

:e. Region/tiass Properties

.i~. ~ist

,15 lDPolnt

Sp~l~g

Qulctseled ...

DrllWQ.rder .'

: €1 UpdilteFields
----

: , illod Editor

Xref and Block In-place Editing

;~ Attribute E~tra(tion...
1-IDDistance

Inquiry f3

~oad Apprtciltion•..

8,unScript...

~Clo

I!me

Set ~ariilble

•'r-'-.,"""'-----~

The Inquiry commands can be found on the In­
quitytoolbar shown above or in the Tools pull­
down menu under Inquiry, as shown in Figure
13.10. These commands can also be typed in at
the Command: prompt.

Figure 13.10

AREA

0lS1

LIST

10

STATUS

computes the area of a closed polygon

computes the distance between two points

lists the position and properties of a specific object or group of
objects

identifies the position of a point

displays a listing of all the statistics of a file along with other
infonnation
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The AREA Command

AutoCAD offers built-in area computational
abilities which also display the perimeter of
the object calculated. This can be extremely
useful for calculations of plines and irregular
shapes.

AREA Using an Entity

In Figure 13.11 is a pline that has been fitted
with a spline curve, and the area and perimeter
are to be calculated. In this case an entity is
chosen for the area option.

Figure 13.1 1

Command:AREA

Specify first corner point or [Object/Add/Subtract]:O

Select objects; (pick 1)

Area = 16.1434 Perimeter = 19.6824

AREA Using Lines

When calculating a series ofstraight lines, the default is to have the shape entered by a
series of points as shown in Figure 13.12. OSNAPs are needed for accuracy.

Command:AREA

Specify first corner point or [Object/Add/Subtract] :

END of (pick 1)
Specify next point or press ENTER for total:END of (pick 2)
Specify next point or press ENTER for total:END of (pick 3)
Specify next point or press ENTER for total:END of (pick 4)
Specify next point or press ENTER for total:END of (pick 5)

Specify next point or press ENTER for total:..J

Area = 67.5000 Perimeter = 31.1131

4 3

5
2

Figure 13.12

Subtract and Add with AREA

To calculate the net floor area of a bathroom, a
drawing ofa bathroom will be needed. Draw in a
bathroom 3 m x 2 m, as shown in Figure 13.13.

Set OSNAP to ENDpoint and calculate the total
floor area.

Command:OSNAP

Object snap modes:ENDpoint

Figure 13.13
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2Command:AREA

Specify first corner point or

[Object/Add/Subtract] :A

First point: (pick 1)

Next point: (pick 2)
Next point: (pick 3)

Next point: (pick 4)

Next point:.J

Area = 6000000

Perimeter = 10000

Without leaving the command, subtract the fixtures.

1
L:J,x----------.-----7f.,.

Figure 13.14

Specify first corner point or [Object/Add/Subtract]:5

Specify next corner ENTER for total (SUBTRACT mode) : (pick 5)

Specify next corner ENTER for total (SUBTRACT mode) : (pick 6)

Specify next corner ENTER for total (SUBTRACT mode) : (pick 7)

Specify next corner ENTER for total (SUBTRACT mode) : (pick 8)

(SUBTRACT mode) Next point:.J

Area = 1859444, Perimeter = 5859

Total area = 4140556
6

Specify first corner point : (pick 10)

Specify (SUBTRACT mode) : (pick 11)

Specify (SUBTRACT mode) : (pick 12)

Specify (SUBTRACT mode):~

Area = 306148, Perimeter = 2226

Total area = 3834408

n
10

)f----";{

9 8

Figure 13.15

5

u

The wording in these commands is
Ivoluminous, just Jook for SUBTRACT
mode or Add.

Specify first corner point or [Object/Add]: (pick
Specify (SUBTRACT mode) : (pick 14)

Specify (SUBTRACT mode) : (pick 15)

Specify (SUBTRACT mode) : (pick 16)
(SUBTRACT mode) Next point:.J

Area = 139611, Perimeter ::::: 1732

Total area = 3694797

13)

(SUBTRACT mode) <First

point>/Object/Add:O

Select objects: (pick 17)

Area = 199307, Perimeter 1615

Total area 3495490
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Figure 13.16

As you can see from Figures 13.13, 13.14, 13.15,
and 13.16, points and objects can be used together. With the Subtract mode, subse~
quent area calculations are subtracted from the accumulated area. Use Add to enter the
first area, then Subtract for the subsequent areas.

With the Add option, subsequent areas will be added to the accumulated area.

AREA and PERIMETER are also system variables and can be viewed but not changed by
displaying them. Use the SENAR command to access the system variable. Ifyou cal­
culated an area, but neglected to jot it down, type AREA as the variable name and the
last calculated area will be displayed. To find the length or circumference ofa circle,
arc, or pline, use the LIST command. Be sure to change the units to the desired values
before entering the AREA command, othelWise the readings may be inaccurate.
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The BOUNDARY Command

The BOUNDARY command creates a region or a polyline ofa closed boundary. Speci­
fying a boundary set can produce the boundary more quickly, because AutoCAD ex­
amines fewer objects when a boundary set is identified. For an example of how
BOUNDARY works, see Tutoria113.

The DISTance Command

The DISTance command will give you the actual distance between two points.

The command line equivalent is OIST.

Remember that when dealing with points in AutoCAD or any other CAD package, you
can specify the points in three ways:

1, if they are associated with objects, by finding them with OSNAPs e.g. ENDpoint,

MIDpoint, etc.

2, by picking on them on the screen, with or without the use of SNAP

3, by specifying their coordinates.

When calculating DISTance, you can identify the
points by any combination of the above. First enter
the DIST command, then respond with the two points
that identify the distance you want to know, as in
Figure 13.17. It is better that you specify the exact
points with either an OSNAP or a coordinate entry.
As with the other commands, you will be offered the
information relative to the current units specified.

You will note that the readout contains not only the
distance, but also the angle from the XY plane, and
the length and width of the object.

A
Figure 13.17

_1

Command:DIST
Specify first point: (pick point A)
Specify second point: (pick point B)
Distance= 10.2956, Angle in X-Y Plane = 61, Angle from X-Y

Plane = 0 Delta X = 5.0000 Delta Y = 9.0000 Delta Z =

0.0000

The LIST Command

We looked at LIST briefly in the first section of this book to establish the layer, color,
and linetype properties ofobjects that had already been entered. In addition to this, LIST
is an extremely useful command for the following purposes:

1. cleaning up objects before hatching and editing

2. finding out the angle of an existing LINE
3. finding out the radius of a specified circle

4. determining text fonts and sizes

5. finding out if existing items were put in incorrectly or without the use ofSNAP

6. checking for incorrect dimensions.
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LIST can also be used to show the number ofob·
j ects within a specified window to check that
the objects follow good CAD practice. In the
following exalnple, we will see how LIST can
also be used to tell us if the dimension for an
object is real or made up.

In Figure 13.18 there are two associative di­
mensions listed. To the eye, they look the
same. They are identified by being highlighted
in the DOT linetype.

Note the difference in the readouts after the
LIST command has been used.

Command:LIST
Select objects: (pick the dimension)

~"e:-;" 2.0000

Figure 13.18

5.0000

x= 2.0000 y= 4.5000 Z= 0.0000

x= 4.0000 ¥= 3.5000 Z= 0.0000

x= 4.0000 y= 2.5000 Z= 0.0000

y= 2.5000 Z= 0.0000

The Properties command has much
of the LIST information in a dialog
format.

250 CHAPTER THIRTEEN

DIMENSION Layer: dim

SPACE: Model Space

Handle = ID14

type: horizontal

1st extension defining point:

2nd extension defining point:

dimension line defining point:

default text position X= 3.875

default text

dimension style *UNNAMED

DIMENSION Layer: dim

SPACE: Model Space

Handle =:: ID14

type: vertical

1st extension defining point: X= 6.0000 Y= 8.5000 Z= 0.0000

2nd extension defining point: X= 6.0000 ¥= 3.0000 Z= 0.0000

dimension line defining point: X= 6.5000 ¥= 2.5000 Z= 0.0000

default text position X= 6.500 Y= 5.7500 Z= 0.0000

dimension text modifier: 5.0000

dimension style *UNNAMED

You can see that the first dimension has been entered properly, and the text for the di­
mension is the default text. In the second dimension, however, the dimension text has
beenmodified to read 5.0000. Ifyou subtract the second extension defining point from
the first in the Yvalue, you will notice that the actual distance should read 5.5000, but
the dimension text has been altered before it was entered.

In addition to checking your own work to be sure that it is all entered correctly and that
there are no overlapping items, with the LIST command you can check to see that the di­
mensions associated with the drawing you have on file are correct and not altered in
any way. Ifthe dimensions have been altered, check to see that all ofthe necessary di­
mensions have been altered.

Another great advantage of LIST is that it enables you to determine ifthere are overlap­
ping lines when making hatches and dimensions. Use LIST, then Crossing, to see the
number of objects overlapping.

The ID Command

The ID function is similar to the LIST function, in that it gives an exact position. The dif­
ference is that it gives an exact position ofa point rather than an object. This command
is used in 3D modeling more frequently than in 2D modeling, to determine the Z depth
of items. In 2D this can be useful for finding out the exact position you are looking at
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on a zoomed screen, or for simply getting your bearings. Keep in mind that ifyou are
picking a point in space, a snap can give a more usable readout.

The location ofthe point will be relative to the origin or 0,0,0 ofthe modeL Ifa point in
space is chosen, the Z depth will be the current elevation; ifan object is chosen with an
OSNAP, the actual Z depth of the object will be used.

ID can be used as a reference point for the next point entered using @:

Command:LlNE

From point:@2,O (starts the line 2 units in X from the ID
point)

There are basically two ways ofusing ID. The first is to find the parameters ofa point
on the screen.

Command:ID

Specify point: (pick a point)
X = 34.6375 Y = 24.8758 Z 0.0000

This will give the coordinates ofa point in space in the defined units. The second is to
locate a point by typing in the coordinates.

Command:ID

Specify point:23,4,O

The STATUS Command

Another useful command for determining what is happening is STATUS. As you be­
come proficient with AutoCAD, you will find the STATUS command more and more
useful, because it displays a listing of all the statistics of a file.

The STATUS command also offers information on memory and the partition on the hard
drive where your temporary file or .AC$ file is being stored. Ifyou run out of space in
this partition (in a classroomthis is often the A: drive), the program will terminate after
first saving your file.

STATUS is most often used by beginners to determine if the color setting is overriding
the layer color setting.

Enter STATUS at the command prompt and read the status of your file.
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Step 1

Step 2

Set up three layers, for Points, Object, and Dimensions. Make Points current. Then add

points.
Make the top center or third point active, and change Size Relative to Screen to 50/0.
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Add the points. The lower left comer will be 0,0.

Command: POINT

Specify point:.75,.75

COffiInand: POINT

Specify point:l.5,.7725

Comrnand:POINT

Specify point:2.25, .7965
Command: POINT

Specify point:3.0,.8665

Command: POINT

Specify point:3.75,l.0305 etc.

+ +++++

+
+

+++

Step 3
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Change OSNAP to NODE and use SPLINE to create a spline through all ofthe points.

Command:OSNAP

Object snap rnodes:NODE

Now use SPLINE to create a spline through
the identified points.

Comrnand:SPLlNE

Specify first point or

[Object] : (pick the first point)
Specify next point: (pick the next point)

Specify next point or [Close, Fit Tolerance]: (pick the points

in sequence)
Specify next point or [Close, Fit Tolerance] : (pick the last

point)

Specify next point or [Close, Fit Tolerance] :~~

Specify start tangent: (pick the first point)
Specify end tangent: (pick the last point)
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Step 4 Using the drawing given at the beginning, add the outside lines.

Step 5

Now use the Boundary op­
tion to help detennine the
area of the top of the part.

Step 6

From the Boundary Creation dialog box, choose Make New Boundary Set.

Now pick the lines and the spline.

3

2

4

6
5

Press .J when you are finished and you will return to the Boundary Creation dialog
box.

From the dialog box, select Pick Points. You will be prompted to pick the internal
point; choose the inside of the part.

A region will be created and you will have the area for the part.

If your system doesn't allow this, enter the
AREA command, use the Object option, and
Lfor last object.

Now list the properties ofthe spline and one
of thepoint nodes.

You will get a listing of the properties. 2
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Step 7 Now add some points along the top edge ofthe part that corresponds to the X measure­
ment ofall ofthe points. This is to double-check that all ofyour points are entered cor­
rectly. Use DDPTYPE to change the point style to the vertical line as shown.

Command:MEASURE
Select object to

measure: (pick 1)
Specify length of

segment or [Block]: .75

Use Undo to remove the points once
they have been used to double-check
the lower points.

Step 8 Now add the remaining lines and di­
mensions to this view.

Step 9 Pan the screen over and, using the same method, draw in the front view of the gusset.
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The points will be much easier to enter ifyou make 0,0 the upper left comer. Move the
fIrst view up and out of the way.

When you are done, add a title block and notations to complete the drawing.

Type in the word TIME to see how long it took you to do the drawing.
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Step 1

DIVIDE and MEASURE are used most effectively on
PLlNEs. In this example we will draw a pseudo four-cen­
tered arch.

First we must detennine the span of the arch. Start by
setting up some construction lines with the span and the
rise of the arch.

We will make the span 5" or 60 N, and the rise

14 N.

Draw in two construction lines as shown.

Then put in two circles, each one centered 6"
from the end ofthe span line, having a radius of

611
•

" I-'"
.....------,.-------t

Step 2 Draw lines tangent to the circles terminating at the top of the rise. Trim the circles.

Step 3 Use PEDIT with the Join option to make two plines, one on either side of the rise.

2

Comrnand:PEDIT

Select object: (pick 1)

Object selected is not a polyline

Do you want to turn it into one? <y>:~

Enter an option [Close/Join/Width ... rve/Ltypegen/UndoJ: j

Select objects: (pick 2)

Select objects:.J

1 segments added to polyline
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Step 4 Use DIVIDE to divide the plines into six equal sections for the stone pieces. First set
PDMODE. Under the Format menu, pick Point Style.

Cornmand:DIVIDE

Select object to divide: (pick 1)
Enter the number of segments or

[Block] :6

StepS

Step 6
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Your PLiNE should have six points on it. Do the Saine with the other side.

Now OFFSET the PUNEs first by 6", then by 7".

Use FILLET with a radius of0 to close the top off. Then use LINE with the OSNAP NODE
and PERpendicular to make the lines for the stone.

The hidden lines and arrows show the method of calculation.
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GLIDING DOOR UNIT

Exercise 13 Practice
Create the simple floor plan shown below.
Use DIVIDE to divide the glass wall and gliding doors into equal portions.
Use MEASURE with BLOCK to create the decorative brick wall.
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Exercise 13 Architectural
This steel roof framing plan is very difficult without DIVIDE.
To place the 'marks' make a dimension style without extension or dimension lines.
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Exercise 13 Mechanical
Use DIVIDE and MEASURE to produce 13A.
Use AREA to find the various surface area of 13B.
Use PDSIZE to display the nodes at the corred distance.
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¢O,5000
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Introduction

Attributes for
Title Blocks and

Notations

Attributes

chapter, you should be able to:

••.•.••..•..•..•••.• >i3.••• ln~iedrth€:cltt(lbu·tesonto a drawing

boxes

In addition to creating geometry and drawings, AutoCAD allows for the generation of
non-graphic information which can be accessed in the form of bills of materials,
schedules, parts lists, and other data that is cross-referenced on the drawing. This
non-graphic intelligence is called an attribute. Attributes provide a label or tag that lets
you attach text or other data to a block. This attribute information can then be
downloaded onto your file in a text format.

Attributes can also be used to generate templates for fill-in-the-blanks situations such
as on drawing notations and title blocks. This information can then be used by your
system manager to track files and drawings.

Attributes are commonly used to fill in relevant infonnation on title blocks and other
drawing notations. All of the sizes for the inserted text are determined at the time the
attribute is defined and blocked, as are the placement ofthe text and the lettering font.
All the user needs to do is add the missing information for the customer, name ofpart,
date, name of designer, etc.

In the title block in Figure 14.1, all the informa­
tion relative to the current drawing (in italics) has
been added using attributes.

Cornmand:-INSERT

r SCALE
,

BEACH DESIGNS
COMPUTER AIDED DESIGN SERVICES

-s'kylab Industries
_...

B.ChaUis

Ho";k Link
>tAU: 1:500

...ro
_..

MaTck 17 2008 DFC-1003

Figure 14.1Enter block name or [?] : TITLE

Specify insertion point or [Scale

/X/Y/Z/Rotate/PScale/PX/PY/PZ/P

Rotate] :0,0

Enter X scale factor,specify opposite corner,or

[Corner/XYZ] :.J

Enter Y scale factor <use X scale factor>:.J

Specify rotation angle <O>:.J (the same as block inserts)

Customer name <Skylab Industries>:~

Name of Part<>:Hook Link

Enter the current date (Month/Day/Year) :March 17 2006

Drawn by <B. Challis>:~

Scale <1:5>:~

Drawing no. DFC-####<>:DFC-1003

Remember that the angle brackets contain defaults, e.g. <Skylab Industries>.
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Defining the
Attributes

Use -INSERT and -ATTDEF to
avoid the dialog boxes.

262 CHAPTER FOURTEEN

To define attributes, use the ATTDEF command. In a title block the text font for the block
titles (Name, Date, Drawn By) should be different from the text font for the current
information. Before creating the attribute defmitions, load the new text font.

To define the attribute use -ATIOEF or the Attribute dialog box.

The ATTDEF Command

The ATTDEF command allows you to define an attribute. We will create the attribute
definition for the date. Access the ATTDEF command through the command line.

The command line equivalent is ATIDEF for the dialog box and -ATIDEF for the com­
mand string.

Figure 14.2 illustrates a comer ofa title block. The word Scale is added in text to iden­
tify the information within that box. The tag Scale will then be added with the AITDEF
command. See the Attribute Definition dialog box on the next page as well.

Command:-ATTDEF
Current attribute modes -- Invisible-N, Constant-N,

Verify-N, Preset-N
Enter an option to change [Invisible!Constant/Verify/Preset]

<done>:~

Change the modes ifyou want the attribute to be constant, invisible, preset, or verified.
In this case no change is necessary.

The attribute tag is a one-word summary of the subject of the attribute. In this case,
you want the user to enter the scale of the drawing.

Enter attribute tag name:Scale

The attribute prompt is what is actually going to appear on the command line. This
prompt asks you for the required information, in this case the scale, and it should offer
any further infonnation that may be required in order to enter that information.

Enter attribute prompt:Enter scale of drawing

The default attribute value is what the user will usually want to use. If most of your
drawings are done with a scale of 1:50, that is the scale you should use as a default.

Enter default attribute value:l:50

Now that the you have identified what your attribute is going to say, you need to place
it on the title block. ATIDEF works like the TEXT command.

Specify start point of text or [Justify/Style]:J

Align/Center/Fit/Middle/Right/TL!TC/TR/ML/MC/MR/BL/BC/BR:R

Right: (pick the right to have your text right justified)

Specify height <0.1800>:.25

Specify rotation angle <O>:~
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SCALE

Text in the Standard font was used to define the I
text for the title block. The tag for the scale at-
tribute is in the Italic Complex Font. This is ~ ......
where the current scale will appear. The tag 1-, _

shows up as shown in Figure 14.2 until the at-
tributes are blocked.

Figure 14.2

Using the Define ATTribute DIAlog Box

In the Attribute Definition dialog box you can set the modes, tag information, prompt,
location, and text style as described above. When Insertion Point is chosen, the dialog
box will disappear until the point is chosen, then reappear once the selection is made.

The Value box means default
value.

Mode

o Invisible

Dkonstant

DY:elify

O,ererel

l~'ertion Point

Ea Spedy Q.n·screen

lag;

ProIDPt

Value:

TelllOptions

,lustkation:

Text~tyle:

H~ight<

flotation <

Editing Attribute
Definitions

o81ign helow previous attribute definition

r;a Loc!:, pos~ion in block

OK i I Cancel I I Help

When using the dialog boxes you need to be sure to enter a point for the reference
point (Specify On-screen). Ifnot, your attribute could end up anywhere.

Once the attribute definitions are all entered, the attributes can be blocked and then in­
serted.

If you have made an error in defrning the attribute you can change the attribute
defmition with the CHANGE command or with the Edit Attribute Definition dialog
box.

The command line equivalents are ED, DDEDIT or CHANGE.

DDEDIT and ED give you a dialog box where you can change the tag, prompt, and de­
fault values, etc. The CHANGE command does the same without the dialog box.

Command: CHANGE
Select objects: (pick the definition you wish to change)
Select objects:-l
Command:DDEDIT

<Select a TEXT or ATTDEF object>/Undo: (pick the ATTDEF)

Attributes 263
More free ebooks  :  http://fast-file.blogspot.com



CHANGE and DDEDIT alter the
Attribute Definitions, not the
attributed block.

The Edit Attribute Definition dialog box will offer you three input boxes to change the
tag, prompt, or default value. Note how the default value is here called the Default.

II Edit A;Hribute Definilion' " ' ' 11111
Tag:

Prompt

Default:

OK l I Cancel I I Help

Press OK to complete the change.

SLOCKing the Attributes

Once the attributes are all defined, you must BLOCK the information. Pick the attribute
definitions in the order that you want your prompts to appear by picking each attribute
in order. If you use Window, you may be prompted in the reverse order.

Inserting the Attributed Blocks

Having created the attributed block, now use INSERT to place it on your drawing. Once
inserted, the block will contain the values for each attribute in that particular instance
or application.

If you use -INSERT you will be prompted for the information on the command line. If
you use INSERT, you will get the Insert dialog box. You can also use the ATTDIA dialog
box for inserting attributes. If this dialog box does not appear, toggle ATTDIA on.

Command:ATTDIA

Enter new value for ATTDIA<O>:l

Changing Attribute Definitions

While inserting the block, you may notice some errors in the block definitions. To
change the attribute definitions at this point, use EXPLODE and then CHANGE or
DDEDIT. When you EXPLODE the attributed block, it will revert back to the tag format.

r "BEACH DESIGNS
COMPUTER AIDED DESIGN SERVICES

M'IlIQ -'"CUSTOMER DRAWN
IIIC .. ,..,. 'IOU

PART SCALE...
~-DATE DRWNO

Attribute definition with tags

Figure 14.3

r
'""BEACH DESIGNS

COMPUTER AIDED DESIGN SERVICES- .... '"Skylab lnd:u.stries B. Ch.aUis
IIIC IF NIn'. mu:

Hook Link t:500
..Ito ---March 17 2008 DFC-1003

Attributed block instance
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In Figure 14.3 the graphics with attribute tags before they are all blocked are shown on
the left, and the inserted block with the instance values on the right. If you want to
change any of the default values once they have been entered, use EXPLODE then
CHANGE or DDEDIT.
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Displaying
Attributes

When attributes are added to objects, they can be nlade universally invisible by setting

the Invisible mode in the ATIDEF command, or you can make them invisible later using

the ATIDISP command.

The ATTDISP Command

ATIDISP controls the display ofattributes. It is only available on the command line.

Command:ATTDISP

Enter attribute visibility setting

[Normal/ON/OFF] <Normal>:OFF

Where: ON

OFF

Normal

all attributes visible

all attributes invisible

normal visibility, set individually

Attribute Modes

Ifyou want to INSERT the attributed blocks without having to tum the display off, you
can set the attribute mode to invisible. You can set these as follows to make attributed
block insertion easier:

INVISIBLE

CONSTANT

VERIFY

PRESET

makes all attributes invisible

makes an attribute uneditable; for example, the president's desk is
always the president's desk even though the president may change

allows you to take a final look at what you have entered prior to
having it added to the drawing

is used when creating attributes that will always have the same
value

Creating
Attributes for

Data Extraction

Attributes can be used both for title blocks and drawing notations, and for occasions
where the information can be downloaded to a price list or bill of materials. The
attributes are all defined in the same way, and the extractions take place once the
attributed blocks are all inserted.

When attributes are used for drawing notations they are almost always visible on the
drawing. When they are used for bill ofmaterials, parts list or schedules, the attributes
are usually invisible on the drawing but shown on the Attribute Extract Table, as ex­
plained on page 267.

Attributes are always associated with blocks. Ifyou want an attributed block, first cre­
ate the geometry for the final block, if there is any, then add the attributes. You will
need to have lines and text as well as attributes in a title block, but you will not need ge­
ometry in an attributed block that is meant, for example, to extract room colors.

Tutorial14b gives an example ofattributes used for extraction toaBillofMaterials.

The concepts for attributes are relatively difficult for non-computer users. The only
way to see how they are used is with practice. There are three tutorials at the end ofthis
chapter starting on page 268. Ifyou do all of them, you should understand better how
attributes work.
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Editing
Attributes

There are two ways ofediting attributes:one at a time or in groups. For one at a time use
ATIEDIT or the Enhanced Attribute Editor.

You will be prompted to choose the block to edit. Then you will get this screen.

You can change the value of the attribute on this tab, the size and quality ofthe text on
the next, and the properties (layer, color, linetype) on the last. Make changes then click
OK.

f------------- ------------------------------------x 2
:, .

st...
: .ell x.~
I us
I

I
I
I
I,,
:
:,

1 :x-------------------------------------------------

Before ATTEDIT
Figure 14.4

After ATIEDIT
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Cornmand:-ATTEDIT

Edit attributes one at a time? [Yes/No]<Y>:N
Performing global editing of attribute values
Edit only attributes visible on screen? [Yes/No]<Y>:~

Enter block name specification <*>:JIGLEG
Enter attribute tag specification <*>:Material

Enter attribute value specification <*>:~

Select Attributes: (pick 1 pick 2)
Enter string to change:Steel

Enter new string value:Bronze

Figure 14.4 show a global change on a number of attributes. The value is case sensi­
tive, i.e. Steel will work, STEEL won't. Make sure that you have typed the infomlation
in correctly or you will have problems.

Ifyou need to change a lot of the information on an attributed block, another way of
doing this is to EXPLODE the block, redefine it, then re-block it under the same name.
All of the block instances will be updated.
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Data Extraction Now that the data have been entered correctly, you can have the file printed out onto a
spreadsheet or materials list by using the command ATIEXT. This operation does not
change the drawing in any way, but takes the attribute data to applications such as
Excel, Lotus 1-2-3, or your favorite word processor. You can either export the data, or

have it written immediately on your drawing with EAnEXT.

ATTEXT and Template Files

To extract data with ATIEXT you must create
a template file in .txt; Wordpad or Notepad
are the easiest to use.The template file might
look like this:

PARTNO C008000

DESCRIPT C0150DO

MATERIAL C0080Da

SIZE C00800a

PRICE C008000

The template file is set up with the tag plus
the code:

PARTNO C008000

TAGWhere: PARTNO
C
008
000

character

8 characters maximum in the jig name (COOSOOO)

number of decimal places ( none are needed for a
character field)

Once the template file is created, invoke the AnEXT command and you will get the At­
tribute Extraction dialog box. The template file is the one you have just created. The
extract file is the one you are trying to make. View the extract file in Wordpad or Note­
pad.

EATTEXT

Ifwhat you are after is a compiled listing ofyour attributes on screen, use the EATIEXT
command. This will walk you through the process of extracting all of your attribute
data and placing it on your screen. This is a new command with Release 2006. In Re­
lease 2008 it has become much more complicated. Simply remove all references to ob­
jects other than attributes when prommpted and it will work beautifully.

You will be prompted for such things as a table heading, in this case the heading Jig
Assembly was chosen. Figure 14.5 shows an extraction from quite a large drawing.
The lists can be numbered according to any of the tags.

hardware
Quantity DESCRIPT MATERIAL NaMe PARTND PRICE PRODND SIZE

1 Jig Leg Bronze Jl JIG135 5.26 .60 X 1.25
1 brass jigleg none
2 Jig Leg Steel Jl JIG135 5.26 .60 X 1.25
-4 1
-4 Jig Leg Bronze J1 JIG125 5.26 .60 X 1.25
-4 Stnnc:t Bushing Steel B1 BU135 3.29 .125 X .55
12 Stand. Bushing Steel B1 BUl25 3.29 .125 X .55
19 Jig Leg SteEtl Jl JIG125 5.26 .60 X 1.25
31 2

Figure 14.5
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Step] Use LINE and PLiNE to create the design for a standard title block. Use TEXT to enter the
headings for each area. Use imperial or metric sizes.

CUSTlINER DRAVN BY'

1

NAME OF p.r. ~~ --r0.lO (23

I)/IT£. !RA....INCi NO<

Your title block should be in
a layer called title. If it is on
Layer 0, it will pick up the
linetype, layer and color of
the layer current in the
receiving file when it is
inserted.

--------6-00 [1523--------:1
1-1---3.00 [76]------·

I
1.50 CJ8l

~I~l

Step 2 Add the attribute definition for the
date.

l:USTDIlElt DRA\Il'II IIY,
DRAWN

IWIE IT P.T, SCAI.£

DA,
D~TFJ< 1 DRAVINIi to

'-- \.-.

First use the SlYLE command to set a

new text style for the attributes. Use the typed-in version of ATTDEF for this one.

Command:STYLE (set a new text style with the name attributes

using a different font)

Command:-ATTDEF

Current attribute modes:lnvisible-N Constant-N Verify-V

Preset-P

Enter an option to change [Invisible/Constant/Verify/PresetJ

<done>:.J

Enter attribute tag name:Date

Enter attribute prompt:Enter today's date
Enter default attribute value:

Justify/Style/<start point>:J

Align/Center/Fit/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR:R

Right point: (pick 1)

Specify height <5.0000>: .15

Specify rotation angle <O>:.J

Step 3 Now enter the attribute for the
designer using the Attribute
Definition dialog box.

DRAWN I

Mod"

D!nvisible

o Constant

D~81jfJl

oEresel

Insertion Pain!

[;2] SpeclJl .Qn·~feen

Mobute

lag

Vajue:

Use your own name as the default.

o 8ign below previous atbibute definition

E:l Lock.p~n in block

OKl j Cancel I [JieCJ
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Ifyour attribute is not where you want it, the Insertion Point area cannot have been set
up right. Use Undo to undo this command, and try again being sure to specify the inser­
tion point on screen by first choosing Insertion point from the dialog box.
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alSlIIO CUSTOMER
...w .....

DRAWN
tWC or PMr. ~

PART SCALE
D'Tto _vlNG ..

DRWNODATE

Step 4

Step 5

Use either the command line or the dialog box method ofdefming the other attributes
so that each area has an attribute tag.

Once these are in, the title block can be inserted onto other drawings.

Title blocks are meant to be used
on many different drawings. Save
this file under the name of Titlel
just to see if it works. Be sure you
know what directory it is going to.
When in doubt use the A: drive or
your flash drive.

Command: SAVE

TITLE1

Step 6 Open a new file and test the block out. Use either the dialog box or the command line
form of the INSERT command. Keep the Title1 file open as well.

Command:New

Command:-INSERT
Enter block name or [?] :TITLE

Specify insertion point or [Scale/X ... /PRotate] :0,0

Enter X scale factor, specify opposite corner,or
[Corner/XYZ] :.J

Enter Y scale factor <use X scale factor>:~

Specify rotation angle <O>:~

Customer name <Skylab Industries>:~

Name of Part <>:Hook Link

Enter the current date (DD/MM/YY) :17/03/06

Drawn by <S.R.Kyles>:Bill Challis

Scale <1:50>:.J

Drawing no. DFC-####<>:DFC-1003

With the ATTDIA system variable on, you will get this dialog box to let you see all of
your attributes. To change the defaults, simply type over them.

Turn on ATIDIA as shown.

Step 7

Command:ATTDIA

Enter new value for

ATTDIA<O>:1

Click OK to place them on screen.

A good way of checking your attributed
block is to have a fellow student insert the
block and fill in the details of the attrib­
utes without your help. If he/she has any
problem understanding the prompts, go
back and edit them. While you may un­
derstand your prompts now, the fact that
someone else doesn't understand them
may indicate that you won't either after a
few days.

a;STOMfR
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Other areas you may want to adjust are the attribute text sizes or justifications.

Go to the file Title1. Use CHANGE, DDEDIT , or the Properties menu shown on the left
to make necessary changes.

Command:-justifytext
Select objects: (pick the text)
Select objects:.J

n

~xternal Reference

Image

mf t!atch...

h f?olyJine

dt) ~line

Multiline, •.

8,ttribute

'6 liIock Description".

CUSTIKR DRAWN BY.

Skylab Industries Brian Crippin
NAME IlF' PART,

SCALE 1:50Hook Link

DAn;· 17/03/06 IlRAVINCi to DFe - 1003

"T M0:teo Rotate

5] Scale

Dlk Stretcb.

~Ijp

.ti.. ~rase

'Q Cop~

t11~ Mlrror

~ Offiet

g~ ~rray ...

For the justification ofattributes such as in Skylab Industries andDFC - 1003, shown
below, neither CHANGE nor DDEDil will help. Use the Properties bar under the Mod­
ify menu shown on the left or

i PositiOn X -'18.04

•Position Y28.45

Position 20.00

«<,~,B,y,Layer<
o

,~in.,~~~P~c<,,===,~~~y~r ,
Linetyp... 1.00

'pfotstYI8';E3YC~I~;
i li~~~~i•.. <==Bye;y~;
< Hyperllnk' ..... ,.
'Thicl;;~sso:o6

: Contents DATE

[:~~til~<>C< ;IT~I~~

:.~s~i~¥.< ,~~ft

:~~~h.tH 0:3.5
.R.:~,t~t~n 0
Width f". 1.00

'6bliq~ing"0
'T~~t~ii:.:'·o:O(i

rT~~t'~li.::'o:oo .
r'~",_~, ·_···_, ·.. , __ ,,__ ,, ,

'Text ali ... 0.00

Once changed, save the file again and reinsert it.

Step 8 Ifyou have updated the file, resaved
it, and reinserted it and the same
problems still exist, erase the Title 1
block, then use PURGE to erase it
from memory. Sometimes, even if
you have updated the file, it will
bring back the old file instead of the
new one. Purge is a great way to
clean up your files ofunwanted data.

0&l~~iiffi!~l~~~

o Vie!,! items you cannot PLllge

Items not u$ed in drawing:

I SJ • All items
! iil@ Blocks
, "~ Dimension styles

;:B~ Layers
::;:::: Linetype$

j<R: Mline st,YlllS
. III Plot styles

.If£. Shapes
Iml Table st)lles
• Telll styles

Command: PURGE ; (

~~.~~~~~~~~_~_~ ~__'_A..-J

f2] Qlnfinn e<ICh item to be purged

o Pulga nested iterrn;

Close Help
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In this tutorial, you will create a jig with a bushing andjigleg. In a manufacturing envi­
ronment, it is usual to have items such as bushings purchased rather than made on-site
to save both time and money. Ifyou were to create a drawing of this part using these
items, you could also have the ordering information stored as attributes with the block
before it is inserted into the drawing.

Step 1

Step 2

Draw up these very simple parts in imperial measures on different areas of your
screen. Make separate layers for the bushing and the jigleg.

I: 6.00

"I3.00 al
~~~{fflDO.3'O eo.15

02.00 t: .0.30RO.25 .0....0
~2.50

.0.60 ...... ";1

.0.50

10.60

~3.50

If you wanted to create a bill of materials for these items, the information could in­
clude:

• Part Number

• Description

• Material

• Size

• Price

Then you would add the quantity and order the parts. The information listed above will
be added as attributes to the block before it is blocked and then extracted later.

The words in this illustration are attribute tags, not
text. No text is needed in this exercise.

PARTNO
DESCRIPT
MATERIAL
SIZE
PRICE
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272 CHAPTER FOURTEEN

Add the attributes for the part using these default factors:

Tag Prompt Default Value

Partno Enter Part Number JIG125

Descript Enter Part Description Jigleg

Material Enter Material Steel

Size Enter Part Size .60 x 1.25

Price Enter Current Price 5.26

Enter the information for the jig with the -ATTDEF command. Use the Attribute Defini­
tion dialog box for the bushing.

Command:-ATTDEF
Current attribute modes:Invisible-N Constant-N Verify-V

Preset-P
Enter an option to change [Invisible/Constant/Verify/Preset]

<done>:.J

Enter attribute tag name:PARTNO

Enter attribute prompt:Enter Part Number

Enter default attribute value:JIG125

Justify/Style/<start point>: (pick a spot beside the part)

Specify height <5.0000>: .03

Specify rotation angle <O>:.J

When entering the next line for the attribute, the attribute definition will line up with
the last entered line ifyou press.J at the text justification line or simply choose OK on
the dialog box. The attribute definitions will line up perfectly.

Command: -ATTDEF

Current attribute modes:Invisible-N Preset-P

Enter an option to change [Invisible /PresetJ <done>:~

Enter attribute tag name:DESCRIPT

Enter attribute prompt:Enter Part Description

Enter default attribute value:JIGLEG

Justify/Style/<start point>:.J

Command: .J

ATTDEF

Current attribute modes:Invisible-N Preset-P
Enter an option to change [Invisible Preset] <done>:.J

Enter attribute tag:MATERIAL

Enter attribute prompt:Enter Material

Enter default attribute value:Steel

Justify/Style/<start point>:.J

Continue with the final two definitions until all five are complete. It's simply a matter
of typing.

Use ~ at the JustifY text prompt to line the attribute up with the previous definition.
Also use -J to bring back the previous command to make the attribute definition more
rapid.
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Step 3 When all ofthe information has been added, create a block ofthe part with a new name
to help you identify it as an attributed block.

Command:-BLOCK

Block name (or ?) :ATTJIGLG
Insertion base point:CENter of (pick 1)

Select objects: (pick 2, 3)

Remember that the block will disappear.

,--------Jf,." 2.... f'
PARTNO

•
~~~~
SIZE
PRICE

,l/ 1

Step 4 Do the same with the bushing using the dialog box. Use the values listed below.

Tag Prompt Default Value

Partno Enter Part Number BUl25

Descript Enter Part Description Stand. Bushing

Material Enter Material Steel

Size Enter Part Size .125 x .55

Price Enter Current Price 3.29

Use the dialog box by either typing in ATTDEF or on the Draw menu, choose Block then
Define Attributes.

Mode

D!nvisible

DI;;onstant

DY:eril,Y

Dfreset

Attribute

lag:

PromPt

Vajue:

Insertion Point

G2J Specif,Y .on-screen

Text Optiom

Justification:

Text~t'yle:

H~ight <

flotation <

D align below previous attribute definition

~ Loc1, position in block

OK) I Cancel I { Help

After the first definition is entered you can pick the'Align under previous defmition'
button to have the attribute definitions line up.

Your part should look like this. ~
PARTNO

DESCRIPT
MATERIAL

- SIZE(0\ PRICE
'-/
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StepS Use the BLOCK command with the dialog box to save the geometry and attributes as a
block.

Name:

o ~cale uniformly

[t] Allow eXj;![oding

Objects

~ Selecl objects Ij]
Ofietain
CD Convert to block

oQelete

ill No objects selected

Settings

Block y~~:..,__.__.~ .__
jUnitless ~:i

jBushing125._-----_...._--_.._.-----------._-._-
Base point

E!) Pic~ point

~:

X~

~:

The important thing to remember with
this is to pick the insertion base point.
You are not prompted for it, so often
people forget to pick it. The default 0,0
will make placing the bushings on the
part quite difficult.

HyperJink...

O.Qpen in block eclitOl

OK·I [ Cancel 1\ Help

Step 6 Use ZOOM All to get the original file back onto the screen. Add four circles for the
jiglegs at 0.50 from the edge ofthe part in each comer. Add four circles at the QUAD­
rant of the center line circle on the inside. Now insert four jiglegs and four bushings
onto the file.

RO.30

Command:-INSERT

Block name (or ?) :ATTJIGLG

Insertion point:CEN of (pick 1)

X scale factor <l>/Corner/XYZ:~

Y scale factor (default = X) :~

Rotation angle <O>:~

Enter Part Number <JIG125>:G
Enter Part Description< Jigleg>:~

Enter Material <Steel>:~

Enter Part Size <.60 x 1.25>;~

Enter Current Price <5.26>:~

To get all four ofthese jiglegs placed, you could insert the object three more times or
you could copy the existing block.
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Step 7 Use the Attribute Dialog box to enter the final four parts.
INSERT the four bushings, making sure to rotate each one by 90 degrees so they line up
correctly.

Command: INSERT

Name:

Path:

Browse... I

I·. OKI [ Cancel I I Help

Rotation
oSpecify 0 n·screen

Angle:

G2J Uniform Scale

Scale

o Specify Orr-screen

X:

Insertion point

[!j Specify 0n-screen

oExp!ode

When all four bushing blocks
have been entered, your file will
look like this:

Notice that when you insert the bushings, the attributes will be rotated along with the
geometry. This is ofno importance because the attributes will not be part ofan overall
drawing. In an electrical drawing, however, the attributes must be visible and legible;
in this case, you should create attributed blocks for both directions. When attributes
are added to parts in mechanical or architectural applications, they· are not usually
printed or plotted.

StepS If you were just making a drawing, it would never look like this. Use ATTDISP to turn
all of the attributes off.

Command:ATTDISP
Normal/On/Off <current value>:OFF

Step 9 Finally create an attribute table containing the Bill ofMaterials. Use EATTEXT and sim­
ply follow the menus.

Command: EATTEXT
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In this Tutorial we will create attributes for the footings in Tutorial12b page 229.

Step] Open Tutorial12b and save it as Tutorial 14c. Make one copy offooting A and one of
Footing B outside the grid.

~
bd

Default ValuePrompt

Use theATTDEF command to define attributes with the same defaults as shown below.

Footing A

Tag

Name Enter Footing Designation Footing A

Size Enter Size 4000x2000x2300

Volume Enter Volume 7 cubic meters

Pins Enter Pin description 4 X 250 projection

Footing B

Tag Prompt Default Value

Name

Size

Enter Footing Designation

Enter Size

Footing B

2000xlOOOx1300

Volume Enter Volume 3.5 cubic Dleters

Pins Enter Pin description 4 x 125 projection

Step 2 Block the footings and insert them into the grid layout as they were before.

Step 3 Use ATIDISP to tum the Attribute Display off.

Step 4 Use EATTEXT to get a list ofthe footings on the part placed on the drawing. Simply open
the dialog box, use Next for every entry, add the title' Footings' where required. In Re­
lease 2008, you will nedd to remove any information not related to the attributes.

Footings
Quantity I No.l"'lE.> 1 NAME(D I PINS I SIZE I VOLUME

6 I f'ootinglo1 Footing A I <4 x 250 projection 1<4000 x 2000 x 2300 I 7 cubic t'leters
16 I f'ootingo. I rooting A I <4 x 250 projection 14000 x 2000 x 2300 I 7 cubic Meters
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Exercise 14 Architectural
First create this title block with attributes as shown. Save the file.
Draw the two sample windows shown. Add the attributes. BLOCK them.
Draw the simple layout shown. INSERT the attributed windows.
Use EATTEXT to get a window schedule. Insert the attributed title block.

TlUIItI ~lIn ByI ~.. RrMIorlI

TITLE DRAWN By SCALE REV
ProJectJ ICMcked By1 Ik'tei illrw •

PROJECT CHECKED By DATE DRW.#

21 '
~=-

I I
lUI Itll

I

4'-9"

I PRODND pello.36o.

1 1: : ::[;.,(i[ FINISH wo.Lnut
TYPE doubLe gto.zed

lUI COST 450.00

I 4'-6" I-I Irui

ItII ~

CD

I
9'-3" ·---1

I pello.60o. I
till 1: : ,:~

wo.lnut
1111oIouble glo.zed

I
875.00

. -_.!.-

=­=- =­=-

Second Floor 'WIndow Schedule
Quo.ntity COST FINISH Na.Me PRDDND TYPE

3 875.00 wa.lnut wlndowl pello.GOa. double glo.zed
10 450,00 wo.lnut wlndowl pelta.360 double glozed

TJtw. ~Q.n Iy' SCo.l.. Revlslonl

WINDOW PLAN JAMIE JONES NOTED 5
ProJectJ lCMcked I)q Do."tea Dr••

WESTOVER HOUSE WENDY BENEDETTI 01/04/08 A2
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Exercise 14 Challenger
Draw these desks, the dimensions are on page 67.
Attribute as shown. BLOCK them and then make the room layout.
Create a Furniture Schedule using EATIEXT.

Cho.irA

DeskB
Supplier
POortdes
Po.rtno
F"o.brlc:
:BOose
F"lnlsh
Cost

I
I

_L_
I
I
I
I
I
I
I

DeskA
Supplier
POortdes
POor'tno
F"o.brlc
Bo.se
F"lnJsh
Cost

I
I

_L_
I
I
I

Cho.irB

Supplier
POortdes
Po.r1:no
FOobrlc
BOose
Finish
Cos1:

Supplier
POortcies
Po.rtno
rOobrlc
BOose
Finish
Cost

1-------16'-6"------~

-----11'-----1·

I
I

_L._
I
I
I

I
I

_.J_
I
I
I

W
I I

~
I I
I I-.-- -,-

32'-10'
I I
I I

~Q~
I

- _.J ___

I

a
V I I 0-.-- -,-

I I
I I

27'-6"
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Index
A
absolute coordinates, 6
acad.dwt file, xiii
aligned dimensions, 123
angle brackets, 30
angles

cjegrees/minutes/seconds, 17
dimensioning, 125
putting lines in at 8

ANGULAR dimensions, 125
ARC command, 12, 24, 31

AREA commandl 247
ATIDEF,262
AITDISP, 265
ATIEDlt 266
ATIEXt 267
attributesl 261

B
BASELINE dimensionsl 124
begin AutoCAD sessionl 1
BHATCH command, 165
BLOCK commandl 181
blocks

attributed, 264
(jefining, 181
editing, 186
external, 183

borders
in paper spacel 21 8

brackets, 30
BREAK command, 36

C
cartesian coordinates, 6
center lines, 58
center marksl 132
CHANGE commandl 1471 263

CHPr<Op command, 110
CIRCLE commandl 11, 19, 23
circles

creating/ 11
tangent tal 23 1 33

COLOR command, 11 0
color

blocks and, 187
layers and I 1091 110

commands
entering from keyboard, Ix
entry, 1

command lines, ix

configure plotterl 205
coordinates

absolute/ 6

incrementaL 7
polar/ 8
relative, 7

COpy command, 51

crosshatchingl 165
crossing polygon system variable, 50

D
DDEDIT command, 147,263
DEFPOINTS layer,129
delete

objects, 36

unused blocks, 188
DIAMETER dimensions,

125
digitizingl 6
dimensioningl

and paper space scalingl
220/222

basic, 122
center Iinesl 58
editing, 129
leaders, 148
stretching, 129
text, 126

dimension styles, 126
dimension text 126

angle, 134

editing, 147
displaying toolbars, x
DISTANCE command, 249
DIVIDE command, 242
DONUT commandl 95
drafting standards, 202
drawing

compiling, 197
inserting, 183
Isometric, 149, 164
opening existingl x
scale, 206
units, 1

dynamic
block/ 188
zoom/ 4

DYNamic option, 10

E
EATTEXT command I 267
ED, 147,263
editing

commands, 51
dimensions, 129
hatches, 170

ENDpoint object snap, 32

ERASE commandl 36
exiting AutoCAD. vi
EXPLODE command, 186

EXTEND command, 73

F
feet and inches, 1, 2
Fence, 51, 81
file names, xii
file

plotting to, 206
recovery, xiii
saving, xiii

FILLET commandl 13,
20

fractional units displaYI 17
freezing layers

in paper space, 221
in single views, 108

frozen layers, 108
function keys, xi

G
geometry commands, 11
GRADIENT, 171
grid

isometric, 149
standard. 5

GRID command, 5
grips, 37 1 56

H
HATCH commandl 165
HATCHEDIT commandl 170
HELP command, 29
hidden lines, 58

I
imperial/metric/ 1
incremental point entry, 7
inquiry commandsl 246
INSERT command, 182
isometric

grid and snap, 149
text, 152

J
joining PUNEs, 89
justificaiion of text, 146

K
keyboard entryl 1
keys (funciion)1 xi

L
last entity selection method, 49
LAYER commandl 107
layers

changingl 108

colors/ 109
defpoints, 129
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filtering, 111
freeze and thaw in paper space,
221
linetypes, 110
lock and unlock, 108, 115
thaw and freeze, 115

LEADER command, 148
LIMITS command, 4

LINE command J 11, 18
lines

center, 58

extension, 122

filleting, 13
freehand, 170
mUltiple, 97
using and entering, 11

Iinetypes
and layers, 11 0
assigning, 58
changing, 110
scaling, 58

LIST command,250
Jineweights, 204

Iinewidth, 204
LTSCALE command, 58

M
MEASURE command, 243
MIDpoint object snap, 32, 44
MINSERT command, 186
MIRROR command, 53
MLiNE command, 97

model space,
dimensioning in, 121

switching to, 21 9
modify polyline, 92

modify toolbar, 51
mouse, x

MOVE command, 52
moving objects to 0,0, 53

moving viewports, 220, 228
MSPACE command, 219
MTEXT command, 144
MVIEWcommand,219

N
NEARest object snap, 32
NEW command, xiii
NODE object snap, 32

NONE object snap, 32

o
object selection methods, 49, 69
object snap, 32
OFFSET command, 75
orthographic projection, 138

ORTHO option, 9
OSNAP command, 32, 39, 42
OTRACK option, 35, 42

280 Index

P
PAN command, 4, 16
paper space

dimensioning, 220
floating viewports, 21 9
freezing layers, 221
scaling views in, 220
switching to, 21 7

paragraph text, 144
PDMODE system variable, 214

PEDIT command, 92

PUNE command, 89

plot
with paper space, 204
without paper space, 219

PLOT command, 204
POINT command, 241
POLAR, 9
polar arrays, 77
POLYGON command, 94
polylines, 89

preview
hatch, 166

plot 205, 212
print dialog box, 204

properties, 115, 148
PSPACE command, 219
pull-down menus, x
PURGE command, 188

Q
QUIT command, xiv

R
RADIAL dimensions, 125

radius
are, 12

circle, 11

setting for fillets, 13

rectangUlar arrays, 76, 78
REDO command, 37
REGEN command, 16
relative coordinates, 7
remove entity selection method, 69
rotate and copy, 54
ROTATE command, 54
running object snap dialog box, 35

S
SAVE command, xiii
SAVE AS command, xiii

SCALE command, 55

scaling
dimensions, 127
draWIngs, 199

hatches, 167
linetypes, 58
plots, 206
text, 142, 198
title blocks, 201, 208

scroll bars, 16

sections, 202
SKETCH command, 170

snap
basIc, 5
Isometric or rotated, 149

SNAP command, 5
SOLID command, 95

SPLINE command, 245
STRETCH command, 70

STATUS command, 251

STYLE command, 145

T
TANgent object snap, 32, 33

text
editing, 147
height, 142
importing, 203
justification, 142
paragraph, 144

special characters, 143

styles, 146

underscored, 143
TEXT command, 96, 141

TILEMODE command, 21 8

toolbars
moving, xi
restoring, xii

transparent commands, 14
TRIM command, 34, 36, 72
TrueType Fonts, 146

U
UNDO command, 37

UNITS command, 2, 17
units of measure,

alternate, 17

surveyors, 17

V
values

absolute, 6
relative, 6

VPLAYER command, 222

W
WBLOCK command, 184

width of lines, 204

width of polylines, 89
window entity selection method, 38,

50

Z
ZOOM command, 14,15,

ZOOM in paper space, 220
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Drawings
Architecture, CiviL
and Transportation

Details
arches, 103, 119, 120
bench, 162, 163
bookshelf, 177

capital, 103
doorway, 106
Insulated Concrete Forms, 240
stairs, 175, 213
wall assembly, 85
windows, 61, 84,137

Drawing sets
commerciaL 237
res1dential, 192

Elevation
commercial, 194, 195, 237
interior, 162, 163, 177

residential, 65, 84, 176

Lot plans, 46

Pictorial views
cavaller, 163
isometric, 164

Plan
floor, 85, 98, 134, 137,207,257

kitchen, 26

Presentation, 101

Profile moulding, 106

Rendering, 180

Section
details, 106, 177
Insulated Concrete Form, 240
rE!sidential, 11 7
stair, 175
structural, 194
wood,177

Structural
aiL 214
concrete, 136, 172
footings, 136
roof layout, 257
steel beams, 160, 258

Transportation, 102

Mechanical

Applied geometry
hook, 47,48

Assembies
template, bushing and jigleg, 193
vise, 178
wheel, 196

axle, 45
axle support 138
bolt 104
bushing,64
top plate 116
wheel, 1i5

Complete
body and pin, 215
faucet, 216
gasket, 161

pedestal, 238

Fasteners
bolt, 102, 104

Gear
gear with threading, 86, 87

Orthographic projection
axle support, 138

Pictorial views
coupling, link, swivel hanger, 116
rocker arm, 66
rocker arm, top plate, 11 6
various, 118

Section
die ring, 175
fastener, 210
vice, 178, 179

Single view geometry
nozzle, 84
template, 27, 66
various, 25,45,47,83

Wood

Cabinets
front 28
side, 45

Clock
base and body, clock a, 105
bonnet and face, clock a, 139
full assembly, clock b, 239

Fireplace
mantel,236

Orthographic projection
bookcase, 177

Reverse section
base, 105

Saw handle, 88

Shelving
bookcase, 177

Stairs
detail, 175
full, 213

Wood grain detail, 93

Compiled Drawings

Commercial
complete, 237
front elevation, 195
sections and details, 194
side elevation, 237

Furniture, 67, 68

Residential
complete, 192
elevations, 65, 84, 176
first floor, 98, 134, 137
full layout 192
kitchen, 26
second floor, 85
section, 117
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